Comments?
Send comments on the documentation by going to http://solvnet.synopsys.com, then clicking “Enter a Call to the Support Center.”
Contents

What's New in This Release .................................................. xx
About This Guide ............................................................... xxi
Customer Support .............................................................. xxiii

Part I: Prerequisites and General Instructions

1. Preparing for Installation
   Checking Your Hardware and Software Configuration .............. 1-2
   Installation Changes ..................................................... 1-2
   Overlay Installation ..................................................... 1-2
      Platform-Independent Package (Common File) ................... 1-2
      Supported Platforms and Operating Systems ................... 1-3
   Multiple-Platform Installation ...................................... 1-5
   Products and Supported Platforms ................................ 1-6
   Disk Space Requirements ............................................. 1-9
   Memory Requirements ................................................ 1-11
      Physical Memory Requirements for Synthesis,
      PrimeTime, and Design Budgeting ............................. 1-13
Swap Space Requirements for Synthesis Tools .......... 1-13
Accessing Memory Beyond 2 GB With 32-Bit Synopsys Tools. ........................................ 1-14
Acquiring a License ........................................... 1-16
Obtaining Your License Keys .............................. 1-17
Installing Synopsys Common Licensing Software .... 1-18
Finding Your Site Identification Number ............... 1-19
Creating the Synopsys Root Directory ................. 1-19
Defining the SYNOPSYS Environment Variable ...... 1-20

2. Downloading and Installing the Software

Downloading the Software .................................... 2-2
 About the Synopsys Installer Software .................... 2-2
 Using the Product Files ..................................... 2-3
 Downloading the Files by FTP ............................ 2-5
 Downloading the Files From the Web .................... 2-6
 Untarring and Uncompressing the Files ................. 2-7
 Installing EST Files by Using a Text Script .......... 2-9
 Running the Installation Program From the GUI ....... 2-10
 View the Main Screen ....................................... 2-11
 Browse or Enter the Path to the Product Files ...... 2-12
 Select the Release Version ............................... 2-13
 Enter your site information .............................. 2-14
 Select the Products You Want to Install ............. 2-15
 Review the Product Package ............................ 2-16
Select the Platform .................................................. 2-17
Select the Destination Directory ................................. 2-18
Verify the Selected Information ................................. 2-19
Wait While the Products Are Installed ....................... 2-20
Exit or Install Another Product ............................... 2-21
Installing Product Files From a CD ......................... 2-22
Synopsys Media Installation Scripts ....................... 2-24
Synthesis Tools Script ....................................... 2-24
PrimeTime Script ............................................. 2-27

Part II: Specific Product Instructions

3. AMPS (version V-2003.12)
   Installing the Software ..................................... 3-3
   Setting Up AMPS for Each User ........................... 3-3
   Verifying the AMPS Installation .......................... 3-4

4. Astro, Astro Interactive Ultra, JupiterXT (version W-2004.12)
   Media Availability and Supported Platforms ............... 4-3
   Disk Space Requirements ................................. 4-4
   Installing the Software .................................. 4-5
   Setting Up Astro for a New User ......................... 4-6
   Verifying the Astro Installation ........................ 4-7
5. Astro-Rail (version W-2004.12)
   Media Availability and Supported Platforms ....................... 5-2
   Disk Space Requirements ......................................... 5-3
   Installing the Software ........................................... 5-3
   Setting Up Astro-Rail for a New User .......................... 5-4
   Verifying the Astro-Rail Installation ........................... 5-5

6. Cadabra (version W-2004.09)
   Installing the Software ............................................ 6-2
   Setting the Environment Variables ............................... 6-2
      Setting the CADABRAHOME Environment Variable ............ 6-3
      Setting the LM_LICENSE_FILE Environment Variable ....... 6-4
   Verifying the Cadabra Installation ............................. 6-4
   Customer Support .................................................. 6-5

7. CosmosScope (version W-2004.12)
   Preparing for Installation ........................................ 7-3
      Supported Platforms and Compilers .......................... 7-4
      Disk Space and Memory Requirements ......................... 7-5
   Installing the Software (UNIX and Windows) .................... 7-6
      Installing the Software by EST ............................... 7-6
      Installing the Software From a CD .......................... 7-7
      Running the Installation Program ............................ 7-8
   Invoking CosmosScope on Windows ................................. 7-13
Setting Up the User Environment on UNIX ............... 7-14
Specifying the Executable File Location ............... 7-14
Setting the License Environment Variable ............... 7-14
Verifying the CosmosScope Installation on UNIX ......... 7-15
Using Command Options .................................. 7-16
Uninstalling the Software .................................. 7-18
Customer Support .......................................... 7-18

8. Design Compiler FPGA (version W-2005.03)
Installing the Software .................................. 8-2
Setting Up Design Compiler FPGA for Each User ........ 8-3
Configuring the Browser for FPGA Vision Online Help .... 8-3
Verifying the Design Compiler FPGA Installation ......... 8-4

9. Encore (version W-2005.03)
Installing the Software on UNIX Platforms ............... 9-2
Verifying the Encore Installation on UNIX Platforms .... 9-4
Installing the Software on Windows Platforms .......... 9-4
Running the Installation Program on Windows Platforms .... 9-5
Invoking Encore on Windows Platforms .................. 9-7

10. ESP (version W-2004.12)
Installing the Software .................................. 10-2
Setting Up ESP for Each User ........................................ 10-3
Setting the LM_LICENSE_FILE Environment Variable ....... 10-3
Verifying the ESP Installation ................................. 10-4

11. Floorplan Compiler (version V-2003.12)

Installing the Software ........................................ 11-3
Setting Up Floorplan Compiler for Each User ............... 11-3
Configuring the Browser for Floorplan Compiler
Online Help ......................................................... 11-4
Verifying the Floorplan Compiler Installation ............... 11-4

12. Formality (version W-2005.03)

Installing the Software ........................................ 12-2
Setting Up Formality for Each User .......................... 12-3
Verifying the Formality Installation ......................... 12-3

13. Hercules (version W-2004.12)

Media Availability and Supported Platforms .............. 13-3
Disk Space Requirements ...................................... 13-4
Installing the Software ....................................... 13-5
Setting Up the Hercules Environment for Each User ...... 13-6
Verifying the Hercules Installation ......................... 13-7
14. HSPICE (version W-2005.03) on UNIX or Windows Platforms

Media Availability and Supported Platforms ................. 14-3
Disk Space Requirements ...................................... 14-4
Installing the Software on UNIX or Linux Platforms ....... 14-4
Configuring HSPICE and AvanWaves for UNIX and Linux .... 14-5
Setting Up HSPICE for Each User .............................. 14-6
Verifying the Installation ..................................... 14-7
  Verifying the HSPICE Installation ......................... 14-8
  Verifying the AvanWaves Installation ..................... 14-8
Installing the Software on Windows Platforms .............. 14-9
  Installing With Windows Explorer ......................... 14-9
  Installing With Windows DOS Shell ....................... 14-10
  Installing the Sentinel System Drivers ................. 14-10
Running HSPICE on Windows .................................. 14-11
Running AvanWaves on Windows ............................... 14-11
Running Older Versions of HSPICE ......................... 14-12
The hspice.ini File ........................................... 14-13
Related Documentation and Customer Support ............... 14-13

15. IC WorkBench (version W-2004.12)

Installing the Software ....................................... 15-2
Setting Up the User Environment ............................. 15-3
Setting the LM_LICENSE_FILE Environment Variable ....... 15-3
Verifying the IC WorkBench Installation .................. 15-4

   Installing the Software ..................................... 16-2
   Setting the Environment Variables ......................... 16-3
     Setting the MG_HOME Environment Variable ............... 16-3
     Setting the SNPSLMD_LICENSE_FILE or
     LM_LICENSE_FILE Environment Variable .................. 16-5
   Verifying the Magellan Installation ....................... 16-6

17. NanoSim (version W-2004.12)
   Installing the Software ..................................... 17-2
   Setting Up NanoSim for Each User .......................... 17-2
   Verifying the NanoSim Installation ......................... 17-4

18. PathMill (version W-2004.12)
   Installing the Software ..................................... 18-3
   Setting Up PathMill for Each User .......................... 18-3
   Verifying the PathMill Installation ......................... 18-4

19. PowerMill (version V-2004.06)
   Installing the Software ..................................... 19-2
   Setting Up PowerMill for Each User .......................... 19-2
   Verifying the PowerMill Installation ......................... 19-3
   Installing the Software .................................. 20-2
   Setting Up PrimePower for Each User ...................... 20-3
   Verifying the PrimePower Installation .................... 20-3

   Installing the Software .................................. 21-2
   Setting Up PrimeTime for Each User ...................... 21-2
   Verifying the PrimeTime Installation .................... 21-4

22. RailMill (version U-2003.03)
   Installing the Software .................................. 22-2
   Setting Up RailMill for Each User ...................... 22-2
   Verifying the RailMill Installation .................... 22-3

23. Saber and Saber HDL (version W-2004.12)
   Preparing for Installation .............................. 23-3
      Supported Platforms and Compilers ................... 23-4
      Disk Space and Memory Requirements ................. 23-6
   Installing the Software (UNIX and Windows) .......... 23-8
      Installing the Software by EST ....................... 23-8
      Installing the Software From a CD ................... 23-9
      Running the Installation Program ................... 23-10
   Invoking Saber on Windows ............................ 23-15
Setting Up the User Environment on UNIX .......................... 23-16
Specifying the Executable File Location ........................... 23-16
Setting the License Environment Variable ......................... 23-17
Verifying the Saber Installation on UNIX ......................... 23-17
Using Command Options .............................................. 23-18
Uninstalling the Software ............................................ 23-20
Customer Support ..................................................... 23-21

24. Saber Optional Software

Installing the Frameway Integration for Mentor Graphics ...... 24-3
Installing the Software .............................................. 24-3
Verifying the Environment Variable Settings ...................... 24-9
Creating or Modifying a Location Map File ....................... 24-10
Loading the Saber and CosmosScope Icons ....................... 24-12
Verifying the Installation .......................................... 24-13

Troubleshooting a Frameway Integration for
Mentor Graphics Installation ...................................... 24-15

Installing the Saber Co-Simulation Interface
With ModelSim ...................................................... 24-19

Installing the Frameway Integration for Cadence ............... 24-21

Installing the Saber Co-Simulation Interface With Verilog .... 24-30

Setting Up the Software to Use a Remote System .............. 24-33

Troubleshooting the Saber Co-Simulation Interface
With Verilog Installation ........................................... 24-33
Installing the Frameway Integration for Innoveda ....................... 24-39

25. Synopsys Online Documentation (version W-2005.03)
   About SOLD ................................................................. 25-3
   Acquiring and Installing the Adobe Reader Software ................. 25-4
     Downloading and Installing Adobe Reader
     From the Web ......................................................... 25-4
   Verifying Your Adobe Acrobat Software ............................. 25-5
     Checking the Version Number ....................................... 25-5
     Checking for the Search Plug-In .................................. 25-5
   Installing SOLD ......................................................... 25-6
     Contents of SOLD ..................................................... 25-6
     Installation Options .................................................. 25-7
     Electronic Software Transfer Installation ......................... 25-8
     CD Installation ......................................................... 25-8
     Partial Installation .................................................. 25-9
   Verifying the SOLD Installation ...................................... 25-9
   Configuring SOLD for Each User ..................................... 25-10

   Media Availability and Supported Platforms ....................... 26-2
   Disk Space Requirements ............................................. 26-3
   Installing the Software ............................................... 26-3
   Setting Up Star-MTB for Each User ................................ 26-3
Verifying the Star-MTB Installation ......................... 26-5

27. Star-RCXT (version W-2004.12)
   Media Availability and Supported Platforms ............... 27-3
   Disk Space Requirements .................................. 27-4
   Installing the Software .................................. 27-4
   Setting Up Star-RCXT for Each User ....................... 27-5
   Verifying the Star-RCXT Installation ...................... 27-6
   Customer Support ......................................... 27-6

28. Star-SimXT (version V-2003.12)
   Media Availability and Supported Platforms ............... 28-2
   Downloading and Installing the Software .................. 28-2
   Setting the Environment Variables ........................ 28-3
       Setting the $starsimxt_HOME Environment Variable ...... 28-4
       Setting the LM_LICENSE_FILE Environment Variable ..... 28-4
   Verifying the Star-SimXT Installation ...................... 28-5
   Customer Support ......................................... 28-6

   Synthesis Tools .......................................... 29-2
   Installing the Software ................................... 29-3
   Configuring the Synthesis Tools ........................... 29-4
Setting Up the Synthesis Tools for Each User ....................... 29-4
Setting Up the Systemwide Defaults ................................. 29-6
Configuring the Browser for Physical Compiler and Design Vision Online Help ................................................. 29-7
Installing Optional Tools .................................................. 29-8
Installing Synopsys Integrator for Falcon Framework .......... 29-8
Installing Power Compiler VPOWER .................................. 29-9
   Verilog-XL Simulator .................................................. 29-10
   VCS Simulator ....................................................... 29-15
Using SoCBIST ............................................................ 29-17
Verifying the Synthesis Tools Installation ......................... 29-17

30. System Studio (version W-2004.09)
   Installing the Software .............................................. 30-2
   Setting Up System Studio for Each User ......................... 30-3
      For C Shell Users .................................................. 30-3
      For Bourne Shell Users ....................................... 30-4
      VHDL Simulation .................................................. 30-6
   Verifying the System Studio Installation ....................... 30-6
   Troubleshooting Startup Problems ............................... 30-7
      Key File Problems ................................................. 30-7
      Insufficient Interprocess Communication (IPC) Semaphores .................................................. 30-8

31. TCAD Products and Utilities
   Supported Platforms and Media Availability ..................... 31-2
Verifying the TetraMAX Installation ........................................ 32-8

33. TimeMill (version V-2004.06)
   Installing the Software ................................................. 33-2
   Setting Up TimeMill for Each User .................................... 33-2
   Verifying the TimeMill Installation ................................... 33-3

34. VCS (version 7.2)
   Installing the Software .................................................. 34-2
   Setting the Environment Variables ................................. 34-4
      Setting the $VCS_HOME Environment Variable ................. 34-4
      Setting the SNPSLMD_LICENSE_FILE or
      LM_LICENSE_FILE Environment Variable ..................... 34-5
   Verifying the VCS Installation ....................................... 34-6
   Customer Support ..................................................... 34-7

35. VCS MX (version 7.2)
   Installing the Software ................................................. 35-2
   Setting the Environment Variables ................................. 35-4
      Setting the VCS_HOME Environment Variable ................. 35-4
      Setting the SNPSLMD_LICENSE_FILE or
      LM_LICENSE_FILE Environment Variable ..................... 35-5
   Verifying the VCS MX Installation .................................. 35-6
36. Vera (version 6.3.30)
   Downloading and Installing the Software ................................. 36-2
   Setting the Environment Variables ......................................... 36-3
     Setting the VERA_HOME Environment Variable .......................... 36-3
     Setting the SNPSLMD_LICENSE_FILE or
     LM_LICENSE_FILE Environment Variable ................................. 36-4
   Customer Support .............................................................. 36-4

Appendix A. Troubleshooting
   Memory ................................................................................. A-2
     Why Do I Get an “out of memory” Message? .............................. A-2
     What Should I Do When an “out of memory”
     Error Occurs? ................................................................. A-4
   X Window System ................................................................. A-5

Appendix B. VirSim (version 4.4)
   Installing the Software .......................................................... B-2
   Setting Up VirSim for Each User ............................................. B-3
   Setting the SNPSLMD_LICENSE_FILE or
   LM_LICENSE_FILE Environment Variable ............................... B-4
   Verifying the VirSim Installation .......................................... B-4
   Customer Support ................................................................. B-5

Index
Preface

This preface includes the following sections:

• What’s New in This Release
• About This Guide
• Customer Support

The installation instructions in this guide reflect the latest version of Synopsys software for each product. Not all products are the same version.

All instructions in this guide are for UNIX systems unless otherwise indicated.

Important:
Install each version of the software in a new directory. Do not install different versions of Synopsys software in the same directory.
## What’s New in This Release

For information about new features and changes in specific Synopsys tools, see the individual product documentation. For links to Synopsys documentation, see “Related Publications” on page 1-xxi.

## Synopsys Installer GUI

In addition to performing installation by using a text script, you have the option of installing many Synopsys products by using a graphical user interface (GUI). For information about the Synopsys Installer version 1.0.8, see “About the Synopsys Installer Software” on page 2-2.

In the W-2005.03 release, the Synopsys Installer GUI is available for the following products. Products not in this list continue to use their current installation methods, as documented in the individual product chapters.

<table>
<thead>
<tr>
<th>Astro</th>
<th>Astro Interactive Ultra</th>
<th>Astro-Rail</th>
<th>Cadabra</th>
<th>Design Compiler FPGA</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESP</td>
<td>Formality</td>
<td>Hercules</td>
<td>HSPICE</td>
<td>JupiterXT</td>
</tr>
<tr>
<td>NanoSim</td>
<td>PathMill</td>
<td>PowerMill</td>
<td>PrimePower</td>
<td>PrimeTime</td>
</tr>
<tr>
<td>SOLD</td>
<td>Star-RCXT</td>
<td>Synthesis tools</td>
<td>System Studio</td>
<td>TCAD</td>
</tr>
<tr>
<td>TetraMAX</td>
<td>TimeMill</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
About This Guide

The *Installation Guide* provides the basic information and procedures required to install Synopsys tools.

**Audience**

This guide is written for system administrators responsible for installing Synopsys software tools.

**Related Publications**

For additional information about Synopsys tools, see

- Synopsys Online Documentation (SOLD), which is included with the software for CD users or is available to download through the Synopsys Electronic Software Transfer (EST) system
- Documentation on the Web, which is available through SolvNet at http://solvnet.synopsys.com
- The Synopsys MediaDocs Shop, from which you can order printed copies of Synopsys documents, at http://mediadocs.synopsys.com
# Conventions

The following conventions are used in Synopsys documentation.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Courier</td>
<td>Indicates command syntax.</td>
</tr>
<tr>
<td><em>Courier italic</em></td>
<td>Indicates a user-defined value in Synopsys syntax, such as <code>object_name</code>. (A user-defined value that is not Synopsys syntax, such as a user-defined value in a Verilog or VHDL statement, is indicated by regular text font italic.)</td>
</tr>
<tr>
<td><em>Courier bold</em></td>
<td>Indicates user input—text you type verbatim—in Synopsys syntax and examples. (User input that is not Synopsys syntax, such as a user name or password you enter in a GUI, is indicated by regular text font bold.)</td>
</tr>
<tr>
<td>[]</td>
<td>Denotes optional parameters, such as <code>pin1 [pin2 ... pinN]</code></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>_</td>
<td>Connects terms that are read as a single term by the system, such as <code>set_annotated_delay</code></td>
</tr>
<tr>
<td>Control-c</td>
<td>Indicates a keyboard combination, such as holding down the Control key and pressing c.</td>
</tr>
<tr>
<td>\</td>
<td>Indicates a continuation of a command line.</td>
</tr>
<tr>
<td>/</td>
<td>Indicates levels of directory structure.</td>
</tr>
<tr>
<td><em>Edit &gt; Copy</em></td>
<td>Indicates a path to a menu command, such as opening the Edit menu and choosing Copy.</td>
</tr>
</tbody>
</table>
Customer Support

Customer support is available through SolvNet online customer support and through contacting the Synopsys Technical Support Center.

Accessing SolvNet

SolvNet includes an electronic knowledge base of technical articles and answers to frequently asked questions about Synopsys tools. SolvNet also gives you access to a wide range of Synopsys online services including software downloads, documentation on the Web, and “Enter a Call to the Support Center.”

To access SolvNet,


2. If prompted, enter your user name and password. (If you do not have a Synopsys user name and password, follow the instructions to register with SolvNet.)

If you need help using SolvNet, click HELP in the top-right menu bar in the footer.
Contacting the Synopsys Technical Support Center

If you have problems, questions, or suggestions, you can contact the Synopsys Technical Support Center in the following ways:

• Open a call to your local support center from the Web by going to http://solvnet.synopsys.com (Synopsys user name and password required), then clicking “Enter a Call to the Support Center.”

• Send an e-mail message to your local support center.
  - E-mail support_center@synopsys.com from within North America.
  - Find other local support center e-mail addresses at http://www.synopsys.com/support/support_ctr.

• Telephone your local support center.
  - Call (800) 245-8005 from within the continental United States.
  - Call (650) 584-4200 from Canada.
  - Find other local support center telephone numbers at http://www.synopsys.com/support/support_ctr.
Part I: Prerequisites and General Instructions
Preparing for Installation

This chapter provides information about steps to complete before you install Synopsys tools.

The chapter contains the following sections:

• Checking Your Hardware and Software Configuration
• Acquiring a License
• Finding Your Site Identification Number
• Creating the Synopsys Root Directory
• Defining the SYNOPSYS Environment Variable
Checking Your Hardware and Software Configuration

You must check your hardware and software configuration (including patch requirements) before you attempt to load any Synopsys tools.

Installation Changes

Beginning with the June 2003 release of Synopsys software, the way the install.now script checks the software version has changed. This change affects overlay installation only.

Overlay Installation

When you attempt to install overlay software over an earlier release, the installation script now looks only at the foundation identifier, for example, U or V; it no longer looks for the release month and year.

For products that allow overlay installation, this change enables you to install a later tool version for the same foundation release over an earlier tool version. For example, you could install TetraMAX version U-2003.09 over version U-2003.06 of the synthesis tools.

Do not attempt to install an earlier version of an overlay tool (for example, U-2003.06) over a later version of the tool (U-2003.09). This installation is not supported, but the install.now script will not stop you from doing it if overlay installation is allowed for a product.

Platform-Independent Package (Common File)

Even though the install.now script is no longer included in the common file, for each product you must download one common file (platform-independent package) and one or more platform-specific files. (See Figure 1-1 on page 1-5.)
• For SOLD, download only the common file. (SOLD has no platform-specific files.)

• For the synthesis tools, download a common file and a platform file for synthesis (syn). You do not need to download the sf3 or sf4 common and platform files unless your site is licensed for System Integrator for Falcon Frameworks.

• For TetraMAX, download a common file and a platform file for either TetraMAX stand-alone (txs) or TetraMAX overlay (tx). If your site is licensed for TetraMAX IddQTest, also download the TetraMAX IddQTEST (idq) common and platform files.

**Supported Platforms and Operating Systems**

Table 1-1 lists the supported platforms, operating systems, and corresponding Synopsys platform keywords for this release. Many platforms require operating system (OS) patches.

For detailed information, see the Supported Platforms Guide page on the Synopsys Web site. Go to

http://www.synopsys.com/products/sw_platform.html

and under Supported Platforms Guides, select the appropriate foundation for your release. This Web page provides information about supported hardware, operating systems, and required OS patches. If the required patch described on this page is not available from the platform vendor, install the most recent patch instead.
The Synopsys tools support 64-bit operation on HP-UX, Solaris, Linux, and AIX platforms. When you run the tools in 64-bit mode, the upper limit for virtual address space is extended beyond the 4-gigabyte limit imposed by the 32-bit mode,

---

**Table 1-1 Supported Platforms, Operating Systems, and Keywords**

<table>
<thead>
<tr>
<th>Platform</th>
<th>Operating system</th>
<th>Synopsys platform keyword</th>
<th>Window environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMDOpteron</td>
<td>Red Hat Enterprise Linux 3.0&lt;sup&gt;1&lt;/sup&gt;</td>
<td>amd64 (64-bit mode)</td>
<td>GNOME</td>
</tr>
<tr>
<td></td>
<td></td>
<td>linux (32-bit mode)</td>
<td></td>
</tr>
<tr>
<td>EM64T</td>
<td>Red Hat Enterprise Linux 3.0&lt;sup&gt;1,2&lt;/sup&gt;</td>
<td>amd64 (64-bit mode)</td>
<td>GNOME</td>
</tr>
<tr>
<td></td>
<td></td>
<td>linux (32-bit mode)</td>
<td></td>
</tr>
<tr>
<td>EM64T</td>
<td>SUSE Enterprise Linux 9&lt;sup&gt;1&lt;/sup&gt;</td>
<td>suse64 (64-bit mode)</td>
<td>GNOME</td>
</tr>
<tr>
<td></td>
<td></td>
<td>suse32 (32-bit mode)</td>
<td></td>
</tr>
<tr>
<td>HP PA-RISC 2.0</td>
<td>HP-UX 11.0, 11.11 (11i)&lt;sup&gt;1,2&lt;/sup&gt;</td>
<td>hp32 (32-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>hp64 (64-bit mode)</td>
<td></td>
</tr>
<tr>
<td>IBM RS/6000</td>
<td>AIX 5.1&lt;sup&gt;1&lt;/sup&gt;</td>
<td>rs6000 (32-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>aix64 (64-bit mode)</td>
<td></td>
</tr>
<tr>
<td>IA-32 (x86)</td>
<td>Red Hat Enterprise Linux 3.0</td>
<td>linux (32-bit mode)</td>
<td>GNOME</td>
</tr>
<tr>
<td>IA-32 (x86)</td>
<td>Red Hat Linux 7.2&lt;sup&gt;1&lt;/sup&gt;</td>
<td>linux72 (32-bit mode)</td>
<td>GNOME</td>
</tr>
<tr>
<td>IA-32 (x86)</td>
<td>SUSE Enterprise Linux 9&lt;sup&gt;1&lt;/sup&gt;</td>
<td>suse32 (32-bit mode)</td>
<td>GNOME</td>
</tr>
<tr>
<td>Itanium 2</td>
<td>Red Hat Enterprise Linux 2.1&lt;sup&gt;1&lt;/sup&gt;</td>
<td>linuxipf (64-bit mode)</td>
<td>GNOME</td>
</tr>
<tr>
<td>Sun SPARC</td>
<td>Solaris 8, 9&lt;sup&gt;2&lt;/sup&gt;</td>
<td>sparcOS5 (32-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sparc64 (64-bit mode)</td>
<td></td>
</tr>
</tbody>
</table>

<sup>1</sup> The AIX 5.1, HP-UX 11.0 and 11.11, Red Hat Linux 7.2, Red Hat Enterprise Linux 64-bit, and SUSE Enterprise Linux 32- and 64-bit platforms are not available on CD. Most products running on these platforms will be available for download by electronic software transfer (EST) at a later date. For availability, check with your Synopsys sales representative.

<sup>2</sup> Binary-compatible operating system. Note, however, that binary compatibility is not guaranteed.

---

64-Bit Platform Support. The Synopsys tools support 64-bit operation on HP-UX, Solaris, Linux, and AIX platforms. When you run the tools in 64-bit mode, the upper limit for virtual address space is extended beyond the 4-gigabyte limit imposed by the 32-bit mode,
allowing you to process larger designs. With both the 32-bit and 64-bit platforms installed, you have the flexibility to run either 32-bit or 64-bit applications without running out of memory.

You can install the 64-bit version of the Synopsys tools in the same root directory as the 32-bit version or in a separate directory. When both 32-bit and 64-bit dc_shell executable files are installed and you specify dc_shell, the first executable file in the PATH environment is invoked.

Note:
If you attempt to use the 64-bit mode executable file on a 32-bit platform, you will see an error message.

Multiple-Platform Installation
When you install tools on a network that connects different platforms, the result is the directory tree shown in Figure 1-1.

Figure 1-1 Illustration of a Multiple-Platform Installation
Each Synopsys product includes a platform-independent package (indicated by the shaded box in Figure 1-1) containing files common to all platforms. When you select multiple platforms, the installation script installs one platform-independent package and a platform-dependent package for each selected platform.

If you have previously installed a product on one platform and want to install it on another platform,

1. Rerun the installation script for the product.

2. In the installation script,
   - Answer n to the query about installing the platform-independent package.
   - Specify the new platform when queried about which platform to install.

Note:
This option is applicable only if you are performing a text script installation. It does not apply to GUI (setup.sh) installation.

---

**Products and Supported Platforms**

-table 1-2 lists the products and their supported platforms. For the latest product-specific platform information, see the release notes for your tool.

**Table 1-2  Products and Supported Platforms**

<table>
<thead>
<tr>
<th>Product</th>
<th>Product ID</th>
<th>Platform keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMPS</td>
<td>amps</td>
<td>sparcOS5, hp32, linux, linuxipf</td>
</tr>
<tr>
<td>Cadabra</td>
<td>cadabra</td>
<td>sparcOS5, hp32, linux</td>
</tr>
</tbody>
</table>
Table 1-2  Products and Supported Platforms (Continued)

<table>
<thead>
<tr>
<th>Product</th>
<th>Product ID</th>
<th>Platform keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Compiler FPGA</td>
<td>dc_fpga</td>
<td>sparcOS5, sparc64, linux, linux72, amd64, linuxipf</td>
</tr>
<tr>
<td>Encore</td>
<td>enc</td>
<td>sparcOS5, windows</td>
</tr>
<tr>
<td>ESP</td>
<td>esp</td>
<td>sparcOS5, sparc64, hp32, linux, linux72, amd64, linuxipf, rs6000</td>
</tr>
<tr>
<td>Floorplan Compiler</td>
<td>fpc</td>
<td>sparcOS5, sparc64, linux</td>
</tr>
<tr>
<td>Formality</td>
<td>fm</td>
<td>sparcOS5, sparc64, hp32, hp64, rs6000, aix64, linux, linux72, linuxipf, amd64</td>
</tr>
<tr>
<td>Magellan</td>
<td>mg</td>
<td>sparcOS5, sparc64, linux</td>
</tr>
<tr>
<td>NanoSim (including ADFMI, NanoSim Integration with VCS, CosmosScope, turboWave, Verilog-A, and VTRAN)</td>
<td>ns</td>
<td>sparcOS5, sparc64, hp32, hp64, rs6000, linux, linux72, linuxipf, amd64, aix64</td>
</tr>
<tr>
<td>PathMill</td>
<td>pm</td>
<td>sparcOS5, sparc64, hp32, hp64, linux, linux72, linuxipf, amd64, rs6000</td>
</tr>
<tr>
<td>PowerMill (including ADFMI, VTRAN, and turboWave)</td>
<td>pw</td>
<td>sparcOS5, sparc64, hp32, hp64, rs6000</td>
</tr>
<tr>
<td>PrimePower</td>
<td>pps</td>
<td>sparcOS5, sparc64, hp32, hp64, linux, linux72, amd64, linuxipf</td>
</tr>
<tr>
<td>PrimeTime</td>
<td>pts</td>
<td>sparcOS5, sparc64, hp32, hp64, linux, linux72, linuxipf, rs6000, amd64</td>
</tr>
<tr>
<td>RailMill</td>
<td>rm</td>
<td>sparcOS5, sparc64, hp32, hp64, rs6000</td>
</tr>
</tbody>
</table>
Table 1-2  Products and Supported Platforms (Continued)

<table>
<thead>
<tr>
<th>Product</th>
<th>Product ID</th>
<th>Platform keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synthesis tools</td>
<td>syn</td>
<td>sparcOS5, sparc64, hp32, hp64, rs6000, linux, linux72, linuxipf, amd64, aix64</td>
</tr>
<tr>
<td>System Studio</td>
<td>css</td>
<td>sparcOS5, hp32, linux gccsparcOS5</td>
</tr>
<tr>
<td>TetraMAX</td>
<td>tx/txs</td>
<td>sparcOS5, sparc64, hp32, hp64, linux, linux72, linuxipf, amd64, aix64, rs6000</td>
</tr>
<tr>
<td>TimeMill (including ADFMI, VTRAN, and turboWave)</td>
<td>tm</td>
<td>sparcOS5, sparc64, hp32, hp64, rs6000</td>
</tr>
<tr>
<td>VCS</td>
<td>vcs, vcsi</td>
<td>sparcOS5, sparc64, hp11.00, PA2.0_32, 64, linux, AIX 32</td>
</tr>
<tr>
<td>VCS MX</td>
<td>vcs</td>
<td>sparcOS5, hp32, hp64, linux, rs6000</td>
</tr>
<tr>
<td>Vera</td>
<td>vera</td>
<td>sparcOS5, sparc64, hp32, linux, rs6000</td>
</tr>
</tbody>
</table>

Note:

Most products running on the AIX 5.1 (aix64), AMD Opteron Red Hat Enterprise Linux (amd64), HP-UX, Itanium 2 Red Hat Enterprise Linux (linuxipf), Red Hat Linux 7.2, and HP-UX (hp32, hp64) platforms will be available at a later date by EST only. For more information, contact your Synopsys sales representative.
Checking Your Hardware and Software Configuration

Disk Space Requirements

Table 1-3 lists the amount of disk space required to install the various Synopsys tools. Each CD also includes this information in the top-level README.\textit{product\_name} file.

\begin{table}[h]
\centering
\begin{tabular}{|l|l|}
\hline
Synopsys product & Required size in MB (approximate) \\
\hline
AMPS & \\
Platform independent & 35 \\
Per platform & 110 \\
Cadabra & \\
Platform independent & 30 \\
Per platform & 75 \\
Design Compiler FPGA & \\
Platform independent & 425 \\
Per platform & 450 \\
Encore & \\
UNIX & 55 \\
Windows & 47 \\
ESP & \\
Platform independent & 12 \\
Per platform & 40 \\
Floorplan Compiler & \\
Platform independent & 50 \\
Per platform & 400 \\
Formality & \\
Platform independent & 102 \\
Per platform & 132 \\
Magellan & \\
Per platform & 4 GB \\
\hline
\end{tabular}
\end{table}

Checking Your Hardware and Software Configuration
**Table 1-3  Disk Space Requirements (Continued)**

<table>
<thead>
<tr>
<th>Synopsys product</th>
<th>Required size in MB (approximate)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NanoSim</td>
<td></td>
</tr>
<tr>
<td>Platform independent</td>
<td>50</td>
</tr>
<tr>
<td>Per platform</td>
<td>500</td>
</tr>
<tr>
<td>PathMill</td>
<td></td>
</tr>
<tr>
<td>Platform independent</td>
<td>11</td>
</tr>
<tr>
<td>Per platform</td>
<td>172</td>
</tr>
<tr>
<td>PowerMill</td>
<td></td>
</tr>
<tr>
<td>Platform independent</td>
<td>50</td>
</tr>
<tr>
<td>Per platform</td>
<td>300</td>
</tr>
<tr>
<td>sparcOS5</td>
<td>450</td>
</tr>
<tr>
<td>PrimePower</td>
<td></td>
</tr>
<tr>
<td>Platform independent</td>
<td>245</td>
</tr>
<tr>
<td>Per platform</td>
<td>350</td>
</tr>
<tr>
<td>PrimeTime</td>
<td></td>
</tr>
<tr>
<td>Platform independent</td>
<td>450</td>
</tr>
<tr>
<td>Per platform</td>
<td>350</td>
</tr>
<tr>
<td>RailMill</td>
<td></td>
</tr>
<tr>
<td>Platform independent</td>
<td>125</td>
</tr>
<tr>
<td>Per platform</td>
<td>300</td>
</tr>
<tr>
<td>Synthesis tools</td>
<td></td>
</tr>
<tr>
<td>Platform independent</td>
<td>400</td>
</tr>
<tr>
<td>Per platform</td>
<td>825</td>
</tr>
<tr>
<td>Synopsys Online Documentation (English)</td>
<td>385</td>
</tr>
<tr>
<td>Synopsys Online Documentation (Japanese)</td>
<td>350</td>
</tr>
<tr>
<td>System Studio</td>
<td></td>
</tr>
<tr>
<td>Platform independent</td>
<td>700</td>
</tr>
<tr>
<td>Per platform</td>
<td>600</td>
</tr>
</tbody>
</table>
Memory Requirements

The UNIX kernel defines hard per-process limits on the maximum amount of memory that can be used, and the `limit` command creates soft limits. If ignored, these limits can cause processes (jobs) to fail even when sufficient memory is available. For more information, see “Memory” on page A-2.
Table 1-4 lists the general guidelines for the minimum amount of physical memory and swap space (virtual memory) required to run Synopsys tools.

**Table 1-4 Minimum Memory Requirements**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Physical memory (MB)</th>
<th>Swap space (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMPS</td>
<td>256</td>
<td>512</td>
</tr>
<tr>
<td></td>
<td>Recommended: 1GB</td>
<td>Recommended: 2GB</td>
</tr>
<tr>
<td>Cadabra</td>
<td>1 GB</td>
<td>256</td>
</tr>
<tr>
<td>Design Compiler FPGA</td>
<td>128</td>
<td>256</td>
</tr>
<tr>
<td>Encore</td>
<td>512</td>
<td>512</td>
</tr>
<tr>
<td>ESP</td>
<td>256</td>
<td>512</td>
</tr>
<tr>
<td>Floorplan Compiler</td>
<td>256</td>
<td>512</td>
</tr>
<tr>
<td>Formality¹</td>
<td>256</td>
<td>512</td>
</tr>
<tr>
<td>NanoSim</td>
<td>256</td>
<td>512</td>
</tr>
<tr>
<td></td>
<td>Recommended: 1GB</td>
<td>Recommended: 2GB</td>
</tr>
<tr>
<td>PathMill</td>
<td>256</td>
<td>512</td>
</tr>
<tr>
<td></td>
<td>Recommended: 1GB</td>
<td>Recommended: 2GB</td>
</tr>
<tr>
<td>PowerMill</td>
<td>256</td>
<td>512</td>
</tr>
<tr>
<td></td>
<td>Recommended: 1GB</td>
<td>Recommended: 2GB</td>
</tr>
<tr>
<td>PrimePower</td>
<td>128</td>
<td>256</td>
</tr>
<tr>
<td>PrimeTime</td>
<td>150</td>
<td>256</td>
</tr>
<tr>
<td>RailMill</td>
<td>256</td>
<td>512</td>
</tr>
<tr>
<td>Synthesis tools</td>
<td>128</td>
<td>256</td>
</tr>
<tr>
<td>System Studio</td>
<td>256</td>
<td>512</td>
</tr>
<tr>
<td>TetraMAX²</td>
<td>256</td>
<td>512</td>
</tr>
</tbody>
</table>
Physical Memory Requirements for Synthesis, PrimeTime, and Design Budgeting

For the synthesis, PrimeTime, or design budgeting tools to run efficiently, the physical memory must equal 25 to 50 percent of the swap space. For example, if you have 128 MB of swap space, you need at least 32 MB of physical memory. You might need as much as 64 MB, however. The more physical memory you have, the more quickly your job runs.

Swap Space Requirements for Synthesis Tools

The amount of swap space required by the synthesis tools depends on the size and type of each circuit design.

Use the following formula to help you determine the minimum amount of available swap space required for HDL designs: $16.3 \text{ MB} + (5.9 \times \text{(size of the design in K gates)})$. 

<table>
<thead>
<tr>
<th>Tool</th>
<th>Physical memory (MB)</th>
<th>Swap space (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TimeMill</td>
<td>256</td>
<td>Recommended: 1GB</td>
</tr>
<tr>
<td>VCS</td>
<td>256</td>
<td>Recommended: 2 GB</td>
</tr>
<tr>
<td>VCS MX</td>
<td>256</td>
<td>Recommended: 1GB</td>
</tr>
<tr>
<td>Vera</td>
<td>256</td>
<td>Recommended: 1GB</td>
</tr>
</tbody>
</table>

1. For large designs, the expected amount of required memory is approximately 1 million bytes per 2,000 gates.
2. Physical memory and swap space requirements are dependent on design size. For the figures in the table, it is assumed that the design size is less than 1 million (equivalent NAND) gates.
For example, a 5K-gate design requires $16.3 + (5.9 \times 5) = 45.8$ MB of available swap space.

**Accessing Memory Beyond 2 GB With 32-Bit Synopsys Tools**

In general, UNIX-based systems support a maximum memory of 2 GB for 32-bit processes. However, the following Synopsys tools can extend memory beyond 2 GB:

- Design Compiler
- Design Compiler FPGA
- DFT Compiler
- ESP
- Floorplan Compiler
- Floorplan Manager
- Formality
- HDL Compiler (Presto Verilog)
- NanoSim
- Physical Compiler
- Power Compiler
- PowerMill
- PrimePower
- PrimeTime
- RailMill
• TimeMill
• VCS
• VCS MX
• Vera

Note:
Available memory is space not used by the OS, the windowing system, or other applications.

To access memory beyond 2 GB,

1. Do one of the following, depending on the platform you are using:
   - For HP-UX,
     Make sure your server has HP-UX 11.0 (or later) loaded.
   - For Solaris,
     Make sure your server has Solaris 8 (or later) loaded.

2. Make sure your server has at least 4 GB of memory (physical and swap space) available.

Note:
Physical memory equals data size plus stack size, and stack size is used before data size. Therefore setting stack size to a large value causes problems for designs that need to go over 2 GB. If you set the stack size too high, you cannot get enough memory for your data. To check the settings, use the limit command at the system prompt. For more information, see “Memory” on page A-2.

3. Make sure the system you are using does not have restrictions that prevent you from using more than 2 GB of memory.
4. Create unlimited data size in the shell that you are using: C, Bourne, Korn, or Bash. If there are systemwide limits on the data size you can create, you can remove them or override them. You can do this in one of two ways:

- Enter one of the following commands:

  For the C shell,
  
  % limit datasize 3800000

  For the Bourne, Korn, or Bash shell,
  
  # ulimit -S -d 3800000

- Modify the kernel of your server. This approach allows everyone using your server to extend memory beyond 2 GB.

Note:

On HP-UX systems, you will see a data size of 2 GB. This value is accurate. After your process reaches the 2-GB limit, the Synopsys product extends the address space.

---

**Acquiring a License**

The Synopsys Common Licensing (SCL) system provides a single, common licensing base for all Synopsys tools. The SCL software and the documentation describing how to install and configure it are separate from the tools that use it.

Before you can use the Synopsys tools, you must do the following:

- If you have not already done so, retrieve your license keys from the SmartKeys Web page at http://solvnet.synopsys.com/smartkeys.
• Install the SCL software.

Note:

Installation of Synopsys tools and SCL is not order dependent. You can install SCL before or after you install your Synopsys tools. However, you cannot use your Synopsys tools until you have installed, configured, and started SCL.

Obtaining Your License Keys

To obtain your license key file from SmartKeys,

1. Go to the SmartKeys Web page at

   http://www.synopsys.com/smartkeys

2. On the SmartKeys Web page, click Key Retrieval.

3. In the Key Retrieval box, enter the following information:

   - Your site ID. This is the numeric site ID that identifies your customer site. If you have synthesis, test, or VHDL simulation tools installed, you can obtain the site ID by viewing your site_info file: $SYNOPSYS/admin/license/site_info.

   - Your host ID (optional). To obtain a license key file for a single host, enter its host ID. To obtain license keys for all hosts at the specified site, leave this field blank.

   - Your e-mail address. The default is your Synopsys e-mail address. This is the address that your key file will be sent to.

4. Click Continue to submit your request.
Installing Synopsys Common Licensing Software

You need to install, configure, and start a single copy of SCL software for all Synopsys tools. If you don’t have the SCL software, you can download it by EST or FTP (go to http://www.synopsys.com/keys/#download_scl).

Alternatively you can order the SCL software CD from the Synopsys MediaDocs Shop at http://mediadocs.synopsys.com.

Note:
Do not install SCL into an existing directory. You must install SCL into a stand-alone directory.

If you already have SCL 8.4.2 or later running, you do not need to reinstall it. However, if you are updating your license key file, you need to notify the SCL daemons that the license file has changed. See the SCL documentation for instructions on this process.

Note:
Not all Synopsys tools use the snpslmd common daemon. Other vendor daemons continue to be required for former Avant!, InnoLogic, and Numerical Technologies tools. SCL 8.4.2 includes the latest vendor daemons for avantd, tmald, CADABRA, innologd, numeritchd, TE_CATS, and so on.

For more information about licensing, see the following documents:

- *Synopsys Common Licensing Quick Start Guide*
  http://www.synopsys.com/keys

- *Common Licensing Installation and Administration Guide*

---

**Finding Your Site Identification Number**

Before you install any Synopsys product CD, locate and make a note of your Synopsys site identification number. Enter your site ID when prompted during the installation process.

Your site ID was shipped in the package with your Synopsys tools, or if you download the software, it is in your Synopsys Order Notification e-mail. If you have trouble locating it, contact your Synopsys sales representative.

---

**Creating the Synopsys Root Directory**

To create a new directory tree for this Synopsys release, enter

```
% mkdir -p /usr/synopsys/product_version
```

To set the permissions on the new directory tree, enter

```
% chmod 755 /usr/synopsys/product_version
```

**Important:**

Install each version of the software in a new directory. Do not install different versions of Synopsys software in the same directory.
Defining the SYNOPSYS Environment Variable

Set the SYNOPSYS environment variable ($SYNOPSYS) in the shell that you are using: C, Bourne, Korn, or Bash. In the following examples, the root_directory argument is the name of the Synopsys root directory.

If you are using the C shell, enter the following command to set the SYNOPSYS environment variable:

```
% setenv SYNOPSYS root_directory
```

If you are using the Bourne, Korn, or Bash shell, enter the following command to set the SYNOPSYS environment variable:

```
# SYNOPSYS=root_directory; export SYNOPSYS
```
This chapter provides information about downloading and installing Synopsys tools.

You can now install many Synopsys products by using a graphical user interface (GUI), or you can continue to use a text script. This chapter includes procedures for using both methods.

The chapter contains the following sections:

- Downloading the Software
- Untarring and Uncompressing the Files
- Installing EST Files by Using a Text Script
- Running the Installation Program From the GUI
- Installing Product Files From a CD
- Synopsys Media Installation Scripts
Downloading the Software

You can download Synopsys software in two ways:

- By File Transfer Protocol (FTP)
- From the Web

For help with download problems, contact the Synopsys Electronic Software Transfer department:

E-mail support: est-adm@synopsys.com
Telephone support: 650-584-1631

Note:
The EST department does not help with installation or licensing issues. For help with such issues, contact your local Support Center.

To access the online EST Troubleshooting Guide, go to http://www.synopsys.com/cgi-bin/est.cgi.

Important:
Install each version of the software in a new directory. Do not install different versions of Synopsys software in the same directory.

About the Synopsys Installer Software

You now have the option of installing many Synopsys products by using either a text script or by using a GUI. Beginning with the V-2004.06 release, to install Synopsys products you must download the synopsysinstaller_v1.0.n.tar.Z file located in the
synopsysinstaller_v1.0.n directory at the top level of the rev directory. The synopsysinstaller_v1.0.n.tar.Z file includes the scripts and files for text command or GUI installation.

The current installer version is 1.0.n, where n is a revision number indicating microrevisions. When you install a new product release, always download the latest version of the installer from the rev directory. (The Synopsys Installer is backward compatible.)

Instead of downloading the Synopsys Installer into each product installation directory, you can download it and uncompress it in a separate empty directory. If you do that, when you run the installation script you will be prompted to provide a path to the temporary directory containing the product files.

**Important:**

The install.now script is no longer included in the platform-independent (common) file. To have access to the install.now script, you must download the Synopsys Installer software (synopsysinstaller_v1.0.n) from the rev directory. (The installer is packaged with each CD product, so if you are installing from CD, you automatically have access to install.now.)

---

**Using the Product Files**

Depending on file size, product files are packaged by one of three processes, tar, tar.Z, or tar.gz. These instructions cover each process.

The product files use the following naming convention:

For .tar files

```
productname_productversion_common.tar
```
For tar.Z files

productname_productversion_common.tar.Z
productname_productversion_platform.tar.Z

For tar.gz files

productname_productversion_common.tar.gz
productname_productversion_platform.tar.gz

For each tool you want to install, substitute the appropriate product
ID and version for productname_productversion and platform
keyword for platform. (See “Products and Supported Platforms” on
page 1-6.)

Important:
Even though the install.now script is no longer contained in the
common file, for each product except SOLD, the synthesis tools,
and TetraMAX, you must download one common file
(platform-independent package) and one or more
platform-specific files. (See Figure 1-1 on page 1-5.)

For SOLD, download only the common file. (SOLD has no
platform-specific files.) For the synthesis tools, you must
download a common file for each of the following: synthesis (syn)
and Integrator for Falcon Framework (sf3 or sf4). For TetraMAX,
download common files for each of the following: TetraMAX
stand-alone (txs), TetraMAX overlay (tx), and TetraMAX
IddQTEST (idq).
Downloading the Files by FTP

In addition to downloading the product files, you must download the synopsysinstaller_v1.0.n.tar.Z file, which includes the files necessary for text script and GUI installation. It is recommended that you download the installer into a separate directory. This will enable you to use the same installer for each Synopsys product that uses the common installation method.

To download the files by FTP,

1. For each tool, create a separate empty directory to download your product files into. For example,

   ```
   mkdir -p /usr/synopsys/synopsysinstaller
   mkdir /tmp/product
   cd /tmp/product
   ```


   ```
   ftp ftp.synopsys.com
   ```

3. Enter your SolvNet user name and password.

4. At the ftp prompt, enter the following commands.

   ```
   binary
   cd rev
   cd productname_productversion
   get productname_productversion_common.tar
   get productname_productversion_platform.tar
   ```

   Remember to download the installer into a separate, stand-alone directory.

   ```
   lcd /usr/synopsys/synopsysinstaller
   cd rev
   dir #Look for synopsysinstaller_v1.0.n, where n is a number.
   cd synopsysinstaller_v1.0.n
   get synopsysinstaller_v1.0.n.tar.Z
   ```
where $n$ is the decimal revision number of the installer, for example, synopsysinstaller_v1.0.8.tar.Z.

For a list of products and supported platforms for this release, see “Products and Supported Platforms” on page 1-6.

5. Untar and uncompress your files (see “Untarring and Uncompressing the Files” on page 2-7).

---

**Downloading the Files From the Web**

In addition to downloading the product files, you must download the synopsysinstaller_v1.0.$n$.tar.Z file, which includes the files necessary for text script and GUI installation. It is recommended that you download the installer into a separate directory. This will enable you to use the same installer for each Synopsys product that uses the common installation method.

To download files from the Web,

1. For each tool, create a separate temporary directory to download your product files into. For example,

   ```bash
   % mkdir -p /usr/synopsys/synopsysinstaller
   % mkdir /tmp/product
   % cd /tmp/product
   ```

2. Go to the Electronic Software Transfer (EST) Web page at http://www.synopsys.com/download

3. Click the Authenticated Access button.

4. Enter your SolvNet user name and password.
5. Read the legal page and, if you agree, click “Yes, I agree to the above terms.”

A new page appears.

6. Click the rev folder.

7. Select the products you want to install (including the Synopsys Installer) and download the files into the temporary directory.

Remember to download the installer into a separate, stand-alone directory. Add this directory to the UNIX path.

Note:
For each product, you must download one common file (platform-independent package) and one or more platform-specific files.

8. Untar and uncompress your files (see “Untarring and Uncompressing the Files” on page 2-7).

Note:
For further download information, double-click the REV_VAULT_GUIDE folder, then double-click rev_vault_guide.html.

---

**Untarring and Uncompressing the Files**

After you download the files,

1. Untar the .tar files, or uncompress and untar the tar.Z or tar.gz files. For example,

   For tar files

   ```bash
   % tar xvf productname_productversion_common.tar
   ```
% tar xvf productname_productversion_platform.tar

For tar.Z files

% cat productname_productversion_common.tar.Z | uncompress | tar xvf -
% cat productname_productversion_platform.tar.Z | uncompress | \ tar xvf -

or

% zcat productname_productversion_common.tar.Z | tar xvf -
% zcat productname_productversion_platform.tar.Z | tar xvf -

For tar.gz files

% gzip -dc productname_productversion_common.tar.gz | tar xvf -
% gzip -dc productname_productversion_platform.tar.gz | tar xvf -

If you want to perform this process in two steps, do the following:

% gzip -d productname_productversion_common.tar.gz
% tar xvf productname_productversion_common.tar

% gzip -d productname_productversion_platform.tar.gz
% tar xvf productname_productversion_platform.tar

Substitute the appropriate product ID and version for productname_productversion and the platform keyword for platform. (See “Products and Supported Platforms” on page 1-6.)

Note:
If you don’t want to see the list of unpacked files, omit the v from xvf -.

2. Uncompress and untar the synopsysinstaller_v1.0.n.tar.Z file in a separate installer directory.

% mv synopsysinstaller_v1.0.n.tar.Z /usr/synopsys/synopsysinstaller
% cd /usr/synopsys/synopsysinstaller
% cat synopsysinstaller_v1.0.n.tar.Z | uncompress | tar xvf -
3. Install the software.

- To install the software by EST, see “Installing EST Files by Using a Text Script” on page 2-9.

- To install the software by using a GUI, see “Running the Installation Program From the GUI” on page 2-10.

---

# Installing EST Files by Using a Text Script

To install the software by using a text script,

1. Add the stand-alone installer directory to the UNIX path. For example,

   ```
   set path=(/usr/synopsys/synopsysinstaller $path)
   ```

2. Execute the following command:

   ```
   install.now
   ```

   To install Synopsys tools, it is recommended that you log on as root or have system administrator privileges. You need write permission for the installation directory.

   Note:

   The install.now installation file should be in a separate stand-alone directory. When you run the installation script you will be prompted to provide a path to the temporary directory containing the product files.

3. Answer the installation program prompts.

   For a sample text script, see “Synopsys Media Installation Scripts” on page 2-24.
**Important:**
When you are prompted to choose a location for installing the software, do not select the download or temporary directory. You must specify a new directory. Do not install different versions of Synopsys software in the same directory.

4. Repeat steps 1, 2, and 3 for each tool you want to install.

---

**Running the Installation Program From the GUI**

To install Synopsys tools, it is recommended that you log on as root or have system administrator privileges. You need write permission for the installation directory.

1. Add the stand-alone installer directory to the UNIX path. For example,

   ```bash
   % set path=/usr/synopsys/synopsysinstaller $path
   ```

2. To use the GUI to install Synopsys products, start the GUI by entering

   ```bash
   % setup.sh
   ```

**Note:**
The setup.sh installation file should be in a separate stand-alone directory. When you run the installation script, you will be prompted to provide a path to the temporary directory containing the product files.
View the Main Screen

The program starts automatically and the Synopsys Installer screen appears. Click Start to begin the installation.

Respond as necessary to each screen.

Note that selections shown in these screens are for demonstration purposes only.

During the installation process, you can exit the installation at any time. If you click Cancel during the product-specific installation, you will be returned to the Synopsys installation setup program. To exit completely, you must click Finish.
Browse or Enter the Path to the Product Files

If you are running the Synopsys Installer in a location different from where the product files reside, browse for the directory containing the files or enter the path to the directory.

Click Continue to view the next screen.
Select the Release Version

Select the version of the release you want to install.

Click Next to continue.
Enter your site information

Enter your site ID and the name and e-mail address of your license administrator.

Your site ID was shipped in the package with your Synopsys tools, or if you download the software, it is in your Synopsys Order Notification e-mail. If you have trouble locating it, contact your Synopsys sales representative.

Click Next to continue.
Select the Products You Want to Install

Each stand-alone product must be installed in an empty directory.

Click Next to continue.
Review the Product Package

The platform-independent package, or common file, is selected automatically. This file is required when you are installing a new version of a product for the first time. If you do not want to install the common file, deselect the box next to the appropriate tool.

Note:
When you install SOLD, do not deselect the chosen selection. You must select the platform-independent package.

Click Next to continue.
Select the Platform

You can select one or more platforms on which to install the products.

Note:

SOLD is platform independent (that is, it installs on any platform); therefore, when you install SOLD, All is preselected as the platform selection.

Click Next to continue.
Select the Destination Directory

Select the directory in which you want to install the product. You can browse for a directory or enter it in the “Install to” pane.

Click Next to continue.
Verify the Selected Information

Verify the selected information, then click Install to begin the installation or Back to change information.
Wait While the Products Are Installed

The installation program is loading. Click Cancel to return to the Synopsys installation setup program.

The “Installation progress” bar lets you track progress as the program installs the products. You can also see where you are by checking the current action.
Exit or Install Another Product

When the program completes the installation, click Install Another Product if you want to install additional products, or click Finish to exit the program.
Installing Product Files From a CD

You can now install many Synopsys products by using either a text script or a GUI. Use the following installation procedures to transfer the files from each CD (or CD set) to your system.

Note:
Only authorized sites are eligible to order CD media. If your site is authorized to order CD media, you can order CDs by logging on to the SolvNet Web site (http://solvnet.synopsys.com) and clicking the MediaDocs link.

To install a Synopsys product from a CD,

1. Create a product installation directory. For example,

   % mkdir installation_directory

2. Insert the product CD into the CD-ROM drive.

3. Mount the CD if necessary. For example, enter

   % mount -o ro /dev/dsk/c2t1d4s0 /cdrom

   Mounting the CD might require root access privileges. If you do not have root access privileges, see your system administrator for assistance. If you have the proper privileges, complete the following steps.

   Mounting instructions vary by operating system. See your system man pages for the correct CD mounting commands.

   Note:
   By default, some systems mount the CD-ROM drive automatically.
4. Change your directory to the CD-ROM directory. On Red Hat Linux, the CD-ROM directory is /mnt/cdrom. On Solaris (with the vold daemon running), it is /cdrom/cdrom0. For example,

```
% cd /cdrom/cdrom0
```

5. View the README.productname file for the most up-to-date disk space requirements.

6. Enter one of the following commands, depending on whether you want to use a text script or a GUI:

```
% install.now  #To use a text script
% setup.sh     #To use a GUI
```

If you select the GUI, go to “Running the Installation Program From the GUI” on page 2-10. If you select a text script, continue with step 7.

7. Answer the installation program prompts.

For a sample text script, see “Synopsys Media Installation Scripts” on page 2-24.

Note:

If you receive an UNCOMPRESS/TAR ERROR during the installation script, rerun the installation command, using the `-i` option to correct the problem. For example, enter

```
% install.now -i
```

8. When installation is finished, move to another directory. For example, enter

```
% cd /tmp
```

9. Unmount the CD by using the appropriate command for your operating system. For example, enter
% umount /cdrom

Note:

If you are running the Solaris vold daemon, use the eject command to unmount the CD.

10. Remove the CD from the drive.

Note:

Before you can run Synopsys tools, the Synopsys Common Licensing (SCL) software must be installed. In addition, a licensing variable such as LM_LICENSE_FILE or SNPSLMD_LICENSE_FILE must be set. For details about Synopsys licensing software, see the Synopsys Licensing QuickStart Guide available at http://www.synopsys.com/keys.

---

**Synopsys Media Installation Scripts**

This section contains sample installation scripts for the synthesis tools and PrimeTime. Other tools that use the Synopsys Installer text script are installed in a similar manner.

---

**Synthesis Tools Script**

*Example 2-1* shows a sample Synopsys media installation script for the synthesis tools on the Sun Solaris platform; it applies to installation by EST and from the CD.

*Example 2-1 Synopsys Media Installation Script for the Synthesis Tools*

```bash
Synopsys Media Installation

Instructions: The list within {} shows the choices for a given option. The entry within [] shows the default selection when you hit the Return key. You can cancel the installation by
```
The current mounted Synopsys CD file system is W-2004.12.

<table>
<thead>
<tr>
<th>VERSION:</th>
<th>W-2004.12</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODUCTS:</td>
<td>syn sf3 sf4</td>
</tr>
<tr>
<td>PLATFORMS:</td>
<td>sparcOS5</td>
</tr>
<tr>
<td>PART NUMBER:</td>
<td>XXXXXX</td>
</tr>
</tbody>
</table>

Install W-2004.12 release? {y,n} [y]: y

Enter the full path to the directory where you want to install Synopsys W-2004.12_syn products. If the directory does not exist, it will be created. [/usr/synopsys]: /usr/synopsys/syn_W-2004.12


Select Synopsys product(s) to install:

```
{  syn - Core Synthesis Tools
   sf3 - Synopsys Integrator for Falcon Framework MentorC
   sf4 - Synopsys Integrator for Falcon Framework MentorD
}
```

Enter the list of product(s) to install [syn sf3]: syn sf3

Product(s) selected: syn sf3

Platform Independent Package for a particular product contains support files that are common to all the platforms. You must install this package for each product if you are installing it to the /usr/synopsys/syn_W-2004.12 directory for the first time.

Install Platform Independent Package for syn? {y,n} [y]: y

Install Platform Independent Package for sf3? {y,n} [y]: y

sparcos5

Verify cksum for ./syn.taz ...Pass.
Verify cksum for ./sparcos5/syn.taz ...Pass.
Verify cksum for ./sf3.taz ...Pass.
Verify cksum for ./sparcos5/sf3.taz ...Pass.

Platform(s) selected: sparcos5
Here is your final selection for installing Synopsys Tools:

VERSION: W-2004.12
PRODUCTS: syn sf3
PLATFORMS: sparcos5

Synopsys Media Directory (from) : /cdrom
Synopsys Install Directory (to) : /usr/synopsys/syn_W-2004.12

Platform Independent Package(s) for : syn sf3

Disk space required : 1034 MB
Disk space available : 14649 MB

If all the information is correct, continue with the installation.

___________________________________________________________________________
Install? {y,n} [y]: y

Starting Installation ... Please do not interrupt.

  uncompress < ./syn.taz | (cd /usr/synopsys/syn_W-2004.12; tar xvfp - )

sparcos5
  uncompress < ./sparcos5/syn.taz | (cd /usr/synopsys/syn_W-2004.12; tar xvfp - )

  uncompress < ./sf3.taz | ( cd /usr/synopsys/syn_W-2004.12; tar xvfp - )

sparcos5
  uncompress < ./sparcos5/sf3.taz | (cd /usr/synopsys/syn_W-2004.12; tar xvfp - )

Installing Design Compiler ...

Installing Module Compiler ...

Installing Library Compiler ...

Installing Physical Compiler ...
Setting up environment for Astro ...

Installing Synopsys Integrator for Falcon Framework version C
Synopsys Site Identification Number appears on the upper right corner of your Synopsys License Key Certificate.

Synopsys Site Identification Number [Hit return for 000]: 000

Synopsys License Administrator is a person who must be contacted for Synopsys product related administrative tasks at your site.

Local Synopsys License Administrator [Hit return for customer]:

License Administrator Contact is the current phone number and/or Email address of customer.

License Administrator Contact [Hit return for ###-#### and/or user@email]:

Created site file /usr/synopsys/syn_W-2004.12/admin/license/site_info.

Installation is complete.


Thank you ...

---

**PrimeTime Script**

**Example 2-2** shows a sample Synopsys media installation script for PrimeTime; it applies to installation by EST and from a CD.

**Example 2-2  Synopsys Media Installation Script for PrimeTime**

Instructions: The list within {} shows the choices for a given option. The entry within [ ] shows the default selection when you hit the Return key. You can cancel the installation by entering quit when prompted for input.
The current mounted Synopsys CD file system is V-2003.12.

VERSION:  W-2004.12
PRODUCTS:  pts
PLATFORMS:  sparcOS5 sparc64
PART NUMBER:  XXXXXX

Install W-2004.12 release? {y,n} [y] y

NOTE: The product(s) pts on this CD-ROM must be installed in a stand-alone directory.

Enter the full path to the directory where you want to install Synopsys W-2004.12_pts products. If the directory does not exist, it will be created.  [/usr/synopsys]: /usr/synopsys/pts_W-2004.12

Creating Synopsys root directory /usr/synopsys/pts_W-2004.12...

Product(s) selected: pts

The Platform Independent Package for a particular product contains support files that are common to all the platforms. You must install this package for each product if you are installing it to the /usr/synopsys/pts_W-2004.12 directory for the first time.

Install Platform Independent Package for pts? {y,n} [y]: y

Select platform(s) to install:
{  
  sparcOS5 (for Solaris 8, 9)
  sparc64 (for Solaris 8, 9; 64-bit)
}

Enter the list of platform(s) to install [sparcOS5]: sparcOS5
Platform(s) selected: sparcos5

Here is your final selection for installing Synopsys Tools:

VERSION:  W-2004.12
PRODUCTS:  pts
PLATFORMS:  sparcos5

Synopsys Media Directory (from) : /cdrom
    Synopsys Install Directory (to) : /usr/synopsys/pts_W-2004.12

Platform Independent Package(s) for : pts

Disk space required : 290 MB
Disk space available : 10063 MB

If all the information is correct, continue with the installation.

_________________________________________________________
Install? {y,n} [y]: y

Starting Installation ... Please do not interrupt.

uncompress < ./pts.taz | ( cd /usr/synopsys/pts_W-2004.12; tar xvfp - ) sparcos5
uncompress < ./sparcos5/pts.taz | (cd /usr/synopsys/pts_W-2004.12; tar xvfp - )

Installing PrimeTime ...

Synopsys Site Identification Number appears on the upper right corner of your Synopsys License Key Certificate.

Synopsys Site Identification Number [Hit return for 000]: 000

Synopsys License Administrator is a person who must be contacted for Synopsys product related administrative tasks at your site.

Local Synopsys License Administrator [Hit return for customer]:

License Administrator Contact is the current phone number and/or Email address of customer.

License Administrator Contact [Hit return for ###-#### and/or user@email]:

Created site file /usr/synopsys/pts_W-2004.12/admin/license/site_info.

Installation is complete.


Thank you ...
Part II: Specific Product Instructions
This chapter describes how to install the AMPs product.

This chapter contains the following sections:

- Installing the Software
- Setting Up AMPS for Each User
- Verifying the AMPS Installation

To ensure a successful installation, complete the following procedures before beginning the installation process:

- Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).
- Define the `SYNOPSYS` environment variable (see “Defining the SYNOPSYS Environment Variable” on page 1-20).
• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
Installing the Software

To download and install AMPS from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the AMPS software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-2 on page 2-27 shows a Synopsys media installation script for PrimeTime. AMPS is installed in a similar manner.

The AMPS tool is on the PathMill CD. AMPS is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of AMPS. You must create a new directory for AMPS.

Setting Up AMPS for Each User

To set up a new AMPS tool user, add the AMPS directory containing the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

```
set path=($SYNOPSYS/platform/amps/bin $path)
```

If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile or .kshrc file:

```
PATH=$SYNOPSYS/platform/amps/bin:$PATH
export PATH
```

Replace platform with the appropriate platform (see “Products and Supported Platforms” on page 1-6).
Verifying the AMPS Installation

To verify the AMPS installation,

1. Make sure you are in a directory where you have read/write privileges:

   \% cd $HOME

2. Invoke the tool by entering the following command:

   \% $SYNOPSIS/platform/amps/bin/amps

   Replace platform with the appropriate platform (see “Products and Supported Platforms” on page 1-6).

   If you see information about the product version, production date, and copyright, the installation was successful.
This chapter describes how to install the Astro, Astro Interactive Ultra, and Jupiter XT products.

Note:
The installation instructions in this chapter are the most up-to-date available at the time of production. However, changes might have occurred. For the latest installation information, see the product release notes or documentation.

Important:
The installation procedure for these versions of Astro products has changed. These products now use the Synopsys Installer. (See “About the Synopsys Installer Software” on page 2-2.)
This chapter contains the following sections:

- Media Availability and Supported Platforms
- Disk Space Requirements
- Installing the Software
- Setting Up Astro for a New User
- Verifying the Astro Installation

To ensure a successful installation, have your license server running and have the appropriate license keys installed before beginning the installation process. (See “Acquiring a License” on page 1-16).
Media Availability and Supported Platforms

The current versions of the Astro, Astro Interactive Ultra, and JupiterXT tools are available on CD or by EST. Obtain the appropriate binary executable files based on the operating system you need. Table 4-1 shows the supported operating systems and keywords for this release.

Table 4-1  Supported Operating Systems and Keywords

<table>
<thead>
<tr>
<th>Platform</th>
<th>Operating system</th>
<th>Platform keyword</th>
<th>Path keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD Opteron</td>
<td>Red Hat Enterprise Linux 3.01</td>
<td>amd64 (64-bit mode)</td>
<td>AMD.64</td>
</tr>
<tr>
<td>HP PA-RISC 2.0</td>
<td>HP-UX 11.0, 11.11 (11.i)</td>
<td>hp64 (64-bit)</td>
<td>HP.64</td>
</tr>
<tr>
<td>IA-32 (x86)</td>
<td>Red Hat Enterprise Linux 3.0</td>
<td>linux</td>
<td>IA.32</td>
</tr>
<tr>
<td>IA-32 (x86)</td>
<td>Red Hat Linux 7.2</td>
<td>linux72</td>
<td>IA.32-RH72</td>
</tr>
<tr>
<td>Itanium 2</td>
<td>Red Hat Enterprise Linux 2.1</td>
<td>linuxipf (64-bit mode)</td>
<td>IA.64</td>
</tr>
<tr>
<td>Sun SPARC</td>
<td>Solaris 8, 9</td>
<td>sparcOS5 (32-bit)</td>
<td>SUN.32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sparc64 (64-bit)</td>
<td>SUN.64</td>
</tr>
</tbody>
</table>

1. The HP-UX, Red Hat Linux 7.2, and Red Hat Enterprise Linux 64-bit platforms will be available for download by electronic software transfer (EST) at a later date. For availability, check with your Synopsys sales representative.

2. Binary-compatible operating system. Note, however, that binary compatibility is not guaranteed.

To install a product, select the appropriate platform keyword. To set an environment variable, select the appropriate path keyword (see “Setting Up Astro for a New User” on page 4-6).
Disk Space Requirements

The disk space requirement varies depending on the platform and the tool selected for installation. Table 4-2 shows the maximum space required for installing each product on a particular platform.

Table 4-2  Disk Space Requirements (in Megabytes)

<table>
<thead>
<tr>
<th>Platform</th>
<th>Astro</th>
<th>Jupiter XT</th>
<th>Astro Interactive Ultra</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base size</td>
<td>231 MB</td>
<td>250 MB</td>
<td>65 MB</td>
</tr>
<tr>
<td>AMD Opteron Red Hat Enterprise 64-bit</td>
<td>321 MB</td>
<td>270 MB</td>
<td></td>
</tr>
<tr>
<td>HP-UX 64-bit</td>
<td>475 MB</td>
<td>410 MB</td>
<td>156 MB</td>
</tr>
<tr>
<td>Itanium Red Hat Enterprise 64-bit</td>
<td>667 MB</td>
<td>570 MB</td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise 3.0. 32-bit</td>
<td>296 MB</td>
<td>270 MB</td>
<td>105 MB</td>
</tr>
<tr>
<td>Red Hat 7.2 32-bit</td>
<td>455 MB</td>
<td>370 MB</td>
<td></td>
</tr>
<tr>
<td>Sun Solaris 32-bit</td>
<td>427 MB</td>
<td>410 MB</td>
<td>135 MB</td>
</tr>
<tr>
<td>Sun Solaris 64-bit</td>
<td>485 MB</td>
<td>420 MB</td>
<td>156 MB</td>
</tr>
</tbody>
</table>
Installing the Software

Although the following instructions specifically address the Astro tool, they also apply to Astro Interactive Ultra and JupiterXT.

Beginning with the V-2004.03 release, the installation procedure for Astro has changed. Astro now uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install Astro from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the Astro software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. Astro is installed in a similar manner.

Astro is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of Astro. You must create a new directory for Astro.
Setting Up Astro for a New User

This section describes how to set up a local machine for Solaris so that it can access the Synopsys software. Perform this procedure for each machine on the network.

Note:
The Astro license file uses the avantd daemon, which must be included on the VENDOR line of the license file. The path to the avantd daemon is scl_root/platform/daemons/avantd, where scl_root refers to the Synopsys Common Licensing (SCL) root directory.

To set up your machine,

1. Update your environment variables by adding the following variables in your .cshrc file:

   - If you are using the C shell, enter

     ```
     setenv LM_LICENSE_FILE license_dir/synopsys.lic:$LM_LICENSE_FILE
     set path=(install_dir/bin/platform $path)
     ```

   - If you are using the Bourne or Korn shell, enter

     ```
     LM_LICENSE_FILE=license_dir/synopsys.lic:$LM_LICENSE_FILE
     export LM_LICENSE_FILE
     PATH=install_dir/bin/platform:$PATH
     export PATH
     ```

   where license_dir is the directory in which the Synopsys license file is located, synopsys.lic is the name of the Synopsys license file, install_dir is the Astro root directory, and platform is the appropriate hardware platform.
2. Update your path variable by entering
   \% source .cshrc

3. To resolve potential keyboard mapping problems, copy the 
   install_dir/etc/XKeysymDB file to /usr/lib/X11.
   
   or
   
   In the .cshrc file, add
   
   `setenv XKEYSYMDB $SYNOPSYS/etc/XKeysymDB`

Verifying the Astro Installation

To verify the Astro installation,

1. Make sure you are in a directory where you have read/write
   privileges.
   
   \% cd $HOME

2. Invoke the tool by entering

   \% Astro

   If you see information about the product version, production date,
   and copyright, the installation was successful.
This chapter describes how to install the Astro-Rail product.

This chapter contains the following sections:

• Media Availability and Supported Platforms
• Disk Space Requirements
• Installing the Software
• Setting Up Astro-Rail for a New User
• Verifying the Astro-Rail Installation

To ensure a successful installation, have your license server running and have the appropriate license keys installed before beginning the installation process (see “Acquiring a License” on page 1-16).
Media Availability and Supported Platforms

Astro-Rail is available on CD or by EST. Obtain the appropriate binary executable files based on the operating system you need. Table 5-1 shows the supported operating systems and keywords for this release.

Table 5-1 Supported Operating Systems and Platform Keywords

<table>
<thead>
<tr>
<th>Platform</th>
<th>Operating system</th>
<th>Platform keyword</th>
<th>Path keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD Opteron</td>
<td>Red Hat Enterprise Linux 3.01</td>
<td>amd64 (64-bit mode)</td>
<td>AMD.64</td>
</tr>
<tr>
<td>HP PA-RISC 2.0</td>
<td>HP-UX 11.0, 11.11 (11.i)</td>
<td>hp64 (64-bit)</td>
<td>HP.64</td>
</tr>
<tr>
<td>IA-32 (x86)</td>
<td>Red Hat Enterprise Linux 3.0</td>
<td>linux</td>
<td>IA.32</td>
</tr>
<tr>
<td>IA-32 (x86)</td>
<td>Red Hat Linux 7.2</td>
<td>linux72</td>
<td>IA.32-RH72</td>
</tr>
<tr>
<td>Itanium 2</td>
<td>Red Hat Enterprise Linux 2.1</td>
<td>linuxipf (64-bit mode)</td>
<td>IA.64</td>
</tr>
<tr>
<td>Sun SPARC</td>
<td>Solaris 8, 9</td>
<td>sparcOS5 (32-bit)</td>
<td>SUN.32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sparc64 (64-bit)</td>
<td>SUN.64</td>
</tr>
</tbody>
</table>

1. The HP-UX, Red Hat Linux 7.2, and Red Hat Enterprise Linux 64-bit platforms will be available for download by electronic software transfer (EST) at a later date. For availability, check with your Synopsys sales representative.
2. Binary-compatible operating system. Note, however, that binary compatibility is not guaranteed.

To install a product, select the appropriate platform keyword. To set an environment variable, select the appropriate path keyword (see “Setting Up Astro-Rail for a New User” on page 5-4).
Disk Space Requirements

The disk space requirement varies depending on the platform and the tool selected for installation. Table 5-2 shows the maximum space required for installing each product on a particular platform.

Table 5-2  Disk Space Requirements (in Megabytes)

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Megabytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base size (including online Help files)</td>
<td>250</td>
</tr>
<tr>
<td>AMD Opteron 64-bit</td>
<td>90</td>
</tr>
<tr>
<td>Sun Solaris 32-bit</td>
<td>110</td>
</tr>
<tr>
<td>Sun Solaris 64-bit</td>
<td>125</td>
</tr>
<tr>
<td>HP-UX 64-bit</td>
<td>125</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 32-bit</td>
<td>80</td>
</tr>
<tr>
<td>Red Hat Linux 7.2 32-bit</td>
<td>80</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 64-bit</td>
<td>175</td>
</tr>
</tbody>
</table>

Installing the Software

Astro-Rail uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install Astro-Rail from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.
To install the Astro-Rail software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. Astro-Rail is installed in a similar manner.

Astro-Rail is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of Astro-Rail. You must create a new directory for Astro-Rail.

Setting Up Astro-Rail for a New User

This section describes how to set up a local machine for Solaris so that it can access the Synopsys software. Perform this procedure for each machine on the network.

To set up your machine,

1. Update your environment variables by adding the following variables in your .cshrc file:

   - If you are using the C shell, enter

     ```
     setenv LM_LICENSE_FILE license_dir/ 
     synopsys.lic:$LM_LICENSE_FILE
     set path=(install_dir/bin/platform $path)
     ```

   - If you are using the Bourne or Korn shell, enter

     ```
     LM_LICENSE_FILE=license_dir/ 
     synopsys.lic:$LM_LICENSE_FILE
     export LM_LICENSE_FILE
     PATH=install_dir/bin/platform:$PATH
     export PATH
     ```
where license_dir is the directory in which the Synopsys license file is located, synopsys.lic is the name of the Synopsys license file, install_dir is the Astro-Rail root directory, and platform is the appropriate hardware platform.

2. Update your path variable by entering

   \% source .cshrc

3. To resolve potential keyboard mapping problems, copy the install_dir/etc/XKeysymDB file to /usr/lib/X11.

Verifying the Astro-Rail Installation

To verify the Astro-Rail installation,

1. Make sure you are in a directory where you have read/write privileges.

   \% cd $HOME

2. Invoke the tool by entering

   \% AstroRail

   If you see information about the product version, production date, and copyright, the installation was successful.
This chapter describes how to install the Cadabra product.

This chapter contains the following sections:

- Installing the Software
- Setting the Environment Variables
- Verifying the Cadabra Installation
- Customer Support

To ensure a successful installation, complete the following procedure, have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
Installing the Software

Cadabra uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install Cadabra from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the Cadabra software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the Synthesis tools. Cadabra is installed in a similar manner.

Cadabra is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of Cadabra. You must create a new directory for Cadabra.

Setting the Environment Variables

This section discusses the following environment variables:

- CADABRAHOME
- LM_LICENSE_FILE

It is recommended that you place these variables in your $HOME/.cshrc or $HOME/.profile file as your default settings.
Setting the CADABRAHOME Environment Variable

Follow these steps.

1. Set the $CADABRAHOME environment variable to point to your Cadabra installation subdirectory.

   - If you are using the C shell, add the following line:
     
     \%
     \setenv CADABRAHOME /u/edatools/cadabra-version

   - If you are using the Bourne shell, add these lines:
     
     \%
     CADABRAHOME=/u/edatools/cadabra-version
     export CADABRAHOME

2. Add $CADABRAHOME/bin to your search path:

   - If you are using the C shell, enter
     
     set path=($CADABRAHOME/bin $path)

   - If you are using the Bourne shell, enter
     
     PATH=$CADABRAHOME/bin:$PATH
     export PATH
Setting the LM_LICENSE_FILE Environment Variable

To enable Cadabra to check out a license, you must set the `LM_LICENSE_FILE` environment variable.

- If you are using the C shell, add the following line to the `.cshrc` file:

  ```bash
  setenv LM_LICENSE_FILE port@hostname
  ```

- If you are using the Bash or Bourne shell, add these lines to the `.bashrc` or `.profile` file:

  ```bash
  LM_LICENSE_FILE=port@hostname
  export LM_LICENSE_FILE
  ```

The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use `port@host` rather than using the path to the license file.

You can specify multiple license files by separating each entry with a colon (`:`).

Verifying the Cadabra Installation

To verify the Cadabra installation,

1. Make sure you are in a directory where you have read/write privileges.

   ```bash
   cd $HOME
   ```

2. If you are using a display that is not local, set the `DISPLAY` environment variable.
\verbatim
% setenv DISPLAY my_display:0.0

3. Invoke the tool by entering

\verbatim
% kazam
\endverbatim

If the product GUI appears, the installation was successful.

4. Exit the GUI by choosing File > Exit in any GUI window.

Customer Support

For information about accessing customer support, see “Customer Support” on page xxiii. You can also send an e-mail message to Cadabra Support at cadabrasupport@synopsys.com.
This chapter describes how to install the CosmosScope product.

Note:
The installation instructions in this chapter are the most up-to-date available at the time of production. However, changes might have occurred. For the latest installation information, see the product release notes or documentation.

This chapter provides instructions for both UNIX and Windows platforms.

This chapter includes the following sections:

• Preparing for Installation
• Installing the Software (UNIX and Windows)
• Invoking CosmosScope on Windows
• Setting Up the User Environment on UNIX
• Verifying the CosmosScope Installation on UNIX
• Using Command Options
• Uninstalling the Software
• Customer Support

**Important:**

Do not install a later version of the CosmosScope tools over an earlier version of the tools.
Preparing for Installation

Before beginning the installation process, read the *CosmosScope Release Notes*. The *Release Notes* are in Portable Document Format (PDF) and are located at the top level of the CD and in the electronic software transfer (EST) download directory. They require a PDF file reader to view and print them. Check for the following information:

- Changes in licensing requirements
- Changes in memory requirements
- The operating system versions on which the software is supported
- Changes made from prior releases


By default, the interface to MATLAB version 6.5 is installed with CosmosScope. If you want to use version 6.1, see the INSTALL_README.wri file.

**UNIX**: You must have root or administration privileges when installing licensing or tools in a restricted directory location.

The installation script requires the Bourne shell to be available at `/bin/sh`. 

Preparing for Installation
7-3
Windows: Administration privileges are required for installing and uninstalling the tool. To ensure a successful installation, confirm that previous releases have been uninstalled (see “Uninstalling the Software” on page 7-18). If licensing will be installed with this installation, you must stop any existing license servers (lmgrd or avantd), then uninstall licensing. To stop the Avantd Flexlm license server or Flexlm license server, choose Administrative Tools > Services from the Control Panel.

Supported Platforms and Compilers

CosmosScope is available on CD or by EST. Obtain the appropriate binary executable files for your operating system. Table 7-1 lists the supported platforms for this release.

Table 7-1 Supported Platforms, Operating Systems, and Keywords

<table>
<thead>
<tr>
<th>Platform</th>
<th>Operating system</th>
<th>Synopsys platform keyword</th>
<th>Window environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP</td>
<td>HP-UX 11.0, 11.11 (11i)¹, ²</td>
<td>hp32 (32-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td>Sun SPARC</td>
<td>Solaris 8, 9¹</td>
<td>sparcOS5 (32-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td>IBM</td>
<td>AIX 5.1²</td>
<td>rs6000 (32-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td>IA-32 (X86)</td>
<td>Red Hat Enterprise Linux 3.0</td>
<td>linux (32-bit mode)</td>
<td>GNOME</td>
</tr>
<tr>
<td>IA-32 (X86)</td>
<td>Red Hat Linux 7.2²</td>
<td>linux72 (32-bit mode)</td>
<td>GNOME</td>
</tr>
<tr>
<td>IA-32 (X86)</td>
<td>XP Professional v2002</td>
<td>winXP</td>
<td></td>
</tr>
<tr>
<td>IA-32 (X86)</td>
<td>Windows 2000 SP3</td>
<td>win2000</td>
<td></td>
</tr>
</tbody>
</table>

1. Binary-compatible operating system. Note, however, that binary compatibility is not guaranteed.
2. The HP-UX, Red Hat Linux 7.2, and AIX 5.1 platforms are not available on CD. They will be available for download by EST at a later date. For availability, check with your Synopsys sales representative.
**Disk Space and Memory Requirements**

The disk space requirement varies depending on the platform and the features selected for installation. Table 7-2 shows the maximum space required for installing all CosmosScope features on a particular platform. Each CD also includes this information in the top-level INSTALL_README.wri file.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Software (maximum)</th>
<th>Default temporary directory location</th>
<th>Temporary disk space from CD</th>
<th>Temporary disk space from EST</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solaris</td>
<td>190</td>
<td>/var/tmp</td>
<td>100</td>
<td>130</td>
</tr>
<tr>
<td>HP-UX</td>
<td>200</td>
<td>/var/tmp</td>
<td>120</td>
<td>150</td>
</tr>
<tr>
<td>Linux</td>
<td>150</td>
<td>/tmp</td>
<td>70</td>
<td>100</td>
</tr>
<tr>
<td>Windows</td>
<td>120</td>
<td>%TEMP% or C:\My Documents\temp</td>
<td>40</td>
<td>75</td>
</tr>
<tr>
<td>IBM</td>
<td>120</td>
<td>/var/tmp</td>
<td>60</td>
<td>100</td>
</tr>
</tbody>
</table>

If the default temporary directory has insufficient disk space, use the -is:tempdir /mytempdir command-line option to use an alternative directory for temporary storage. For example, for UNIX platforms,

```
% setup -is:tempdir ~/tmp
```

or

```
% CosmosScope_version_platform.bin -is:tempdir ~/tmp
```
Installing the Software (UNIX and Windows)

You can install CosmosScope version V-2004.06 by using a GUI or by using text commands. By default, the CosmosScope installer invokes the installation GUI. To install CosmosScope by using text commands, see “Using Command Options” on page 7-16.

Installing the Software by EST

Download the CosmosScope release to a temporary directory. You can obtain the latest CosmosScope download instructions from the SolvNet Release Library.

To install the software on UNIX systems,

1. Double-click the downloaded file, or enter the file name at the command prompt. For example,

   % CosmosScope_version_platform.bin

   where version is the release you are installing. Replace platform with the appropriate platform keyword (see Table 7-1 on page 7-4).

2. Continue with the steps in “Running the Installation Program” on page 7-8.

To install the software on Windows systems,

1. Locate and double-click the .exe file. For example, double-click

   CosmosScope_version_win.exe

   where version is the release you are installing.
2. Continue with the steps in “Running the Installation Program” on page 7-8.

---

**Installing the Software From a CD**

Mounting the CD might require root access privileges. If you do not have root access privileges, see your system administrator for instructions on mounting the CD. For detailed instructions, see “Installing Product Files From a CD” on page 2-22.

To mount the CD on UNIX systems,

1. Place the CD in the CD drive.

   Most UNIX systems will automatically mount the CD. If the CD does not mount, see “Installing Product Files From a CD” on page 2-22

2. To invoke the installer, enter

   ```
   % /cdrom/setup
   
   or
   
   % cd your_cd_path; ./setup
   ```

3. Continue with the steps in “Running the Installation Program,” next.

To mount the CD on Windows systems,

1. Place the CD in the CD drive.

   The installation program should start automatically. If it does not, double-click the setup.exe executable file, located at the root level of the CD. For example,
D:\setup.exe  #Where D is your CD drive.

2. Continue with the steps in “Running the Installation Program,” next.

---

**Running the Installation Program**

Make certain that any open applications are closed before proceeding with the installation.

When the installation program begins, the Welcome screen appears. Answer the installation prompts and click Next to continue. If scroll bars appear in the panel, scroll to make sure you have reviewed all available information.

Only the screens that require more explanation are shown. (Note that selections shown in these screens are for demonstration purposes only and might not reflect the current product version.)

1. Read the Welcome Screen.

2. In the Installation Type window, select the type of installation you want to perform.

   **UNIX:** Select a Typical or Custom installation.

   **Windows:** Select a Typical or Custom installation, or select a Network installation to establish network access from a client machine to previously installed products on a remote machine.

3. If you selected a Typical or Custom installation, enter a directory name that does not include spaces in the Destination box. You can also use the Browse button to select a directory.
4. (Windows only) If you have chosen to perform a network installation, create a network mapped drive to a remote machine on which the CosmosScope software was previously installed. If not, skip to step 6.

5. (Windows only) Set up network access to a remote machine.

   The Network installation option allows you to link to applications previously installed on other Windows machines. It is assumed that a stand-alone CosmosScope installation has already been performed on another machine.
- Enter the source path by using the previously created mapped drive, which resolves to the location where the ai_bin directory is located. For example,

\[
\text{S:\Synopsys\W-2004.12}
\]

where S: is your network mapped drive.

- Enter a destination path name to a location on the local host machine where a minimal set of files will be installed. In the Browse window, navigate to the directory you want, for example, W-2004.12. Select this directory and click the Open button. The path to the W-2004.12 directory is inserted in the Destination box.

6. Select a license server type.

Note:

This option is available for Windows users only. However, licensing files are installed for all platforms in a directory named licensing, located in the product directory (for example, Saber/licensing). This allows you to manually set up licensing for UNIX or for Windows if necessary.

7. (Windows only) Select one of the following license server setup types:

- None

- Install and setup for Single server type

- Install and setup for Quorum server type

8. For a single license server, specify the port, host name, and license file path.
License server files are always installed, but Windows services are installed only if the local host or the machine the installer is running on matches what is specified in the HostName box, where *mylocalhost* is the name of the host you are running on.

9. For a quorum license server, specify the port, host name, and license file path.

License server files are always installed, but Windows services are installed only if the local host or the machine the installer is running on matches what is specified in one of the *hostname* fields, where *mylocalhost* is the name of the host you are running on.
10. Wait while the disk space is being verified. You will see a screen that asks you to wait while the disk space is being verified. Then the summary information screen appears. This screen summarizes the selections you have made and the disk space requirements.

11. Wait while the products are installed.

While files are being copied, you can track the Installation progress in the progress bar. When the bar shows a 100 percent progress, you must wait while the uninstall program is created. The final installation status is then displayed, with the message that the tool has finished installing.

If errors are displayed in the final installation status, see the install log for details.
Click Finish to exit the installation program.

---

**Invoking CosmosScope on Windows**

To invoke CosmosScope on Windows platforms, perform the following steps:

1. Check that your `LM_LICENSE_FILE` variable is set to a valid licensing server.

   To ensure that licenses are available, use the `LMTOOLS` command. If licenses are not available, CosmosScope will fail when invoked.

   The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use `port@host` rather than using the path to the license file.

   Each license file can contain licenses for many packages from multiple vendors. You can specify multiple license files by separating each entry with a colon (:) for UNIX or a semicolon (;) for Windows.

2. Start the tool by going to Start > Programs > Synopsys > *product version* > CosmosScope.

   The CosmosScope window opens.

3. To check the product version, choose Help > About CosmosScope, and in the window that opens, click Copyright/Legal.

4. To exit CosmosScope, choose File > Exit.
Setting Up the User Environment on UNIX

To set up the user environment, you must specify the location of the executable files and set the license environment variable. The directory containing the executable commands is located within the ai_bin directory in the install_home installation root.

Specifying the Executable File Location

To set up a new CosmosScope user, add the executable file to the path.

- If you are using the C shell, add the following line to the .cshrc file:

  ```
  set path=(install_home/ai_bin $path)
  ```

- If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile, .kshrc, or .bashrc file:

  ```
  PATH=install_home/ai_bin: $PATH
  export $PATH
  ```

Setting the License Environment Variable

To enable CosmosScope to check out a license, you must set the LM_LICENSE_FILE environment variable.

Note:

The CosmosScope license file uses the avantd daemon, which must be included on the VENDOR line of the license file. The path to the avantd daemon is scl_root/platform/daemons/avantd, where scl_root refers to the Synopsys Common Licensing (SCL) root directory.
• If you are using the C shell, add the following line to the .cshrc file:

```bash
setenv LM_LICENSE_FILE port@hostname
```

• If you are using the Bash or Bourne shell, add these lines to the .bashrc or .profile file:

```bash
LM_LICENSE_FILE=port@hostname
export LM_LICENSE_FILE
```

The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use `port@host` name rather than using the path to the license file.

Each license file can contain licenses for many packages from multiple vendors. You can specify multiple license files by separating each entry with a colon (`:`) for UNIX or a semicolon (`;`) for Windows.

---

**Verifying the CosmosScope Installation on UNIX**

To verify the installation of the CosmosScope tools,

1. Make sure you are in a directory where you have read/write privileges.

   ```bash
   % cd $HOME
   ```

2. Invoke the tool by entering

   ```bash
   %
   ```
If the CosmosScope tools are correctly installed, this command invokes CosmosScope, displays the CosmosScope welcome screen, then opens the tool.

---

**Using Command Options**

You can install CosmosScope on UNIX platforms by using the `setup` script command and on Windows by invoking the `setup.exe` installation program. By default, the CosmosScope installer invokes the GUI installation program on all platforms. If you want to install the software in silent mode or in the background, use the `-silent` command-line option, which is supported on all platforms. If you do not use the `-silent` option at the command line, any option you enter is reflected in the GUI.

The following options are available from the command line. Unless otherwise indicated, they are available for both UNIX and Windows systems.

**UNIX and Windows**: The following options are available from the command line:

Usage: `setup [options]`

- `-silent`
  - Suppresses all graphics output.

- `-installdir destination directory`
  - Installs files to a destination directory. The path name cannot include spaces.

- `-typical (default)`
  - Installs typical features.
-license port host1 [host2 host3] [license file]
(Windows only)

Sets up licensing services on Windows platforms. If you specify a license file, the file must already exist and have an absolute path name. If you don’t specify a license file, the default license file path name is used. You can change the default after installation.

The \texttt{LM_LICENSE_FILE} environment variable is set using the port and host information specified. If the \texttt{LM_LICENSE_FILE} environment variable already exists, only unique port and host information will be added.

Regardless of whether the -license option is used, the lmgrd and avantd daemons are always installed, so you can set up license services manually after installation.

To set up or modify licensing services, use the Macrovision LMTOOLS program, which you can access by choosing Start > Programs > Synopsys > Saber version > License Tool.

To set or modify the \texttt{LM_LICENSE_FILE} environment variable, open the Control Panel and choose System > Environment (Windows NT) or System > Advanced > Environment Variables (Windows 2000 or later). You cannot use LMTOOLS to modify environment variables.

-is:tempdir temporary directory

Specify an alternative location in which to store temporary files. On UNIX platforms, the default temporary directory might not contain enough free space to install the tool, causing the installer to terminate abnormally.
Uninstalling the Software

To uninstall the software on UNIX,

• Execute the uninstall program, which is located in the `Install_home/_CosmosScope` directory, or delete the entire software directory.

  If you delete the directory, you must also delete the `vpd.properties` file located in your home directory.

To uninstall the software on Windows,

• From the Control Panel, select Add/remove programs.
  or
  • Choose Start > Programs > Synopsys > CosmosScope `version` > Uninstall. The uninstall program will automatically start.
  or

• Execute the uninstall program located in the `Install_home\CosmosScope` directory. For example,

  `c:> install_home\CosmosScope\uninstall`

  The uninstall program will start.

Customer Support

For information about accessing customer support, see “Customer Support” on page xxiii.
This chapter contains the following sections:

- Installing the Software
- Setting Up Design Compiler FPGA for Each User
- Verifying the Design Compiler FPGA Installation

To ensure a successful installation, have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
Installing the Software

Beginning with the W-2005.03 release, the installation procedure for Design Compiler FPGA has changed. The tool no longer installs with the synthesis tools.

Design Compiler FPGA uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install Design Compiler FPGA from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the Design Compiler FPGA software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. Design Compiler FPGA is installed in a similar manner.

Design Compiler FPGA is a stand-alone product and cannot be installed over an existing Synopsys product. You must create a new directory for Design Compiler FPGA.

Important:
Do not install Design Compiler FPGA in the same path as the synthesis tools.
Setting Up Design Compiler FPGA for Each User

To set up a new Design Compiler FPGA tool user, add the Design Compiler FPGA directory containing the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

```
set path=(dc_fpga_root/platform/syn/bin $path)
```

If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile, .kshrc, or .bashrc file:

```
PATH=dc_fpga_root/platform/syn/bin:$PATH
export PATH
```

Replace `platform` with the appropriate platform (see Table 1-2 on page 1-6).

Configuring the Browser for FPGA Vision Online Help

The FPGA Vision online Help system is a browser-based HTML Help systems designed for viewing in Netscape version 7.0 for UNIX or version 4.78 for UNIX. This Help system is not supported in Netscape version 6.

**Important:**

When you use online Help from within the GUI, the Netscape executable file must be on the UNIX path.

This Help system makes extensive use of Java, JavaScript, and style sheets. In your browser preferences, select the Advanced category and make sure that
• In Netscape 7.0, the Enable Java and XSLT options are both selected

• In Netscape 4.78, the Enable Java, Enable JavaScript, and Enable Style Sheets options are all selected, and the Enable Java Plugin option is deselected

As an alternative to opening the Help system from within the Design Compiler FPGA GUI tool, you can view the Help system stand-alone by opening the file named index.html in Netscape.

---

**Verifying the Design Compiler FPGA Installation**

To verify the Design Compiler FPGA installation,

1. Make sure you are in a directory where you have read/write privileges:

   ```
   % cd $HOME
   ```

2. Invoke the Design Compiler FPGA shell by entering

   ```
   % fpga_shell
   ```

   Replace `platform` with the appropriate platform (see Table 1-2 on page 1-6).

   If you see information about the product version, production date, and copyright, the installation was successful.

3. Exit `fpga_shell` by entering `exit` on the command line.

4. Run the FPGA Vision GUI on each installed platform by entering

   ```
   % fpga_vision
   ```

5. Exit the GUI by choosing File > Exit in any GUI window.
This chapter describes how to install the Encore product on both UNIX and Windows platforms.

This chapter contains the following sections:

- Installing the Software on UNIX Platforms
- Verifying the Encore Installation on UNIX Platforms
- Installing the Software on Windows Platforms
- Invoking Encore on Windows Platforms

To ensure a successful installation, complete the following procedures before beginning the installation process:

- Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).
• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).

Installing the Software on UNIX Platforms

To begin the installation process,

• If you have downloaded the software by Electronic Software Transfer (EST), execute the setup file.

  $ Encore_version_SOL_setup

  The InstallShield Wizard window appears, and then you will see the Welcome window.

  Note:
  For detailed EST instructions, see “Downloading the Software” on page 2-2.

• If you are installing the software from a CD, insert the CD into your system’s CD drive.

  The setup program starts automatically. The InstallShield Wizard window appears, and then you will see the Welcome window.

  Note:
  For detailed CD mounting and installation steps, see “Installing Product Files From a CD” on page 2-2.

Respond to the prompts as necessary.

1. Select a directory name and location.

   The default directory is /Synopsys/Encore. To select a different directory, click Browse and navigate to the directory you want.
Note:
Do not install the software in a folder or directory whose name contains spaces.

Click Next to verify the directory location.
To continue, click Next again.

2. Wait while the software is installing.
To stop the program, click Cancel.
When the program completes the installation, click Finish.
Verifying the Encore Installation on UNIX Platforms

To verify the Encore installation,

1. Make sure you are in a directory where you have read/write privileges.

   `cd $HOME`

2. Invoke Encore by entering

   `% encore`

   If you see information about the product version, production date, and copyright, the installation was successful.

3. Run the Encore GUI on each installed platform by entering

   `% encore`

4. Exit the GUI by choosing File > Exit Application.

Installing the Software on Windows Platforms

To run Encore, your system must have

- A Pentium or compatible processor or later
- Windows NT, Windows 2000, or Windows XP operating system
- At least 512 MB of memory
- Approximately 47 MB of free disk space
Running the Installation Program on Windows Platforms

To begin the installation process,

• If you have downloaded the software by Electronic Software Transfer (EST), double-click the Encore_version_Win_setup.exe file. The InstallShield Wizard window appears, then you will see the Welcome window.

  Note:
  For detailed EST instructions, see “Downloading the Software” on page 2-2.

• If you are installing the software from a CD, insert the CD into your system’s CD drive. The setup program starts automatically. The InstallShield Wizard window appears, then you will see the Welcome window.

  Note:
  For detailed CD mounting and installation steps, see “Installing Product Files From a CD” on page 2-22.

Respond to the prompts as necessary.

1. Select a Directory Name and Location.

   The default directory is \Synopsys\Encore. To select a different directory, click Browse and navigate to the directory you want.

   Note:
   Do not install the software in a folder or directory that contains spaces.
Click Next to verify the directory location.

To continue, click Next again.

2. Wait while the software is installing.

To stop the program, click Cancel.

When the program completes the installation, click Finish.
Invoking Encore on Windows Platforms

To invoke Encore,

1. Execute the tool by going to Start > Programs and clicking Encore.

   The Encore IC Package Designer window opens.

   Note:
   The tool will not start unless your `LM_LICENSE_FILE` environment variable is set correctly.
   This variable is normally set in the Control Panel. (For Windows NT, choose Control Panel > System > Environment. For Windows 2000 or Windows XP, choose Control Panel > System > Advanced > Environment Variables.)

   \[LM_LICENSE_FILE=path_to_license_file\]

   For detailed information about Synopsys licensing, see the Synopsys Licensing QuickStart Guide at http://www.synopsys.com/keys.

2. To check the product version, choose Help > Product Information.

3. To exit Encore, choose File > Exit.
This chapter describes how to install the ESP product.

This chapter contains the following sections:

• Installing the Software
• Setting Up ESP for Each User
• Setting the LM_LICENSE_FILE Environment Variable
• Verifying the ESP Installation

To ensure a successful installation, complete the following procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).
• (Optional) Define the SYNOPSYS environment variable (see “Defining the SYNOPSYS Environment Variable” on page 1-20).
• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).

Installing the Software

ESP uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install ESP from the Web or by FTP, follow the procedures described in “Downloading the Software” on page 2-2.

To install the ESP software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-2 on page 2-27 shows a Synopsys media installation script for the PrimeTime tool. ESP is installed in a similar manner.

ESP is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of ESP. You must create a new directory for ESP.

To view a list of supported platforms for ESP, see “Products and Supported Platforms” on page 1-6.
Setting Up ESP for Each User

Note:

The $SYNOPSYS environment variable is not required for ESP. You can skip this step completely or substitute another variable (for example, $ESP).

To set up a new ESP tool user, add the ESP directory containing the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

```
set path=($SYNOPSYS/bin $path)
```

If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile, .kshrc, or .bashrc file:

```
PATH=$SYNOPSYS/bin:$PATH
export PATH
```

Setting the LM_LICENSE_FILE Environment Variable

To enable ESP to check out a license, you must set the LM_LICENSE_FILE environment variable.

Note:

The ESP license file uses the innologd daemon, which must be included on the VENDOR line of the license file. The path to the innologd daemon is `scl_root/platform/daemons/innologd`, where `scl_root` refers to the Synopsys Common Licensing (SCL) root directory.

• If you are using the C shell, add the following line to the .cshrc file:
setenv LM_LICENSE_FILE port@hostname

- If you are using the Bourne or Bash shell, add these lines to the .profile or .bashrc file:

  LM_LICENSE_FILE=port@hostname
  export LM_LICENSE_FILE

The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use `port@host` rather than using the path to the license file. You can specify multiple license files by separating each entry with a colon (`:`).

---

Verifying the ESP Installation

To verify the ESP installation, run a small test case from the installation doc directory for the release.

1. Make sure you are in a directory where you have read/write privileges:

   `% cd $HOME`

2. Obtain a copy of test source files:

   `% mkdir ~/testinstall`
   `% cd ~/testinstall`
   `% cp $SYNOPSYS/doc/esp/demo/install/* .`

3. Run the test case by executing one of the following commands, depending on which software you have a license for.

<table>
<thead>
<tr>
<th>Product</th>
<th>Command</th>
<th>Compare results to</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESP-CV</td>
<td>espcv test.v</td>
<td>expect.log</td>
</tr>
</tbody>
</table>

Chapter 10: ESP (version W-2004.12)
The output should be similar to the file specified in the previous table. This file should be in the demo/install directory you specified in step 2. For example,

```
% espcv test.v
```

or

```
% $SYNOPSYS/bin/espcv test.v
```
This chapter describes how to install the Floorplan Compiler product.

This chapter contains the following sections:

- Installing the Software
- Setting Up Floorplan Compiler for Each User
- Verifying the Floorplan Compiler Installation

To ensure a successful installation, complete the following procedures before beginning the installation process:

- Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).
- Define the SYNOPSYS environment variable (see “Defining the SYNOPSYS Environment Variable” on page 1-20).
• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
## Installing the Software

To download and install Floorplan Compiler from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the Floorplan Compiler software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. Floorplan Compiler is installed in a similar manner.

## Setting Up Floorplan Compiler for Each User

To set up a new Floorplan Compiler tool user, add the Floorplan Compiler directory containing the executable file to the `PATH` environment variable.

If you are using the C shell, add the following line to the `.cshrc` file:

```bash
set path=($SYNOPSYS/platform/fpc/bin $path)
```

If you are using the Bourne, Korn, or Bash shell, add the following line to the `.profile`, `.kshrc`, or `.bashrc` file:

```bash
PATH=$SYNOPSYS/platform/fpc/bin:$PATH
export PATH
```

Replace `platform` with the appropriate platform (see “Products and Supported Platforms” on page 1-6).
Configuring the Browser for Floorplan Compiler Online Help

The Floorplan Compiler online Help system is a browser-based HTML Help system designed for viewing in Netscape version 7.0 for UNIX or version 4.78 for UNIX. This Help system is not supported in Netscape version 6.

Important:

When you use online Help from within the GUI, the Netscape executable file must be on the UNIX path.

Floorplan Compiler Help makes extensive use of Java, JavaScript, and style sheets. In your browser preferences, select the Advanced category and make sure that

- In Netscape 7.0, the Enable Java and XSLT options are both selected
- In Netscape 4.78, the Enable Java, Enable JavaScript, and Enable Style Sheets options are all selected, and the Enable Java Plugin option is deselected

As an alternative to opening the Help system from within the Floorplan Compiler GUI tool, you can view the Help system stand-alone by opening the file named index.html in Netscape.

Verifying the Floorplan Compiler Installation

To verify the Floorplan Compiler installation,

1. Make sure you are in a directory where you have read/write privileges:
% cd $HOME

2. Invoke the tool by entering the following command:

% $SYNOPSIS/platform/fpc/bin/fpc_shell

Replace platform with the appropriate platform (see “Products and Supported Platforms” on page 1-6).

If you see information about the product version, production date, and copyright, the installation was successful.

3. Exit fpc_shell by entering exit on the command line.

4. Run the Floorplan Compiler GUI on each installed platform by entering the following command:

% $SYNOPSIS/platform/fpc/bin/fpc_gui

Replace platform with the appropriate platform (see “Products and Supported Platforms” on page 1-6).

5. Exit the GUI by choosing File > Exit in any GUI window.
This chapter describes how to install the Formality product.

This chapter contains the following sections:

- Installing the Software
- Setting Up Formality for Each User
- Verifying the Formality Installation

To ensure a successful installation, complete the following procedures before beginning the installation process:

- Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).
- Define the SYNOPSYS environment variable (see “Defining the SYNOPSYS Environment Variable” on page 1-20).
• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).

Installing the Software

Formality uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install Formality from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the Formality software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-2 on page 2-27 shows a Synopsys media installation script for the PrimeTime tool. Formality is installed in a similar manner.

Formality is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of Formality. You must create a new directory for Formality.
Setting Up Formality for Each User

To set up a new Formality tool user, add the Formality directory containing the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

```bash
set path=($SYNOPSYS/platform/fm/bin $path)
```

If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile, .kshrc, or .bashrc file:

```bash
PATH=$SYNOPSYS/platform/fm/bin:$PATH
export PATH
```

Replace `platform` with the appropriate platform (see “Products and Supported Platforms” on page 1-6).

For information about the Synopsys setup file, see the Formality User Guide.

Verifying the Formality Installation

To verify the Formality installation,

1. Make sure you are in a directory where you have read/write privileges:

   ```
   % cd $HOME
   ```

2. Invoke the Formality shell by entering the following command:

   ```
   % $SYNOPSYS/platform/fm/bin/fm_shell
   ```
Replace *platform* with the appropriate platform (see “Products and Supported Platforms” on page 1-6).

If you see information about the product version, production date, and copyright, the installation was successful.

3. Exit fm_shell by entering `exit` on the command line.

4. Run the Formality GUI on each installed platform by entering the following command:

   ```
   % $SYNOPSYS/platform/fm/bin/formality
   ```

5. Exit the GUI by choosing File > Exit in any GUI window.
This chapter describes how to install the Hercules product.

Note:
The installation instructions in this chapter are the most up-to-date available at the time of production. However, changes might have occurred. For the latest installation information, see the product release notes or documentation.

This chapter contains the following sections:

• Media Availability and Supported Platforms
• Disk Space Requirements
• Installing the Software
• Setting Up the Hercules Environment for Each User
• Verifying the Hercules Installation
To install Synopsys tools, it is recommended that you log on as root or have system administrator privileges. You need write permission for the installation directory.

**Important:**

The installation procedure for this version of Hercules has changed. This product now uses the Synopsys Installer. (See “About the Synopsys Installer Software” on page 2-2.)
Media Availability and Supported Platforms

The Hercules tool is available on CD or by EST. Obtain the appropriate binary executable files based on the operating system you need. Table 13-1 shows the supported platforms for the W-2004.12 release.

Table 13-1 Platforms and Keywords

<table>
<thead>
<tr>
<th>Platform</th>
<th>Operating system</th>
<th>Synopsys platform keyword</th>
<th>Path keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP PA-RISC 2.0</td>
<td>HP-UX 11.0, 11.11 (11i)¹</td>
<td>hp32 (32-bit mode)</td>
<td>HP32_U11,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>hp64 (64-bit mode)</td>
<td>HP64_U11</td>
</tr>
<tr>
<td>Sun SPARC</td>
<td>Solaris 8, 9¹</td>
<td>sparcOS5 (32-bit mode)</td>
<td>SUN32_58,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SUN64_58</td>
</tr>
<tr>
<td>IA-32 (X86)</td>
<td>Red Hat Enterprise Linux 3.0¹</td>
<td>linux (32-bit mode)</td>
<td>IA32_L24</td>
</tr>
<tr>
<td>IBMRS/6000</td>
<td>AIX 5.1</td>
<td>rs6000 (32-bit mode)</td>
<td>RS32_AIX51</td>
</tr>
<tr>
<td></td>
<td></td>
<td>aix64 (64-bit mode)</td>
<td>RS64_AIX51</td>
</tr>
<tr>
<td>Itanium 2</td>
<td>Red Hat Enterprise Linux 2.1</td>
<td>linuxipf (64-bit mode)</td>
<td>IA64_L24</td>
</tr>
<tr>
<td>AMDOpteron</td>
<td>Red Hat Enterprise Linux 3.0</td>
<td>amd64 (64-bit mode)</td>
<td>AMD64_L24</td>
</tr>
</tbody>
</table>

¹. Binary-compatible operating system. Note, however, that binary compatibility is not guaranteed.

Note:

The Hercules software is configured so that multiple platforms of this version can be installed in a single installation directory (install_dir).
Disk Space Requirements

Make sure you have enough disk space for Hercules-Explorer and Hercules-VUE installation. For a full installation on one platform, 380 MB is recommended. The disk space requirement varies depending on the platform and the tool selected for installation. Table 13-2 shows the maximum space required for installing each product on a particular platform.

Table 13-2 Disk Space Requirements (in Megabytes)

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Megabytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform-independent files (Base MB)</td>
<td>110</td>
</tr>
<tr>
<td>Sun Solaris 32-bit</td>
<td>250</td>
</tr>
<tr>
<td>Sun Solaris 64-bit</td>
<td>210</td>
</tr>
<tr>
<td>HP-UX 32-bit</td>
<td>210</td>
</tr>
<tr>
<td>HP-UX 64-bit</td>
<td>210</td>
</tr>
<tr>
<td>Red Hat Linux 32-bit</td>
<td>220</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 64-bit</td>
<td>220</td>
</tr>
<tr>
<td>AMD 64-bit</td>
<td>240</td>
</tr>
<tr>
<td>AIX 5.1 RS 32-bit</td>
<td>270</td>
</tr>
<tr>
<td>AIX 5.1 RS 64-bit</td>
<td>270</td>
</tr>
</tbody>
</table>
Installing the Software

Beginning with the W-2004.12 release, the installation procedure for installing Hercules has changed. Hercules now uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script.

To download and install Hercules from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the Hercules software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. Hercules is installed in a similar manner.

Hercules is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of Hercules. You must create a new directory for Hercules.
Setting Up the Hercules Environment for Each User

1. To set up a new user, you must modify the hercules_setup.csh and hercules_setup.sh files.

   Set the \$HERCULES_HOME_DIR environment variable by replacing the \<TOP-LEVEL-INSTALLEDIR\> text in the install_dir/hercules_setup.csh and install_dir/hercules_setup.sh files with install_dir.

   - If you are using the C shell, modify the following line:
     
     setenv HERCULES_HOME_DIR \<TOP-LEVEL-INSTALLEDIR\>
     
     For example,
     
     setenv HERCULES_HOME_DIR /usr/synopsys/hercules/ \version

   - If you are using the Bourne shell, modify the following line:
     
     HERCULES_HOME_DIR=\<TOP-LEVEL-INSTALLEDIR\>
     
     For example,
     
     HERCULES_HOME_DIR=/usr/synopsys/hercules/version

2. Set the \LM_LICENSE_FILE variable. Add the following information to the .cshrc, .profile, or .bashrc files or to the hercules_setup.csh and hercules_setup.sh source files:

   - If you are using the C shell, enter
     
     setenv LM_LICENSE_FILE port@hostname
     
     - If you are using the Bourne shell, enter
     
     LM_LICENSE_FILE=port@hostname
     export LM_LICENSE_FILE
The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use port@host rather than using the path to the license file.

Each license file can contain licenses for many packages from multiple vendors. You can specify multiple license files by separating each entry with a colon (:

Note:
The Hercules license file uses the avantd daemon, which must be included on the VENDOR line of the license file. The path to the avantd daemon is scl_root/platform/daemons/avantd, where scl_root refers to the Synopsys Common Licensing (SCL) root directory.

Verifying the Hercules Installation

To verify the Hercules installation,

1. Make sure you are in a directory where you have read/write privileges.
   
   $ cd $HOME

2. Invoke the tool by entering

   $ hercules -V

   If you see information about the product version, production date, and copyright, the installation was successful.
This chapter describes how to install the HSPICE product.

Note:
The installation instructions in this chapter are the most up-to-date available at the time of production. However, changes might have occurred. For the latest installation information, see the product release notes or documentation.

This chapter provides instructions for both UNIX and Windows platforms.

This chapter includes the following sections:

- Media Availability and Supported Platforms
- Disk Space Requirements
• Installing the Software on UNIX or Linux Platforms
• Configuring HSPICE and AvanWaves for UNIX and Linux
• Setting Up HSPICE for Each User
• Verifying the Installation
• Installing the Software on Windows Platforms
• Related Documentation and Customer Support
Media Availability and Supported Platforms

HSPICE, Interface, AvanWaves, and MetaEncrypt are available on CD and by EST on all platforms, with the following exceptions:

- Interface is not available on Dec Alpha or Windows platforms.
- AvanWaves is not available on the Linux platform.

Obtain the appropriate binary executable files for your operating system. Table 14-1 lists the supported platforms for this release.

Table 14-1 Platforms and Keywords

<table>
<thead>
<tr>
<th>Platform</th>
<th>Operating system</th>
<th>Synopsys platform keyword</th>
<th>Window environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP PA-RISC 2.0</td>
<td>HP-UX 11.0, 11.11 (11i)¹</td>
<td>hp32 (32-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>hp64 (64-bit mode)²</td>
<td></td>
</tr>
<tr>
<td>Sun SPARC</td>
<td>Solaris 8, 9¹</td>
<td>sparcOS5 (32-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sparc64 (64-bit mode)</td>
<td></td>
</tr>
<tr>
<td>IA-32 (X86)</td>
<td>Red Hat Linux 7.2, Red Hat</td>
<td>linux (32-bit mode)</td>
<td>GNOME</td>
</tr>
<tr>
<td></td>
<td>Enterprise Linux 3.0¹</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM RS/6000</td>
<td>AIX 5.1</td>
<td>rs6000 (32-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td>IA-32 (X86)</td>
<td>XP</td>
<td>winxp</td>
<td></td>
</tr>
<tr>
<td>DEC Alpha</td>
<td>OSF 4.0</td>
<td>alpha</td>
<td></td>
</tr>
</tbody>
</table>

¹ Binary-compatible operating system. Note, however, that binary compatibility is not guaranteed.
² HP-UX 64-bit binary files (for HSPICE only) are packaged with the hspice_version_hp32.tar.gz files.

Note:

When you use HSPICE with Windows platforms that use AMD Athlon CPUs, only a single processor is supported.
Disk Space Requirements

Make sure you have enough disk space for the installation. For a full installation on all platforms, 550 MB is recommended. For a single platform installation, approximately 200 MB is recommended.

Installing the Software on UNIX or Linux Platforms

HSPICE uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script.

To download and install HSPICE from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the HSPICE software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. HSPICE is installed in a similar manner.

HSPICE is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of HSPICE. You must create a new directory for HSPICE.

HSPICE installs with other tools, including AvanWaves.
Configuring HSPICE and AvanWaves for UNIX and Linux

The configuration program for HSPICE is automatically invoked after installation has finished.

To configure HSPICE for UNIX and Linux platforms,

1. Verify the platform on which you want to configure the products.
2. Invoke the configuration program by entering
   
   \% installation_directory/hspice/bin/config

   The Configure Products dialog box appears.

3. If you want to configure AvanWaves, select Configure AvanWaves.
   
   No option is required.

   Note:
   
   AvanWaves is not available on the Red Hat Linux platform.

4. If you want to configure HSPICE, select Configure HSPICE.
   
   The configuration options are “versions file...,” “meta.cfg file ...,” “hspice.ini file ...,” and setup buttons. If you do not select these options, the default settings apply.

5. After selecting your options, click the Configure button.
   
   The configuration log is shown in the middle of the dialog box.

6. Click Exit when the configuration has finished.
Setting Up HSPICE for Each User

To set up a new tool user,

- Enter the path information.
- Set up a license variable that points to the license server.
- Source the cshrc.meta file, or use a dot (.) with the kshrc.meta file (where . is a Bourne or Korn shell command).

Add the following information to the cshrc, .kshrc, or an HSPICE source file:

1. Add the HSPICE and AvanWaves executable files to your search path.
   - If you are using the C shell, enter
     ```
     set path=(installation_directory/hspice/bin $path)
     ```
   - If you are using the Bourne or Korn shell, enter
     ```
     PATH=installation_directory/hspice/bin:$PATH
     ```

2. Set one of the following licensing variables:

   **LM_LICENSE_FILE**

   or

   **AVANTD_LICENSE_FILE**

   For example,

   - If you are using the C shell, add the following line:
     ```
     setenv LM_LICENSE_FILE port@hostname
     ```
- If you are using the Bourne or Korn shell, enter these lines:

```
LM_LICENSE_FILE=port@hostname
export LM_LICENSE_FILE
```

3. Source the cshrc.meta or .kshrc.meta file.

- For C shell users, enter

```
% source installation_directory/hspice/bin/cshrc.meta
```

- For Bourne or Korn shell users, enter

```
$ . installation_directory/hspice/bin/kshrc.meta
```

---

Verifying the Installation

After you set up the licensing and HSPICE software packages, do the following:

- For C shell users, enter

```
% source installation_directory/hspice/bin/cshrc.meta
```

- For Bourne or Korn shell users, enter

```
$ . installation_directory/hspice/bin/kshrc.meta
```

If this step fails, or if the cshrc.meta file does not exist, the installation program failed. To find the problem, review the installation log file:

```
installation_directory/hspice/bin/synopsys_config.log_pid
```
Verifying the HSPICE Installation

To verify the HSPICE installation,

1. Make sure you are in a directory where you have read/write privileges.
   
   % cd $HOME

   The $installdir environment variable refers to the HSPICE installation directory. This variable is created when you source the cshrc.meta file.

2. To run a demonstration simulation, enter
   
   % hspice $installdir/hspice/demo/hspice/bench/demo.sp
   > demo.lis

3. To view the simulation output, enter
   
   % vi demo.lis

   If you are able to get a license, you will see a message about licenses near the top of the listing.

   lic: Checkout hspice; Encryption code: xxx

   If you get a **** job concluded statement near the bottom of the listing, the simulation was successful.

Verifying the AvanWaves Installation

To verify the AvanWaves installation,

1. Change to the installation directory.

   % cd $installdir/hspice/bin/
The \$<installdir> environment variable refers to the AvanWaves installation directory. This variable is created when you source the cshrc.meta file.

2. To start AvanWaves, enter
   `awaves &`

---

### Installing the Software on Windows Platforms

This section describes how to install and set up the license server for HSPICE on a PC. To run HSPICE, your system must have

- A Pentium or compatible processor or later
- At least 64 MB of memory (128 MB or more is recommended)
- A parallel port for the security key (if you are using a dongle-based license)
- Windows 2000 or Windows XP operating system
- Approximately 100 MB of free disk space for a full installation of HSPICE, AvanWaves, and MetaEncrypt

### Installing With Windows Explorer

To install HSPICE by using Windows Explorer,

1. Insert the HSPICE CD into the CD drive.
2. In Windows Explorer, double-click the CD drive icon.
3. Double-click the pchspice folder icon.
4. Double-click the Setup application icon.

5. To install the software, follow the screen prompts.

---

**Installing With Windows DOS Shell**

To install HSPICE by using the Windows DOS shell,

1. Insert the HSPICE CD into the CD drive.

2. At the DOS shell command prompt, enter

   ```
   CD-ROM drive letter:\pchspice\hspice_version_platform_setup.exe
   ```

3. To install the software, follow the screen prompts.

---

**Installing the Sentinel System Drivers**

Installation of Sentinel drivers is required only when you use dongle-based licenses. For information about the Win32 sentinel_key driver (dongle key), see the README.txt file located in the %installdir% installation directory.

In Windows Explorer,

1. Double-click the %installdir%\DRIVERS\flexid.exe file to install the driver.

2. **Set the** `LM_LICENSE_FILE` **environment variable.**

   This variable is normally set in the Control Panel. (For Windows NT, choose Control Panel > System > environment. For Windows 2000 or Windows XP, choose Control Panel > System > Environment Variables.)
LM_LICENSE_FILE=\path_to_license_file

For detailed information about Synopsys licensing, see the Synopsys Licensing QuickStart Guide at http://www.synopsys.com/keys.

Note:
If you have multiple dongles connected to each other, the Synopsys dongle must be connected directly to the PC.

Running HSPICE on Windows
You can run HSPICE in any of the following ways:

• Double-click the HSPUI icon and then click the Simulate button.

• Double-click the HSPICE icon. You are prompted to enter names for the input netlist file and output list file. If you do not name an output file, all of the .lis, .st0, and .tr0 files will be written in the directory in which you run HSPICE or hspice.exe.

• At the DOS prompt in Windows, enter

\c:/> cd work_directory
\c:/> %installdir%\BIN\HSPICE -i netlist -o listfile

Running AvanWaves on Windows
Start AvanWaves in any of the following ways:

• Double-click the HSPUI icon and then click the AvanWaves button.

• Double-click the AvanWaves icon.

• At the DOS prompt in Windows, enter


c:\> %installdir%\BIN\AWAVES

Important:
If you start AvanWaves by using a method other than selecting
the HSPUI icon and then you open online Help, you must delete
the Galaxy Help Server task from the Task Manager after you exit
AvanWaves. Otherwise the next invocation of HSPICE can have
a memory conflict with the AvanWaves Galaxy Help server.

Running Older Versions of HSPICE
You can use the HSPUI utilities to run different versions of HSPICE
that are already installed on your computer. In the installation
directory (%installdir%), the versions.txt file contains all the
information about different versions of HSPICE.

An example of a versions.txt file follows:

<BOF>
c:\synopsys\Hspiceversion\BIN\hspice.exe    HSPICE version
c:\synopsys\Hspiceversion\BIN\hspice_mt.exe HSPICE \version
<EOF>

You can add different HSPICE executable file full paths to
subsequent lines in the versions.txt file. The second column contains
comments as a version reminder and is ignored by the HSPUI utility.
After invoking HSPUI, you can select the HSPICE version in the
combo box of the HSPUI window. HSPICE will run according to the
path selected in the combo box.

The following executable files are provided on the HSPICE,
AvanWaves, and Utility disks:
*.EXE File
%installdir%\bin\lmutil (lmutil hostid - sentinel; run from the DOS prompt)
%installdir%\bin\hspice (HSPICE executable running in a PC Windows environment)
%installdir%\bin\awaves (AvanWaves executables running in a PC Windows environment)
%installdir%\bin\hspui (GUI utility that launches HSPICE.EXE and AWAVES.EXE)

---

The hspice.ini File

On Windows platforms, the hspice.ini file is the configuration file that contains HSPICE options such as the search path. For example,

```
.OPTION Post =1
.Op
.OPTION Post_version = 9601
.......................
```

If you have installed more than one version of HSPICE on the same PC, more than one hspice.ini file will exist, but only one takes effect when you start the tool.

The %installdir%\meta.cfg file points to the current hspice.ini file.

---

Related Documentation and Customer Support

For documentation about using HSPICE and AvanWaves, see the

- *AvanWaves User Guide*
- *Device Models Quick Reference Guide*
- *Elements and Device Models Manual*
- *HSPICE Applications Manual*
- HSPICE Command Reference
- HSPICE Quick Reference Guide
- HSPICE Signal Integrity Guide
- HSPICE Simulation and Analysis User Guide
- MOSFET Models Manual

All documentation is available on SOLD or through Documentation on the Web. Printer-friendly versions are available only for the HSPICE Quick Reference Guide and the Device Models Quick Reference Guide. For information about accessing the documentation, see “Related Publications” on page xxi.

For information about contacting Customer Support, see “Customer Support” on page xxiii.

If you cannot solve a problem, use an editor to review the following files for system error messages:

- /tmp/pid/synopsys_install.log_pid (which is generated during installation)
- /tmp/pid/synopsys_config.log_pid (which is generated during configuration)
This chapter describes how to install the IC Workbench product.

Note:
The installation instructions in this chapter are the most up-to-date available at the time of production. However, changes might have occurred. For the latest installation information, see the product release notes or documentation.

This chapter contains the following sections:

• Installing the Software
• Setting Up the User Environment
• Setting the LM_LICENSE_FILE Environment Variable
• Verifying the IC WorkBench Installation
To ensure a successful installation, have your license server running and have the appropriate license keys installed before beginning the installation process. (See “Acquiring a License” on page 1-16.)

---

**Installing the Software**

Beginning with the W-2004.12 release, the installation procedure for installing the IC WorkBench tool has changed. IC WorkBench now uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script.

To download and install IC WorkBench from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the IC WorkBench software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. IC WorkBench is installed in a similar manner.

IC WorkBench is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of IC WorkBench. You must create a new directory for IC WorkBench.
Setting Up the User Environment

To set up a new IC WorkBench tool user, add the IC WorkBench directory containing the executable file to the PATH environment variable.

• If you are using the C shell, add the following line to the .cshrc file:

```
setenv PATH ICWB_HOME/bin:$PATH
```

where ICWB_HOME refers to the IC WorkBench installation directory.

• If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile, .kshrc, or .bashrc file:

```
PATH=ICWB_HOME/bin:$PATH
export PATH
```

where ICWB_HOME refers to the IC WorkBench installation directory.

Setting the LM_LICENSE_FILE Environment Variable

To enable IC WorkBench to check out a license, you must set the LM_LICENSE_FILE environment variable.

Note:

The IC WorkBench license file uses the numeritchd daemon, which must be included on the VENDOR line of the license file. The path to the numeritchd daemon is scl_root/platform/daemons/numeritchd, where scl_root refers to the Synopsys Common Licensing (SCL) root directory.
• If you are using the C shell, add the following line to the .cshrc file:

```bash
setenv LM_LICENSE_FILE port@hostname
```

• If you are using the Bash or Bourne shell, add these lines to the .bshrc or .profile file:

```bash
LM_LICENSE_FILE=port@hostname
export LM_LICENSE_FILE
```

The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use `port@host` rather than using the path to the license file.

Each license file can contain licenses for many packages from multiple vendors. You can specify multiple license files by separating each entry with a colon (`:`).

---

**Verifying the IC WorkBench Installation**

To verify the IC WorkBench installation,

1. Make sure you are in a directory where you have read/write privileges:

```bash
% cd $HOME
```

2. Invoke IC WorkBench by entering

```bash
% icwb
```

If the GUI appears, the installation was successful.
This chapter describes how to install the Magellan product.

Note:
The installation instructions in this chapter are the most up-to-date available at the time of production. However, changes might have occurred. For the latest installation information, see the product release notes or documentation.

This chapter contains instructions about installing the Magellan tool in the following sections:

- Installing the Software
- Setting the Environment Variables
- Verifying the Magellan Installation
To ensure a successful installation, have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).

Note:
Magellan requires a stand-alone installation and cannot be installed over an existing Synopsys product, including a prior version of Magellan. You must create a new directory for Magellan. Moreover, before you can run Magellan, VCS (or VCS MX) must be installed. For information about configuring Magellan to work with other tools, see the Magellan User Guide.

Installing the Software

Make sure you have enough disk space for the installation. For a full installation on all platforms, 4 GB and two processors are recommended.

To download and install Magellan by electronic software transfer,

1. Create a Magellan installation directory and change to that directory. For example, enter

   % mkdir -p /usr/synopsys/magellan
   % cd /usr/synopsys/magellan

2. Download the software to the installation directory. See “Downloading the Files by FTP” on page 2-5.

3. Uncompress and untar the files.

   % pwd /usr/synopsys/magellan
   % gzip -dc magellan-version-platform.tar.gz | tar xvf -
This command creates a Magellan subdirectory whose name includes the release of Magellan you are installing.

---

**Setting the Environment Variables**

This section discusses the following environment variables:

- **MG_HOME**
- **LD_LIBRARY_PATH**
- **SNPSLMD_LICENSE_FILE** or **LM_LICENSE_FILE**

It is recommended that you place these variables in your $HOME/.cshrc or $HOME/.profile file as your default settings.

---

**Setting the MG_HOME Environment Variable**

Follow these steps.

1. Set the **MG_HOME** environment variable in the shell you are using where the `root_directory` argument is the name of the Magellan root directory.
   - If you are using the C shell, enter
     
     ```
     % setenv MG_HOME install_directory
     ```
   - If you are using the Bourne shell, enter
     
     ```
     % MG_HOME=install_directory
     export MG_HOME
     ```

2. Add the tool directory to your search path.
- If you are using the C shell, add the following line to the .cshrc file:

```bash
set path=($MG_HOME/platform/ctg/bin $path)
```

Replace `platform` with the appropriate platform keyword. See “Products and Supported Platforms” on page 1-6.

- If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile, .kshrc, or .bashrc file:

```bash
PATH=($MG_HOME/platform/ctg/bin:PATH)
export PATH
```

Replace `platform` with the appropriate platform keyword. See “Products and Supported Platforms” on page 1-6.

3. Append $MG_HOME/platform/ctg/lib to the `LD_LIBRARY_PATH` variable. This step is required if you use VHDL or the Magellan GUI (mgui).

- For example, If you are using the C shell, add the following line to the .cshrc file:

```bash
setenv LD_LIBRARY_PATH{$MG_HOME}/platform/ctg/lib \ ${LD_LIBRARY_PATH}
```

Replace `platform` with the appropriate platform keyword. See “Products and Supported Platforms” on page 1-6.

- If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile, .kshrc, or .bashrc file:

```bash
LD_LIBRARY_PATH=($MG_HOME/platform/ctg/lib: \ $LD_LIBRARY_PATH)
export LD_LIBRARY_PATH
```

Replace `platform` with the appropriate platform keyword. See “Products and Supported Platforms” on page 1-6.
Setting the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE Environment Variable

To enable Magellan to check out a license, you must set the `SNPSLMD_LICENSE_FILE` or the `LM_LICENSE_FILE` environment variable.

• If you are using the C shell, enter the following line:

  ```
  % setenv SNPSLMD_LICENSE_FILE port@hostname
  ```

• If you are using the Bourne shell, enter these lines:

  ```
  % SNPSLMD_LICENSE_FILE=port@hostname
  export SNPSLMD_LICENSE_FILE
  ```

The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use `port@host` name rather than using the path to the license file.

Each license file can contain licenses for many packages from multiple vendors. You can specify multiple license files by separating each entry with a colon (`:`).
Verifying the Magellan Installation

After you have installed and set up Magellan, run the test script that is installed with the software. The Testinstall.csh script checks that all required licenses are available, starts Magellan, builds a simple design, and runs a short test. If the script finishes successfully, you have installed Magellan correctly.

To verify the Magellan installation,

1. Verify that the required licenses are available. Enter

   `mgsh check_licenses -verilog`

   or

   `mgsh check_licenses -vhdl`

   If you do not specify either switch, the script checks a Verilog installation.

   Note:
   Magellan requires not only its own license keys but also licenses for VCS or VCS MX.

2. Make sure that either VCS or VCS MX is installed. Set `VCS_HOME` appropriately.

3. Change directories to `$MG_HOME`. Enter Testinstall.csh with the appropriate argument. For example,

   `Testinstall.csh [-vhdl]`
Note:
The -vhdl option also requires the SYNOPSYS_SIM environment variable to be set. Set SYNOPSYS_SIM to the value of VCS_HOME.

4. To run the Magellan GUI, change directories to $MG_HOME. Start an mgsh session, then start the GUI.

```bash
% MG_HOME/platform/ctg/bin/msgh
mgsh> mgui
```
Replace platform with the appropriate platform keyword. See “Products and Supported Platforms” on page 1-6.

5. Exit the GUI by choosing File > Exit in any GUI window.
This chapter describes how to install the NanoSim product.

This chapter contains the following sections:

• Installing the Software
• Setting Up NanoSim for Each User
• Verifying the NanoSim Installation

To ensure a successful installation, complete the following procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).

• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
Installing the Software

NanoSim uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install NanoSim from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the NanoSim software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-2 on page 2-27 shows a Synopsys media installation script for PrimeTime. NanoSim is installed in a similar manner.

The NanoSim subtools (ADFMI, NanoSim-VCS, turboWave, Verilog-A, and VTRAN) are automatically installed with the NanoSim installation.

NanoSim can be installed as a stand-alone installation or with any of the tools (PowerMill and TimeMill) it comes packaged with.

Setting Up NanoSim for Each User

To set up a new NanoSim tool user,

- If you are using the C shell, source the CSHRC_platform file located in the install directory.

  `cd install_dir`
  `source CSHRC_platform`
The install script for NanoSim creates a CSHRC\_platform file for each platform installed. The term *platform* is replaced with the platform you installed.

The CSHRC\_platform file sets the path for NanoSim and the NanoSim man pages, as follows:

\[
\text{set path=(install_directory/platform/ns/utilities/ } \cosmos/ai\_bin \$\text{path)}
\]

\[
\text{setenv MANPATH install_directory/doc/ns/man:$MANPATH}
\]

where *install_directory* is the directory where the tool has been installed.

If you don’t source the CSHRC\_platform file, copy the preceding line and set the path from that file.

- If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile, .kshrc, or .bashrc file:

\[
\text{PATH=}\text{install_directory/platform/ns/utilities/ } \cosmos/ai\_bin:$\text{PATH}
\text{export PATH}
\]

\[
\text{MANPATH=}\text{install_directory/doc/ns/man:$MANPATH}
\text{export MANPATH}
\]

Replace *platform* with the appropriate platform (see “Products and Supported Platforms” on page 1-6).
Verifying the NanoSim Installation

To verify the NanoSim installation,

1. Make sure you are in a directory where you have read/write privileges.
   
   `cd $HOME`

2. Invoke the shell tool by entering the following command:

   `% nanosim`

   If you see information about the product version, production date, and copyright, the installation was successful.

3. Run the NanoSim GUI on each installed platform by entering the following command:

   `% nanosimgui`

4. Exit the GUI by choosing File > Exit in any GUI window.
This chapter describes how to install the PathMill product.

This chapter contains the following sections:

• Installing the Software
• Setting Up PathMill for Each User
• Verifying the PathMill Installation

To ensure a successful installation, complete the following procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).
• Define the SYNOPSYS environment variable (see “Defining the SYNOPSYS Environment Variable” on page 1-20).
• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
Installing the Software

Beginning with the W-2004.12 release, the installation procedure for PathMill has changed. PathMill now uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install PathMill from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the PathMill software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-2 on page 2-27 shows a Synopsys media installation script for PrimeTime. PathMill is installed in a similar manner.

PathMill is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of PathMill. You must create a new directory for PathMill.

Setting Up PathMill for Each User

To set up a new PathMill tool user, add the PathMill directory containing the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

```bash
set path=($SYNOPSYS/platform/pm/bin $path)
```

If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile or .kshrc file:
PATH=$SYNOPSYS/platform/pm/bin:$PATH
export PATH

Replace *platform* with the appropriate platform (see “Products and Supported Platforms” on page 1-6).

---

### Verifying the PathMill Installation

To verify the PathMill installation,

1. Make sure you are in a directory where you have read/write privileges.
   
   `% cd $HOME`

2. Invoke the tool by entering
   
   `% $SYNOPSYS/platform/pm/bin/pathmill`

   Replace *platform* with the appropriate platform (see “Products and Supported Platforms” on page 1-6).

   If you see information about the product version, production date, and copyright, the installation was successful.
This chapter describes how to install the PowerMill product.

This chapter contains the following sections:

• Installing the Software
• Setting Up PowerMill for Each User
• Verifying the PowerMill Installation

To ensure a successful installation, complete the following procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).

• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
Installing the Software

Beginning with the V-2004.06 release, PowerMill uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install PowerMill from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the PowerMill software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-2 on page 2-27 shows a Synopsys media installation script for PrimeTime. PowerMill is installed in a similar manner. The PowerMill subtools (ADFMI, TurboWave, and VTRAN) are automatically installed with the PowerMill installation.

PowerMill can be installed as a stand-alone installation or with any of the tools (NanoSim and TimeMill) it comes packaged with.

Setting Up PowerMill for Each User

To set up a new PowerMill tool user,

- If you are using the C shell, source the CSHRC_platform file located in the install directory.

  ```bash
  % cd install_dir
  % source CSHRC_platform
  ```

  The installation script for PowerMill creates a CSHRC_platform file for each platform installed. The term platform is replaced with the platform you installed.
The CSHRC\textunderscore platform file sets the path for NanoSim and the NanoSim man pages.

\begin{verbatim}
set path=(install_directory/platform/ns/bin $path)
setenv MANPATH install_directory/doc/ns/man:$MANPATH
\end{verbatim}

where \textit{install\_directory} is the directory where the tool has been installed.

If you don't source the CSHRC\textunderscore platform file, copy the preceding line and set the path from that file.

- If you are using the Bourne, Korn, or Bash shell, add the following lines to the \texttt{.profile} or \texttt{.kshrc} file:

\begin{verbatim}
PATH=install_directory/platform/ns/bin:$PATH
export PATH

MANPATH=install_directory/doc/ns/man:$MANPATH
export MANPATH
\end{verbatim}

Replace \textit{platform} with the appropriate platform (see "\textit{Products and Supported Platforms}" on page 1-6).

---

Verifying the PowerMill Installation

To verify the PowerMill installation,

1. Make sure you are in a directory where you have read/write privileges:
   \begin{verbatim}
   % cd $HOME
   \end{verbatim}

2. Invoke the tool by entering the following command:
   \begin{verbatim}
   % powrmill
   \end{verbatim}
If you see information about the product version, production date, and copyright, the installation was successful.
This chapter describes how to install the PrimePower product.

This chapter contains the following sections:

• Installing the Software
• Setting Up PrimePower for Each User
• Verifying the PrimePower Installation

To ensure a successful installation, have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
Installing the Software

PrimePower uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

PrimePower can be installed as a stand-alone tool only; it no longer overlays the synthesis tools. You must install PrimePower in its own directory.

To install the software,

1. Download and install PrimePower from the Web or by EST, following the instructions described in “Downloading the Software” on page 2-2.

Or

Install the files from the PrimePower CD to your system, as explained in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. PrimePower is installed in a similar manner.

Note:

When you are prompted to select the product you want to install, enter pps.

2. Make sure that your licensing software is installed. For information on SCL software, see “Acquiring a License” on page 1-16.
Setting Up PrimePower for Each User

Beginning with version W-2004.12, you set up PrimePower by adding platform-independent wrappers to the PATH environment variable rather than by adding the PrimePower directory containing the executable file to the PATH variable.

To set up a new user by using platform-independent wrappers, add the PrimePower bin directory to the PATH environment variable.

- If you are using the C shell, add the following line to the .cshrc file:

  ```
  set path=(install_directory/bin $path)
  ```

- If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile or .kshrc file:

  ```
  PATH=install_directory/bin:$PATH
  export PATH
  ```

  where `install_directory` is the directory where the tool has been installed.

Verifying the PrimePower Installation

To verify the PrimePower installation,

1. Make sure you are in a directory where you have read/write privileges.

   `% cd $HOME`

2. Invoke the tool by entering the following command:

   `% pp_shell`
If you see information about the product version, production date, and copyright, the installation was successful.

Note:
To invoke the 64-bit version of PrimePower in Solaris 8 or 9, use the \texttt{-64} switch. For example,
\begin{verbatim}
\$ pp_shell -64
\end{verbatim}

3. Exit \texttt{pp_shell} by entering \texttt{exit} on the command line.

4. To run the PrimePower GUI on each installed platform, enter the following command:
\begin{verbatim}
\$ primepower
\end{verbatim}

Note:
To invoke the 64-bit version of PrimePower in Solaris 8 or 9, use the \texttt{-64} switch. For example,
\begin{verbatim}
\$ primepower -64
\end{verbatim}

5. Exit the GUI by choosing File > Exit in any GUI window.

6. To access PrimePower online Help, enter
\begin{verbatim}
\$ pp_shell -help
\end{verbatim}
which lists all command-line arguments.
This chapter describes how to install the PrimeTime product.

This chapter contains the following sections:

- Installing the Software
- Setting Up PrimeTime for Each User
- Verifying the PrimeTime Installation

To ensure a successful installation, complete the following procedures before beginning the installation process:

- Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).
- Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
Installing the Software

PrimeTime uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install PrimeTime from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the PrimeTime software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-2 on page 2-27 shows a Synopsys media installation script for PrimeTime.

PrimeTime is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of PrimeTime. You must create a new directory for PrimeTime.

Note:
- You cannot install PrimeTime as an overlay product in the same directory as the synthesis tools.

Setting Up PrimeTime for Each User

Starting with the V-2004.06 release, the pt_shell script located at primetime_root/bin/pt_shell automatically determines the platform and executes the correct pt_shell under primetime_root/platform syn/bin. This eliminates the need to change the UNIX search path for specific platforms; however, specifying the path using the old method still works.
To set up a new PrimeTime user,

1. Add the directory containing the pt_shell executable file to the PATH.

   - If you are using the C shell, add the following line to the .cshrc file:

     ```
     set path=(primetime_root/bin $path)
     ```

   - If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile, .kshrc, or .bashrc file:

     ```
     PATH=primetime_root/bin:$PATH
     export PATH
     ```

   Note:
   PrimeTime does not require the $SYNOPSYS variable.

2. (Optional) Place a .synopsys_pt.setup file in the user’s home directory.

   This step enables the user to customize the default setting for the setup file.

   If you are using the C shell, enter

   ```
   % cp primetime_root/admin/setup/.synopsys_pt.setup ~
   ```

   If you are using the Bourne, Korn, or Bash shell, enter

   ```
   # cp primetime_root/admin/setup/.synopsys_pt.setup
   ```

   You can modify this file to customize the settings for each user.
Verifying the PrimeTime Installation

Note:
The Synopsys Common Licensing (SCL) software must be installed and `SNPSLMD_LICENSE_FILE` or `LM_LICENSE_FILE` must be defined before you can verify the PrimeTime tool installation. For information on installing SCL, see “Acquiring a License” on page 1-16.

To verify installation of PrimeTime,

1. Make sure you are in a directory where you have read/write privileges.

   `cd $HOME`

2. Invoke the tool by entering one of the following commands on a licensed machine:

   `primetime_root/bin/pt_shell`  #start PrimeTime shell

   `primetime_root/bin/pt_shell -gui`  #start PrimeTime GUI

Replace `platform` with the appropriate platform (see “Products and Supported Platforms” on page 1-6).

If you get the correct prompt, or if a GUI appears, the installation was successful.
This chapter describes how to install the RailMill product.

This chapter contains the following sections:

• Installing the Software
• Setting Up RailMill for Each User
• Verifying the RailMill Installation

To ensure a successful installation, complete the following procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).

• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
Installing the Software

To download and install RailMill from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the RailMill software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. RailMill is installed in a similar manner.

RailMill is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of RailMill. You must create a new directory for RailMill.

Setting Up RailMill for Each User

To set up a new RailMill tool user,

- If you are using the C shell, source the CSHRC_platform file located in the install directory.

  % cd install_directory
  % source CSHRC_platform

  The install script for RailMill creates a CSHRC_platform file for each platform installed. The term platform is replaced with the platform you installed.

  The CSHRC_platform file contains the line

  set path=(install_directory/platform/rm/bin $path)
where *install_directory* is the directory where the tool has been installed.

If you don’t source the CSHRC_platform file, copy the above line and set the path from that file.

- If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile or .kshrc file:

```
PATH=install_directory/platform/rm/bin:$PATH
export PATH
```

Replace *platform* with the appropriate platform (see “Products and Supported Platforms” on page 1-6).

---

**Verifying the RailMill Installation**

To verify the RailMill installation,

1. Make sure you are in a directory where you have read/write privileges.
   
   `% cd $HOME`

2. Invoke the tool by entering the following command:
   
   `% railmill`

   If you see information about the product version, production date, and copyright, the installation was successful.

3. Run the RailMill GUI on each installed platform by entering the following command:
   
   `% $SYNOPSYS/platform/rm/bin/chipviewer`
4. Exit the GUI by choosing File > Exit, and clicking Yes in the dialog box.
This chapter describes how to install the Saber and Saber HDL products.

Note:
The installation instructions in this chapter are the most up-to-date available at the time of production. However, changes might have occurred. For the latest installation information, see the product release notes or documentation.

This chapter includes instructions for installing the Saber simulator and its design environment on both UNIX and Windows platforms. The procedure for installing Saber HDL is similar. Note that the Saber simulator and design environment must be installed before you install Saber HDL.

Several other tools, including the CosmosScope waveform analyzer, install with the Saber simulator.
This chapter includes the following sections:

- Preparing for Installation
- Installing the Software (UNIX and Windows)
- Invoking Saber on Windows
- Setting Up the User Environment on UNIX
- Verifying the Saber Installation on UNIX
- Using Command Options
- Uninstalling the Software
- Customer Support

**Important:**
Do not install a later version of the Saber tools over an earlier version of the tools.
Preparing for Installation

Before beginning the installation process, read the *Saber Release Notes*. The *Release Notes* are in Portable Document Format (PDF) and are located at the top level of the CD and in the electronic software transfer (EST) download directory. They require a PDF file reader to view and print them. Check for the following information:

- Changes in licensing requirements
- Changes in memory requirements
- The operating system versions on which the software is supported
- Changes made from prior releases


By default, the interface files that support MATLAB version 6.5 are installed. For access to other versions of MATLAB, see the INSTALL_README file. For instructions about setting up other optional software (Cadence, Mentor, ModelSim, Verilog), see Chapter 24, “Saber Optional Software.”

**UNIX:** You must have root or administration privileges when installing licensing or tools in a restricted directory location.

The installation script requires the Bourne shell to be available at /bin/sh.
**Windows:** Administration privileges are required for installing and uninstalling the tool. To ensure a successful installation, confirm that previous releases have been uninstalled (see “Uninstalling the Software” on page 23-20). If licensing will be installed with this installation, you must stop any existing license servers (lmgrd or avantd), then uninstall licensing. To stop the Avantd Flexlm license server or Flexlm license server, choose Administrative Tools > Services from the Control Panel.

---

**Supported Platforms and Compilers**

Saber and Saber HDL are available on CD or by EST. Obtain the appropriate binary executable files for your operating system. **Table 23-1** lists the supported platforms for this release.

**Note:**

The Frameway Integration for Mentor Graphics and the Frameway Integration for Cadence are not supported on HP-UX 11.11(11i), Solaris 9, or Red Hat Enterprise 3.0 platforms. Saber HDL installs only on Solaris and Windows platforms.

**Table 23-1  Supported Platforms, Operating Systems, and Keywords**

<table>
<thead>
<tr>
<th>Platform</th>
<th>Operating system</th>
<th>Synopsys platform keyword</th>
<th>Window environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP</td>
<td>HP-UX 11.0, 11.11(11i)(^1)</td>
<td>hp32 (32-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td>Sun</td>
<td>Solaris 8, 9(^1)</td>
<td>sparcOS5 (32-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td>IBM</td>
<td>AIX 5.1</td>
<td>rs6000 (32-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td>IA-32 (x86)</td>
<td>Red Hat Enterprise Linux 3.0</td>
<td>linux (32-bit mode)</td>
<td>GNOME</td>
</tr>
<tr>
<td>IA-32 (x86)</td>
<td>Red Hat Linux 7.2</td>
<td>linux72 (32-bit mode)</td>
<td>GNOME</td>
</tr>
</tbody>
</table>

Chapter 23: Saber and Saber HDL (version W-2004.12)

23-4
Preparing for Installation

The Saber tools work with Solaris and HP-UX platforms in combination with a FORTRAN, C, or C++ compiler. You will need one of these compilers if you are performing any of the following tasks:

- Writing templates that call routines in a language other than the MAST modeling language (“foreign” routines)
- Writing user-defined batch measures
- Providing user-defined windowing functions for a fast Fourier transform (FFT) analysis executed from within Saber
- Installing the mixed-signal interface if you choose certain Verilog-XL options

Table 23-2 shows the supported compilers for each platform.

### Table 23-2 Compatible Operating System Compilers

<table>
<thead>
<tr>
<th>Operating system</th>
<th>C</th>
<th>FORTRAN</th>
<th>C++</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun Solaris (SPARC)</td>
<td>5.3</td>
<td>5.3</td>
<td>5.3</td>
</tr>
<tr>
<td>HP9000 PA-RISC 2.0 (HP8000) using HP-UX 11 (32-bit)</td>
<td>B.11.11.04</td>
<td>B.11.01.42</td>
<td>A.03.33</td>
</tr>
<tr>
<td>IBM (RS/6000 AIX)</td>
<td>VisualAge 6.0</td>
<td>xlfcmp 6.1.0.3</td>
<td>VisualAge 6.0</td>
</tr>
</tbody>
</table>

1. Binary-compatible operating system. Note, however, that binary compatibility is not guaranteed.
Disk Space and Memory Requirements

The disk space requirement varies depending on the platform and the features selected for installation. Table 23-3 shows the maximum space required for installing all Saber features on a particular platform. Each CD also includes this information in the top-level INSTALL_README.wri file. Table 23-4 on page 23-7 shows the space and memory requirements for Saber HDL.

Table 23-3 Saber Disk Space and Memory Requirements (in Megabytes)

<table>
<thead>
<tr>
<th>Platform</th>
<th>Software (maximum)</th>
<th>Default temporary directory location</th>
<th>Temporary disk space from CD</th>
<th>Temporary disk space from EST</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solaris</td>
<td>730</td>
<td>/var/tmp</td>
<td>100</td>
<td>270</td>
</tr>
<tr>
<td>HP-UX</td>
<td>730</td>
<td>/var/tmp</td>
<td>120</td>
<td>330</td>
</tr>
<tr>
<td>Linux</td>
<td>620</td>
<td>/tmp</td>
<td>70</td>
<td>280</td>
</tr>
<tr>
<td>Windows</td>
<td>620</td>
<td>%TEMP% or C:\My Documents\temp</td>
<td>40</td>
<td>260</td>
</tr>
<tr>
<td>IBM</td>
<td>565</td>
<td>/var/tmp</td>
<td>55</td>
<td>260</td>
</tr>
</tbody>
</table>

Table 23-2 Compatible Operating System Compilers (Continued)

<table>
<thead>
<tr>
<th>Operating system</th>
<th>C</th>
<th>FORTRAN</th>
<th>C++</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red Hat Linux (IA-32 or X86)</td>
<td>gcc 2.96</td>
<td>g77 2.96</td>
<td>g++ 2.96</td>
</tr>
<tr>
<td>Microsoft Windows 2000 (32-bit)</td>
<td>MS Visual C++ 6.0</td>
<td>DEC Visual FORTRAN 5.0 with patch C</td>
<td>MS Visual C++ 6.0</td>
</tr>
</tbody>
</table>
If the default temporary directory has insufficient disk space, use the -is:tempdir /mytempdir command-line option to create an alternative directory for temporary storage. For example, for UNIX platforms,

```
% setup -is:tempdir ~/tmp
```

or

```
% Saber_version_platform.bin -is:tempdir ~/tmp
```

**Table 23-4 Saber HDL Disk Space and Memory Requirements (in Megabytes)**

<table>
<thead>
<tr>
<th>Platform</th>
<th>Software (maximum)</th>
<th>Default temporary directory location</th>
<th>Temporary disk space from CD</th>
<th>Temporary disk space from EST</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solaris</td>
<td>490</td>
<td>/var/tmp</td>
<td>100</td>
<td>215</td>
</tr>
<tr>
<td>Windows</td>
<td>390</td>
<td>%TEMP% or C:\My Documents\temp</td>
<td>40</td>
<td>258</td>
</tr>
</tbody>
</table>

If the default temporary directory has insufficient disk space, use one of the commands following Table 23-3, but substitute SaberHDL for Saber.
Installing the Software (UNIX and Windows)

You can install Saber or Saber HDL by using a GUI or text commands. By default, the installer invokes the installation GUI. To install Saber by using text commands, see “Using Command Options” on page 23-18.

Installing the Software by EST

Download the Saber release to a temporary directory. You can obtain the latest Saber download instructions from the SolvNet Release Library.

To install the software on UNIX systems,

1. Double-click the downloaded file, or enter the file name at the command prompt. For example,

   % Saber_version_platform.bin

   or

   % SaberHDL_version_platform.bin

   where version is the release you are installing. Replace platform with the appropriate platform keyword (see Table 23-1 on page 23-4).

2. Continue with the steps in “Running the Installation Program” on page 23-10.

To install the software on Windows systems,

1. Locate and double-click the .exe file. For example, double-click
Installing the Software (UNIX and Windows)

Saber_version_win.exe

or

SaberHDL_version_win.exe

where version is the release you are installing.

2. Continue with the steps in “Running the Installation Program” on page 23-10.

Installing the Software From a CD

Mounting the CD might require root access privileges. If you do not have root access privileges, see your system administrator for instructions on mounting the CD. For detailed instructions, see “Installing Product Files From a CD” on page 2-22.

To mount the CD on UNIX systems,

1. Place the CD in the CD drive.

   Most UNIX systems will automatically mount the CD. If the CD does not mount, see “Installing Product Files From a CD” on page 2-22

2. To invoke the installer, enter

   % /cdrom/setup

   or

   % cd your_cd_path; ./setup

3. Continue with the steps in “Running the Installation Program” on page 23-10.
To mount the CD on Windows systems,

1. Place the CD in the CD drive.

   The installation program should start automatically. If it does not, double-click the setup.exe executable file, located at the root level of the CD. For example,

   \( D:\texttt{setup.exe} \)

   where \( D \) is your CD drive.

2. Continue with the steps in “Running the Installation Program,” next.

---

**Running the Installation Program**

Make certain that any open applications are closed before proceeding with the installation.

When the installation program begins, the Welcome screen appears. Answer the installation prompts and click Next to continue. If scroll bars appear in the panel, scroll to make sure you have reviewed all available information.

Only the screens that require more explanation are shown. (Note that selections shown in these screens are for demonstration purposes only and might not reflect the current product version.)

1. Read the Welcome Screen.

2. In the Installation Type window, select the type of installation you want to perform.

   **UNIX:** Select a Typical or Custom installation.
Windows: Select a Typical or Custom installation, or select a Network installation to establish network access from a client machine to previously installed products on a remote machine.

3. If you selected a Typical or Custom installation, enter a directory name that does not include spaces in the Destination box. You can also use the Browse button to select a directory.

4. (Windows only) If you have chosen to perform a network installation, create a network mapped drive to a remote machine on which the Saber software was previously installed. If not, skip to step 6.

5. (Windows only) Set up network access to a remote machine.

   The Network installation option allows you to link to applications previously installed on other Windows machines. It is assumed that a stand-alone Saber installation has already been performed on another machine.

   - Enter the source path by using the previously created mapped drive, which resolves to the location where the ai_bin directory is located. For example,

     S:\Synopsys\W-2004.12

     where S: is your network mapped drive.

   - Enter a destination path name to a location on the local host machine where a minimal set of files will be installed. In the Browse window, navigate to the directory you want, for example, W-2004.12. Select this directory and click the Open button. The path to the W-2004.12 directory is inserted in the Source box.
6. Select the Saber features you want to install.

7. Select a license server type.

   Note:
   This option is available for Windows users only. However, licensing files are installed for all platforms in a directory named licensing, located in the product directory (for example, Saber/licensing). This allows you to manually set up licensing for UNIX or Windows (if necessary).

8. (Windows only) Select one of the following license server setup types:
- None
- Install and setup for Single server type
- Install and setup for Quorum server type

9. For a single license server, specify the port, host name, and license file path.

License server files are always installed, but Windows services are installed only if the local host or the machine the installer is running on matches what is specified in the HostName box, where \textit{mylocalhost} is the name of the host you are running on.
10. For a quorum license server, specify the ports, host names, and license file path.

License server files are always installed, but Windows services are installed only if the local host or the machine the installer is running on matches what is specified in one of the hostname fields, where mylocalhost is the name of the host you are running on.

11. You will see a screen that asks you to wait while the disk space is being verified. Then the summary information screen appears. This screen summarizes the selections you have made and the disk space requirements.

12. Wait while the products are installed.
While files are being copied, you can track the installation progress in the progress bar. When the bar shows 100 percent progress, you must wait while the uninstall program is created. The final installation status is then displayed, with the message that the tool has finished installing.

If errors are displayed in the final installation status, see the install log for details.

13. Click Finish to exit the installation program.

---

**Invoking Saber on Windows**

To run Saber on Windows platforms,

1. Check that your `LM_LICENSE_FILE` variable is set to a valid licensing server.

   To ensure that licenses are available, use the LMTOOLS command. If licenses are not available, the Saber Simulator will fail when invoked.

   The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use `port@host` rather than using the path to the license file.

   Each license file can contain licenses for many packages from multiple vendors. You can specify multiple license files by separating each entry with a colon (:) for UNIX or a semicolon (;) for Windows.
2. Start the tool by going to Start > Programs > Synopsys > Saber version > Saber Simulator.

The Saber window opens.

3. To check the product version, choose Help > About Saber, and in the window that opens, click Copyright/Legal.

4. To exit Saber, choose File > Exit.

---

**Setting Up the User Environment on UNIX**

To set up the user environment, you must specify the location of the executable files and set the license environment variable. The directory containing the executable commands is located within the ai_bin directory in the *install_home* installation root.

---

**Specifying the Executable File Location**

To set up a new Saber user, add the executable file to the path.

- If you are using the C shell, add the following line to the .cshrc file:
  
  ```
  set path=(install_home/ai_bin $path)
  ```

- If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile, .kshrc, or .bashrc file:
  
  ```
  PATH=install_home/ai_bin:$PATH
  export $PATH
  ```
Setting the License Environment Variable

To enable Saber to check out a license, you must set the `LM_LICENSE_FILE` environment variable.

- If you are using the C shell, add the following line:
  
  \texttt{setenv LM\_LICENSE\_FILE port@hostname}

- If you are using the Bourne shell, enter these lines:

  \begin{verbatim}
  LM\_LICENSE\_FILE=port@hostname
  export LM\_LICENSE\_FILE
  \end{verbatim}

The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use `port@host` rather than using the path to the license file.

Each license file can contain licenses for many packages from multiple vendors. You can specify multiple license files by separating each entry with a colon (:) for UNIX or a semicolon (;) for Windows.

Verifying the Saber Installation on UNIX

To verify the installation of the Saber tools,

1. Make sure you are in a directory where you have read/write privileges.

   \texttt{\% cd \$HOME}

2. Invoke the tool by entering

   \texttt{\% saber}
If the Saber tools are correctly installed, this command invokes the tool, displays the welcome screen, then opens the tool.

### Using Command Options

You can install Saber on UNIX platforms by using the `setup` script command and on Windows platforms by invoking the `setup.exe` installation program. By default, the Saber installer invokes the GUI installation program on all platforms. If you want to install the software in silent mode or in the background, use the `-silent` command-line option, which is supported on all platforms. If you do not use the `-silent` option at the command line, any option you enter is reflected in the GUI.

The following options are available from the command line. Unless otherwise indicated, they are available for both UNIX and Windows systems.

Note:

With the exception of the `-custom` and `-license` options, which apply only to Saber, these options also apply to Saber HDL.

**Usage:** `setup [options]`

- `-silent`
  
  Suppresses all graphics output.
-installdir destination_directory

Installs files to a destination directory. The path name cannot include spaces.

-typical (default)

Installs typical features.

-custom all | feature1 feature2 ...

Select one or more features to install: SaberSimulator, SaberSketch, CosmosScope, SaberHarness, ComponentLibrary, and TemplateLibrary.

Frameway features (Cadence, Innoveda, and Mentor Graphics) might not be available on all platforms.

-license port host1 [host2 host3] [license file] (Windows only)

Sets up licensing services on Windows platforms. If you specify a license file, the file must already exist and have an absolute path name. If you don’t specify a license file, the default license file path name is used. You can change the default after installation.

The LM_LICENSE_FILE environment variable is set using the port and host information specified. If the LM_LICENSE_FILE environment variable already exists, only unique port and host information will be added.

Regardless of whether the -license option is used, the lmgrd and avantd daemons are always installed, so you can set up license services manually after installation.

To set up or modify licensing services, use the Macrovision LMTOOLS program, which you can access by choosing Start > Programs > Synopsys > Saber version > License Tool.
To set or modify the `LM_LICENSE_FILE` environment variable, open the Control Panel and choose System > Environment (Windows NT) or System > Advanced > Environment Variables (Windows 2000 or later). You cannot use LMTOOLS to modify environment variables.

`-is:tempdir temporary_directory`

Specify an alternative location in which to store temporary files. On UNIX platforms, the default temporary directory might not contain enough free space to install the tool, causing the installer to terminate abnormally.

---

**Uninstalling the Software**

To uninstall the software on UNIX,

- Execute the uninstall program, which is located in the `Install_home/_Saber` directory, or delete the entire software directory.

  If you delete the directory, you must also delete the `vpd.properties` file located in your home directory.

To uninstall the software on Windows,

- From the Control Panel, select “Add/remove programs.”
  or

- Choose Start > Programs > Synopsys > Saber version > Uninstall.
  or
• Execute the uninstall program. For Saber, the uninstall program is located in the Install_home\_Saber directory. When you invoke Saber HDL from the Saber VHDL - AMS Add On, the uninstall program is located in the Install_home\_SaberHDL directory. For example,

```bash
c:> install_home\_Saber\uninstall
```

or

```bash
c:> install_home\_SaberHDL\uninstall
```

---

**Customer Support**

The following support centers are available:

**United States**

• Oregon office: 866-898-6700 or 503-547-6700, or send an e-mail message to saber-hotline@synopsys.com

**International**

• Germany: Telephone +49-89-99-320-0, fax +49-89-99-320-117, or e-mail saber-hotline-ge@synopsys.com

• France: Telephone +33 (0) 1 45 12 04 76, fax +33 (0) 1 45 12 07 07, or e-mail saber-hotline-fr@synopsys.com

• Sweden: Telephone +46 08 555 20220, fax +46 08 55520249, or e-mail saber-hotline-swe@synopsys.com
This chapter describes how to install the optional Saber tools.

The installation process for optional Saber tools is described in the following sections:

- Installing the Frameway Integration for Mentor Graphics
- Troubleshooting a Frameway Integration for Mentor Graphics Installation
- Installing the Saber Co-Simulation Interface With ModelSim
- Installing the Frameway Integration for Cadence
- Installing the Saber Co-Simulation Interface With Verilog
- Setting Up the Software to Use a Remote System
- Troubleshooting the Saber Co-Simulation Interface With Verilog Installation
• Installing the Frameway Integration for Innoveda
Installing the Frameway Integration for Mentor Graphics

This section describes how to install the Frameway Integration for Mentor Graphics option, how to set up your environment, and what to do if problems occur.

The Frameway Integration for the Mentor Graphics Falcon Framework is loaded when you select MGC Frameway Integration on the installation tool menu as a part of the software installation procedure.

For the Saber netlister to function, you must load the CDP package when you install the Mentor Graphics software. The complete package name is

CDP V8 Ap SW

Note:

The LM_LICENSE_FILE and PATH environment variables must be defined before you run the Frameway Integration or Co-Simulation Interface option.

```
% set PATH= (install_home/ai_bin $PATH)
```

Installing the Software

To install the Frameway Integration for Mentor Graphics option,

1. Verify that $MGC_HOME is set, and test the Mentor Graphics products: Design Manager, Design Architect, and Design Viewpoint Editor.

   - To invoke Design Manager, enter dmgr.
Exit Design Manager.

- To invoke Design Architect, enter `da`.

Exit Design Architect.

- To invoke Design Viewpoint Editor, enter `dve`.

Exit Design Viewpoint Editor.

2. Set up the Mentor Graphics gen_lib library.

   a. Load the Mentor Graphics gen_lib library according to the instructions provided by Mentor Graphics.

   b. Direct the software to the library by using one of the following methods:

      - Define `MGC_GENLIB` only in the location map file. Usually this definition will have already been set as part of the Design Architect installation procedure. For more information, see the *Installing Mentor Graphics Software* manual.

      - Include the location of the gen_lib in the `MGC_GENLIB` environment variable. If you set this environment variable, you can also include an `MGC_GENLIB` entry in a location map file or not use a location map at all.

3. Verify that the Saber simulator is installed and works correctly.

4. Load the Frameway Integration software.

   If you did not load the Frameway Integration for the Mentor Graphics Falcon Framework software at the time the Saber simulator was installed, do so now.

5. Add the license information to the license file. If needed, install the licenses for the Saber/Verilog Co-Simulation option and the Digital Simulation option.
6. Copy the Saber.dofile files and create symbolic links.

   To take advantage of Design Architect and Design Viewpoint userware, you must copy the .dofile file from the installation directory to the Mentor Graphics MGC_HOME directory.

   a. Make this location your current (working) directory. For example, on a SUN system enter
      ```
      cd $MGC_HOME/shared/etc/cust
      ```

   b. If the following directories do not already exist, create and change to them.
      ```
      mkdir dve
cd dve
      mkdir userware
      cd userware
      mkdir En_na
      ```

   c. Create the following symbolic link:
      ```
      ln -s En_na default
      ```

   d. Copy the .dofile files by entering
      ```
      cp $install_home/Saber/framework/falcon/ 
      userware/dve/setup_Saber.dofile default
      ```

   e. Return to your home directory.
      ```
      cd
      ```

7. Create or modify environment variables in your startup file.

   If you have scripts that automatically configure your environment, be aware that they can overwrite some of the environment variables mentioned in this step. You should place the variable declarations described in this step so that they are executed last.
To automatically set up your environment variables, use a text editor to create the lines in your startup file.

**UNIX:** For the `.cshrc` file in the C shell,

- Enter the following lines in the `.cshrc` file after the `setenv` `install_home` and `setenv MGC_HOME` variable definitions:

  ```
  setenv SABER_FALCON $install_home/Saber/framework/falcon
  setenv AMPLE_PATH $SABER_FALCON/userware
  setenv MGC_TYPE_REGISTRY $SABER_FALCON/saber_rgy/registry/ \ 
  type_registry/saber.rgy
  setenv ANLG_IPC_PKG $install_home/Saber/framework/ \ 
  falcon/ipc
  setenv ANALOGY_SABER available
  setenv SABER_MGC8_SYMBOLS $SABER_FALCON/symbols
  ```

  The order of these lines in your `.cshrc` file is important.

  **Note:**

  If `AMPLE_PATH` exists, add `$SABER_FALCON/userware` to the colon-separated list of paths. Typically, this path is placed at the end of the list, but you must determine the appropriate order of the list (enter as all one line). If `MGC_TYPE_REGISTRY` already exists, just add `$SABER_FALCON/saber_rgy/registry/type_registry/saber.rgy` to the colon-separated list of paths. The following is an example of how these would be listed in your `.cshrc` file:

  ```
  setenv AMPLE_PATH $AMPLE_PATH:$SABER_FALCON/userware
  setenv MGC_TYPE_REGISTRY$MGC_TYPE_REGISTRY:$SABER_FALCON/ \ 
  saber_rgy/registry/type_registry/saber.rgy
  ```

  For the `.profile` file in the Bourne shell,

- Enter the following lines in the `.profile` file after the `install_home` and `MGC_HOME` environment variable definitions:
The order of these lines in your .profile file is important.

Note:

   If AMPLE_PATH or MGC_TYPE_REGISTRY already exist, add the paths specified above to the existing colon-separated list of paths. For example, the previous AMPLE_PATH and MGC_TYPE_REGISTRY entries could be replaced with the following:

AMPLE_PATH="$AMPLE_PATH:$SABER_FALCON/userware"
MGC_TYPE_REGISTRY="$MGC_TYPE_REGISTRY: $SABER_FALCON/saber_rgy/registry/type_registry/saber.rgy"

Windows: On Windows platforms, the Mentor environment variables can be set in one of the following places: in the profile file or from the Start menu.

- Add the following lines to the profile.ksh file:

   export ANALOGY_SABER=available
   export SABER_FALCON=install_dir/Saber/framework/falcon
   export AMPLE_PATH=$SABER_FALCON/userware
   export MGC_TYPE_REGISTRY=$SABER_FALCON/saber_rgy/registry/type_registry/saber.rgy
   export SABER_MGC8_SYMBOLS=$SABER_FALCON/symbols

   Installing the Frameway Integration for Mentor Graphics

24-7
If \texttt{AMPLE\_PATH} or \texttt{MGC\_TYPE\_REGISTRY} is used for other applications, add the Saber paths to these variables as follows:

\begin{verbatim}
export AMPLE\_PATH="$AMPLE\_PATH;$SABER\_FALCON/ \userware"
export MGC\_TYPE\_REGISTRY="$MGC\_TYPE\_REGISTRY: \$SABER\_FALCON/saber_rgy/registry/type_registry/ \saber.rgy"
\end{verbatim}

- Go to Start > Settings > Control Panel > System > Advanced tab > Environment Variables. In the User Variable pane, click New and add the following settings:

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Variable value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANALOGY_SABER</td>
<td>available</td>
</tr>
<tr>
<td>SABER_FALCON</td>
<td>\textit{install_dir}\Saber\ framework\falcon</td>
</tr>
<tr>
<td>AMPLE_PATH</td>
<td>%SABER_FALCON%\userware</td>
</tr>
<tr>
<td>MGC_TYPE_REGISTRY</td>
<td>%SABER_FALCON%saber_rgy/registry/type_registry/ \saber.rgy</td>
</tr>
<tr>
<td>SABER_MGC8_SYMBOLS</td>
<td>%SABER_FALCON%\symbols</td>
</tr>
</tbody>
</table>

If \texttt{AMPLE\_PATH} or \texttt{MGC\_TYPE\_REGISTRY} is already set for other applications, add the following Saber paths:

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Variable value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMPLE_PATH</td>
<td>\textit{old_AMPLE_PATH};%SABER_FALCON%\userware</td>
</tr>
</tbody>
</table>
| MGC\_TYPE\_REGISTRY     | \textit{old\_MGC\_TYPE\_REGISTRY};\%SABER\_FALCON\%\saber\_r
gy/registry/type_registry/saber.rgy |

\textbf{Important:}

Do not set the \texttt{ANLG\_IPC\_PKG} variable on Windows.
Verifying the Environment Variable Settings

The environment variables described in the previous steps must be set for noninteractive invocations of /bin/csh, as well as interactive invocations of whatever shell you normally use. You cannot depend on noninteractive shells inheriting the environment from interactive shells in either Design Architect or Design Manager.

To ensure that the environment variables are correctly set,

1. Source your .cshrc file, create a new shell, or log out and log in.

2. To determine whether the environment is set correctly for interactive shells, enter

   `printenv`

3. View the results to verify each environment variable that was described in step 9. Note that the variables are expanded to their absolute paths.

4. To determine whether the environment is set correctly for a noninteractive C shell, complete the following steps:

   a. Using a text editor, create a file called my_csh_env in your current directory containing the following lines:

      ```csh
      #!/bin/csh
      printenv > analogy_csh_env
      ```

   b. Make the file executable by entering the following command at the shell prompt:

      `chmod 777 my_csh_env`

   c. To invoke Design Architect, enter

      `da`
d. When the Design Architect session window appears, move the cursor into the session window area, enter the following command, then press Return:

```bash
$system("my_csh_env")
```

e. Exit Design Architect.

The previous steps create the analogy_csh_env file, which contains a list of all environment variables in the noninteractive shell created with the invocation of Design Architect. Check this file to ensure that the environment variables are set correctly.

---

**Creating or Modifying a Location Map File**

The MGC_LOCATION_MAP variable points to a location map file. You need to modify that location map file. However, if you cannot modify the file (or don’t want to), you can copy it to your local directory, modify it, and change the MGC_LOCATION_MAP variable to point to your local copy. If the variable is not defined, or if you do not know where to find a location map file, ask your system administrator. The MGC_LOCATION_MAP variable must point to the location map file for both interactive and noninteractive shells as outlined in the previous step.

It is not sufficient to simply change the variable for your current shell. If you are not using a location map, set MGC_LOCATION_MAP to NO_MAP.

To create or modify a location map file,

1. If you need to create a location map file rather than copy an existing one, place the following lines at the beginning of the file:
24-11

Installing the Frameway Integration for Mentor Graphics

MGC_LOCATION_MAP_2
(blank line)

2. Add the following soft prefixes to the location map file that you are either creating or modifying:

$SABER_MGC8_SYMBOLS
(blank line)
$SABER_FALCON
(blank line)

The Mentor Graphics environment requires that these entries be present in the location map file to indicate that they are soft paths. You do not have to specify hard paths for the location map entries because you already defined them as environment variables, which override the corresponding location map entries. However, if you prefer, you can omit the environment variable specifications and instead specify the hard paths in the location map entries. In either case, the location map entries must be included in the location map file.

If you are using the Mentor Graphics Board Station products, a blank line after the soft prefix name in the location map file can cause a fatal error. Instead, you must specify a hard path for each soft prefix in the location map file (except for the MGC_LOCATION_MAP_2 entry).

3. Initialize the startup file by logging out and logging back in.

The installation of the Frameway Integration software is now complete.
Loading the Saber and CosmosScope Icons

To load the Saber and CosmosScope icons,

1. Start Design Manager by using the following command:

   \% dmgr

   When Design Manager is running, place the pointer in the Tools window and click to activate the menu bar for the Tools window.

2. Add the Saber toolbox.

   a. Select the Toolbox window by clicking in the border of the window.

   b. Use the right mouse button to choose “View toolboxes.”

   c. When the $MGC\_HOME/toolbox icon appears, choose Edit > Add Toolbox. A prompt bar appears on the lower-left side of the Toolboxes window.

   d. Enter the following full path in the prompt bar and click OK.

   saberfalcon/saber_rgy/toolbox

   In the preceding command, saberfalcon is the full path name to where the $SABER\_FALCON environment variable resides. You must specify a hard path or $SABER\_FALCON must be defined in the location map. If $SABER\_FALCON is defined in the location map, you can use this soft name in the prompt bar entry.

   A second toolbox named saberfalcon/saber_rgy/toolbox should now appear in the Toolboxes window.

3. Make sure the Saber and CosmosScope icons are visible in the tools window.
If the Tools window is not present inside the Design Manager window, choose View > Tools. The icons for the Saber simulator and CosmosScope should now be present in the Tools window, though you might have to scroll through the window to find them.

4. Exit Design Manager.

---

**Verifying the Installation**

To verify that the Frameway Integration for Mentor Graphics is installed correctly,

1. Copy the $install_home/test/install/mentor directory to a local location.

2. Navigate to the newly created mentor directory.

3. Set the \$SABER_FALCON environment variable to point to your local copy of the mentor directory. For example, if you are using the C shell, enter

   \% setenv SABER_EXAMPLE your_path/mentor

4. Invoke Design Architect by entering the following command:

   \% da

5. In Design Architect, click the Open Sheet icon to open the Open Sheet dialog box.

6. In the Open Sheet dialog box, click the Navigator button, and in the resulting List box, select the component you want to install.

   The path to the component appears in the Component Name box of the Open Sheet dialog box.

7. In the Open Sheet dialog box, click OK.
8. Choose Check > Sheet. Close or minimize the “Check sheet” summary.


10. Choose Saber > Netlist > Show Netlister Transcript.

    You will be able to watch the netlister process in the resulting Netlister Transcript window.

11. Choose Saber > Netlist > Start Netlister.

    This starts the netlister.

12. After the netlist process has finished without any errors, close the Netlister Transcript window.

13. Invoke Saber Guide by choosing the Saber > Start Saber Guide.

14. Open the Saber Guide Transcript window by clicking the cmd Simulation Transcript icon.

15. In the Saber Guide Transcript window, execute the following command:

    `<install.scs`

    The install.scs test program starts a simulation of a test circuit and then loads the resultant plot files into CosmosScope.

    Note:
    The signals are not plotted in the graph window. To plot the same signals in the graph window, use the `scope plot` command in the install.scs command script.
16. If the commands that were executed by the install.scs script produced no errors, the communication between the Mentor Graphics environment and the Saber simulator is good. If you want to complete the test as was done in checking the Saber simulator installation, see steps 7 and 8.

17. Exit Saber and Design Architect.

---

**Troubleshooting a Frameway Integration for Mentor Graphics Installation**

If you followed the steps in the previous section, the environment for running the Frameway Integration for the Mentor Graphics Falcon Framework should be set up correctly. However, other factors can affect the operation of the software. This section describes potential problems and suggests solutions.

**PROBLEM 1**

A schematic window is open and active but there is no Saber menu item in the menu bar, no Saber Parts Gallery menu item, and no Saber or CosmosScope icons in the palette.

**Solution A**

The `ANALOGY_SABER` environment variable is not set to the value available. It is also possible that either the variable or the value is misspelled. Setting this environment variable correctly causes the Saber menu item to appear in the menu bar even if the software has not been loaded.
Solution B

If the ANALOGY_SABER environment variable is set correctly, other causes might be that you executed an old version of Mentor Graphics software or that some other third-party userware redefined the menu bar. If fixing these potential causes does not solve your problem, contact Customer Support.

PROBLEM 2

A schematic window is open and active and there is a Saber menu item in the menu bar, but there is no pull-down menu associated with it.

Solution

The userware has not been loaded into Design Architect. Enter the following command:

```bash
% ls $SABER_FALCON/userware
```

Check that the des_arch, base, and dve directories are listed and that there is something in each of these directories. Also, make sure that the AMPLE_PATH environment variable contains the exact path that $SABER_FALCON/userware resolves to. For information on setting AMPLE_PATH, see step 7, option 2, on page 24-5 in the preceding section.

PROBLEM 3

The first time you open a schematic window, error messages appear in the Design Architect transcript window stating that $load_library failed in the ipc.ample file.
Solution A

Check that the $ANLG_IPC_PKG/lib/ample_ipc.dl file exists. If not, check the ANLG_IPC_PKG environment variable setting, which is defined in $install_home/bin/ai_setupmgc and aisetupmgc_csh.

Solution B

The library mentioned in the $load_library message must have execute permissions. Check the permissions of $ANLG_IPC_PKG/lib/ample_ipc.dl to ensure that read and execute permissions exist for everybody.

PROBLEM 4

A netlist fails after you chose Saber > Netlist or Saber > Start Saber Guide and ran an analysis.

Solution A

If a transcript window appears and shows the error message, fix the problem as described. The transcript window shows the actual output of the current run.

Solution B

Check the transcript window carefully for the following message:

dvetos.exe: command not found

Check that your path environment variable points to the install_home/ai_bin directory.
PROBLEM 5

The palette icons associated with the Saber products appear as letters or numbers rather than pictures in Design Architect, or the Saber simulator tool icons (Saber and CosmosScope) do not appear in the Design Manager Tools window.

Solution

HP Platforms

Verify that the $SABER_FALCON/saber_rgy/registry/fonts directory is not empty. If the fonts directory is not empty, you might be using the wrong fonts. Before rebuilding the fonts, you must remove everything in the fonts directory. If .snf files were in this directory before, create X11R4 fonts. If .pcf files were in this directory before, create X11R5 fonts.

All Platforms

If the fonts still do not work after you rebuild them, execute the following commands:

```
% xset fp+ $SABER_FALCON/saber_rgy/registry/fonts
% xset fp+ $MGC_HOME/registry/fonts
% xset fp rehash
```

This procedure should get your workstation to recognize the fonts. If you still have problems, ensure that everyone has at least read and execute permissions on all of the directories identified by the $SABER_FALCON/saber_rgy/registry/fonts path.
Installing the Saber Co-Simulation Interface With ModelSim

Note:
The LM_LICENSE_FILE environment variable must be defined before you install a Frameway Integration or Co-Simulation Interface option. For details, see “Setting the License Environment Variable” on page 23-17.

Before you can correctly install the Saber/ModelSim interface, you must verify the proper installation and operation of the ModelSim software and the Saber software.

To correctly set up the Saber/ModelSim interface with the correct master-slave relationships, perform the following operations:

• For Solaris:
  If ModelSim is master, enter

  `% setenv SABER_MODELSIM install_home/Saber/ \ 
  bin/sabermti.so`
  `% setenv PATH = (install_home/ai_bin $path)`
  `% setenv LD_LIBRARY_PATH:$install_home/ \ 
  Saber/bin`

  If Saber is master, enter

  `% setenv SABER_MODELSIM install_home/Saber/ \ 
  bin/sabermti.so`

  $PATH must include the path to the ModelSim executable files.

• For HP-UX:
  If ModelSim is master, enter
% setenv SABER_MODELSIM install_home/Saber/ \ 
   bin/sabermti.sl
% setenv SHLIB_PATH install_home/Saber/bin
% setenv PATH $PATH:$install_home/ai_bin

If Saber is master, enter

% setenv SABER_MODELSIM install_home/Saber/ \ 
   bin/sabermti.sl

$PATH must include the path to the ModelSim executables files.

- For Windows:
  1. Open the Environment Variables dialog box.
     For example, on a Windows 2000 system, go to Start > 
     Settings > Control Panel > System > Advanced > Environment 
     Variables.
  2. Set the SABER_MODELSIM variable to
     
     install_home\Saber\sabermti.dll
  3. If ModelSim is the master, add the following line to the PATH 
     variable:
     
     install_home\ai_bin;install_home\Saber\bin
  4. PATH must include the path to the ModelSim executable files.
  5. Modify LM_LICENSE_FILE to include the location of the 
     Synopsys license file. You can use path or port@hostname 
     syntax.

    27000a server1; 27000a server2
Installing the Frameway Integration for Cadence

Note:

The **SABER_HOME** and **LM_LICENSE_FILE** environment variables must be defined before you install a Frameway Integration or Co-Simulation Interface option. Set the **SABER_HOME** environment variable as follows:

```
% setenv SABER_HOME install_home/Saber
```

To set **LM_LICENSE_FILE**, see “Setting the License Environment Variable” on page 23-17.

Before you can correctly install the Frameway Integration for the Cadence Design II Environment, you must verify the proper installation and operation of the partner software and the Saber software. To make these checks,

1. Test the Design Framework II software installation.
   a. Invoke Design Framework II by entering the appropriate command for your system. Your invocation command will be similar to one of the following examples: `icms`, `ictb`, `msfb`, or `icds`.

      The Frameway Integration for Design Framework II is compatible with the Cadence Composer and Analog Artist 4.X.
   b. Exit Design Framework II.
      Note:
      If you are unable to invoke Design Framework II, see the appropriate Cadence installation manual for more information.

2. Verify that the Saber simulator is installed and works correctly.
3. Set the library environment variables.

Set or modify the path to your `LD_LIBRARY_PATH` (Sun) or `SHLIB_PATH` (HP) variable in your `.cshrc` file. A script is provided to automate this procedure. Simply enter the following lines at the command-line prompt:

```bash
% ed 's/$0/ai_setlibpath/’ $SABER_HOME/bin/ \ 
   ai_setlibpath > ! /tmp/my_setlibpath
% source /tmp/my_setlibpath
```

4. (Optional) If you will be using a partner simulator with the Saber simulator, verify that the Verilog simulator is installed for use as a partner simulator.

5. Load the Frameway Integration software.

If you did not load the Frameway Integration for the Cadence Design Framework II at the time the Saber simulator was installed, do so now.

6. Install the necessary license.

   a. Add the license information to the license file.

   b. If needed, install the licenses for the Saber/Verilog Co-Simulation option and the Digital Simulation option.

7. Create the directories.

   You must create a directory named local in cadence standard directory/tools/dfII and create several directories within the local directory.

   a. Make this directory your current (working) directory. For example, on a Sun system enter

   ```bash
   % cd $cds_root/tools/dfII
   ```

   b. Create this directory, if it does not already exist, as follows:
% mkdir local

c. Create the following directories in the local directory if they do not already exist:

% cd local
% mkdir hnl
% mkdir -p si/caplib
% cd si/caplib

d. Copy the si_saber_cds.il file to a Saber.il file in the caplib directory and change permissions, as follows:

% cp $SABER_HOME/framework/artist/skill/ \  
si_saber_cds.il  cadence_standard_directory/ \  
tools/dfll/local/si/caplib/Saber.il
% chmod 755 cadence_standard_directory/tools/dfll/ \  
local/si/caplib/Saber.il

e. Copy the hnl_saber_cds.il file to a Saber.il file in the hnl directory and change permissions, as follows:

% cp $SABER_HOME/framework/artist/skill/ \  
hnl_saber_cds.il  cadence_standard_directory/ \  
tools/dfll/local/hnl/Saber.il
% chmod 755 cadence_standard_directory/tools/dfll/ \  
local/hnl/Saber.il

8. Enter cd to return to your home directory.

9. Edit your cds.lib file to add symbol information.

The cds.lib file is a part of the Cadence Design Framework II software.

- Edit the cds.lib file to include the path to the Frameway symbols in the definition of the library search path. You do this by using ASCII files. For example,
DEFINE SaberLib $SABER_HOME/framework/artist/symbols/SaberLib
DEFINE basic $CDS_HOME/tools/dfII/etc/cdslib/basic
INCLUDE /.../other/.../cdslib

These files can call other cdslib files so that system files can be resident in a location and referred to with an INCLUDE statement. Environment variables can be used as shown.

If the cdslib file is in your local directory, it is used. Otherwise the ~/cdslib file is used. By using a local cdslib file, you can set design-specific search paths.

10. In the Cadence Design Framework II directory, create a MAST file containing initial configuration information.

   a. To create the file, use an ASCII editor, such as vi, that does not insert formatted text and enter

      //Revision 4
      //NOTE
      // Default template for MAST
      // Note:
      // Please remember to replace Top Cell
      // Library, Cell, and View fields with the
      // actual names used by your design.
      //END_NOTE

      config mast;
      design myLib.myCell:myView;

      viewlist mast, schematic, symbol;
      stoplist mast, symbol;

      endconfig

   b. Place the file in the following directory:

      $CDS_HOME/tools/dfII/local/hierEditor

   c. Name the file MAST and save it.

11. Copy the .artistSaberDefaults.il file.
The .artistSaberDefaults.il file sets the defaults for menus and dialog boxes in Design Framework II. You can copy this file into your home directory and modify it to set the defaults you prefer for general use, or you can copy it into a particular project directory and then modify it to set the defaults to be used for that project.

If more than one .artistSaberDefaults.il file exists on your system, the .artistSaberDefaults.il file in your current (working) directory is used if it exists. If not, the .artistSaberDefaults.il file in your home directory is used.

a. Make your home directory or a project directory your working directory.

b. To copy the file to your working directory, enter

```
% cp $SABER_HOME/framework/artist/dotfiles/.artistSaberDefaults.il .
```

Enter the code all on one line. The space and period at the end are important.

c. To change the default working directory for the Cadence Design Framework II software, which is set by the .artistSaberDefaults.il file, edit the file as follows:

System administrators: To change the sitewide .artistSaberDefaults.il file, edit the file in $SABER_HOME/framework/artist/dotfiles.

Individual users: Edit your local copy of the .artistSaberDefaults.il file in one of the following ways:

- Set the saber_simRunDir template to point to the specific directory you want.

Or you can set

```
saber_simRunDir = getWorkingDir()
```
Chapter 24: Saber Optional Software

24-26

- Choose Saber > Set Working Directory and specify the directory you want.

- Use a UNIX environment variable called `SABER_DEFAULT` to set the path to the `.artistSaberDefaults.il` file.

  If this path is set and the file is present, this file will be loaded. Otherwise the `.artistSaberDefaults.il` file will be loaded from the home directory or the working directory. For example, suppose you set the variable as follows:

  ```
  setenv SABER_DEFAULT /homes/myfile/latest
  ```

  If there is an `.artistSaberDefaults.il` file in `/homes/myfile/latest`, it will be used instead of any other files present on your system.

12. Load the new ~/.cdsinit file.

   To access the integration to Cadence 4.4.5, 4.4.6, or 5.0, you need to create a new `.cdsinit` file and install it in each user’s home directory. Use a text editor, such as vi, that does not insert formatted text.

   The contents of the `.cdsinit` file for this release are different from the contents in previous versions. An example of the new file contents follows:
load(strcat(getShellEnvVar("install_home")
   "/framework/artist/skill/analogy.il "))
;
load(strcat(getShellEnvVar("install_home")
   "/framework/artist/skill/analogyReg.il”));
;
load(strcat(getShellEnvVar("install_home")
   "/framework/artist/skill/viewgen.il “))
;
analogy_menu_creation()
;
printf( "Done with startup 
   initialization.\n"
)

The analogyReg.il and viewgen.il files are necessary only if you are using the Frameway Integration for Cadence text views feature. These files are used to register the MAST view type. The MAST views must be registered before you can create them.

13. Register the MAST views by performing the following steps:

a. Go to the data.reg file, which is located at
   $SABER_HOME/framework/artist/skill
b. Do one of the following:
   - Put data.reg into the home directory.
   - Follow the instructions in data.reg to split it into these files:
     cds_install/share/cdssetup/registry/data/mast.reg
     cds_install/share/cdssetup/registry/tool/mastEditor.reg

c. Load analogyReg.il with analogy.il. Add a line to your .cdsinit file that will load the analogyReg.il file.
   The analogyReg.il file contains the trigger functions and is located at
   $SABER_HOME/framework/artist/skill
d. You must load viewgen.il with analogy.il. (You can do so by adding a line to your .cdsinit file that will load the viewgen.il file.) The viewgen.il file is located at

$SABER_HOME/framework/artist/skill

e. To create a MAST view that uses the trigger functions found in analogyReg.il, follow the procedures on creating text views in Cadence in the *Analyzing Designs Using Saber for the Cadence Design Framework II* manual.

14. Verify that the menus have been installed correctly and complete the installation.

a. Copy the $SABER_HOME/test/install/cadence directory to a local location.

b. Edit your cds.lib file to include the path of the cadence/install library.

c. Invoke Design Framework II by entering the appropriate command for your version of the software (for example, icde, icds, icms,asicfe, layout, layoutPlus, icca,asicpr, or icfb).

   The Saber menu item should appear on the menu bar in the schematic window.

d. Choose File > Open. The Open File dialog box appears.

e. In the Open File dialog box,

   - Select Library Name > install.

   - Then select Cell Name > install.

   - Then select View Name > schematic.

   - Click OK.

f. The schematic window should appear with no errors. Check and save the design if necessary.
g. In the schematic window,
   - Choose the Saber > Set Working Directory.
   - In the resulting Project Information dialog box, check that the Project Directory box is set to your_path/cadence.
   - Click OK.

h. In the schematic window, select Saber > Netlist > Start Netlister.
   This starts the netlister. A simulation window appears that contains the netlister transcript.

i. Once the netlist process has finished without errors, close the simulation window.

j. Invoke Saber Guide by choosing Saber > Start Saber Guide.
   The design is automatically loaded in Saber.

k. Open the Saber Guide transcript window by clicking the Simulation Transcript icon.


m. Navigate to your_path/cadence and load the install.scs file.
   This will execute the commands in the install.scs file. The install.scs test program starts a simulation of a test circuit and then loads the resultant plot files into CosmosScope.
   If the commands that were executed by the install.scs script produced no errors, the communication between the Cadence Design Framework II and the Saber simulator is good.

n. Exit Saber and Design Framework II.
Installing the Saber Co-Simulation Interface With Verilog

Note:
The `LM_LICENSE_FILE` environment variable must be defined before you install a Frameway Integration or Co-Simulation Interface option. See “Setting the License Environment Variable” on page 23-17.

To simulate mixed-signal designs by using Verilog-XL as a partner simulator with the Saber simulator, you will need the following licenses:

- Licenses for the Saber/Verilog Co-Simulation Interface (SABER/VERILOG_MM)
- A license from Cadence Design Systems for the Verilog-XL simulator

To build the Verilog executable file, you need to run the vconfig utility provided by Cadence.

Set or modify the path to your `LD_LIBRARY_PATH` (Sun) or your `SHLIB_PATH` (HP) variable in your `.cshrc` file.

See the instructions for linking Verilog executable files in the Cadence documentation.

To install your Saber/Verilog software,

1. Install the software.

   The Saber/Verilog Co-Simulation Interface software is loaded at the same time you load the Saber integrated suite of products.
2. Install the licenses.
   - If you have not yet installed a license file for your software, you can install the license for the SABER/VERILOG_MM option as a part of the software installation procedure.
   - If you have already installed a license file for your software, update that file by adding the SABER/VERILOG_MM license.

3. Verify that the Saber simulator is installed and works correctly.

4. Install the Verilog-XL simulator license.
   Obtain a Verilog-XL simulator license from Cadence Design Systems, and complete any installation instructions provided with the license.

5. Test that the Verilog-XL simulator is installed correctly.
   - Invoke the Verilog-XL simulator by entering the appropriate command for your system.
     If you cannot invoke the Verilog-XL simulator, see the appropriate Cadence Design Systems installation manual for more information.
   - Exit the Verilog-XL simulator.

6. (Optional) Create a configuration file for socket communication.
   By default, pipe communication mode is used with the Saber simulator. If you want to use socket communication with Saber Guide, you must create a config.vmx file as follows:
   a. Copy the $install_home/bin/config.vmx file to your working directory.
If you save the config.vmx file to a directory other than your working directory, you must modify your \$install_home/bin/verilog.scf file accordingly.

b. Make no other changes to the verilog.scf file.

The version of the verilog.scf file provided with the software must be used when you use the Saber/Verilog software. Check that no other versions are present in the data search path ahead of this file.

7. Create the Verilog executable file.

Follow Cadence instructions for invoking vconfig. The instructions likely involve adding a directory to your PATH environment variable for example, $CDS_ROOT/tools/bin.

a. When vconfig asks, “What do you want to name the Verilog_XL target?,” use the default: verilog.

b. When vconfig asks, “Do you want to include Verilog Mixed-Signal Interface?,” answer YES.

c. When vconfig asks for the names of additional files to be loaded, enter a single period (.)

d. Create the Verilog executable file by entering

```bash
% ai_make_verilog
```

For more information about the command, enter

```bash
% ai_make_verilog -h
```

8. Install the Verilog-XL executable file in the desired directory.

9. (Optional) Change the invocation name for the Saber/Verilog simulator.

You can set the invocation name verilog to an ASCII string of your choosing in the invocation_name.scf file.
Setting Up the Software to Use a Remote System

To set up your Saber/Verilog software to run on a remote system,

1. Set up a user account on the remote system.
   
   Your system administrator might need to do this for you.

2. Test that you can execute a remote shell locally.
   
   - To test on an HP system, enter
     
     `remsh remote_host_name ls`
   
   - To test on other systems, enter
     
     `rsh remote_host_name ls`

Troubleshooting the Saber Co-Simulation Interface With Verilog Installation

This section describes a series of potential problems and suggests solutions.

**PROBLEM 1**

You get an error while creating the Verilog executable file.
Solution A

Usually, this error is due to missing or incorrect versions of the C or C++ compilers.

Solution B

Some releases of Cadence's vconfig might produce a script that, when run, produces undefined symbols:

```
ld: Undefined symbol
bcopy
getdtablesize
getwd
```

These symbols are undefined because a Cadence library, virtuous.a, is missing from the vconfig output script. The library will be included if you answer the vconfig questions in a particular way. In general, those questions that have `v` as their default answer result in the inclusion of virtuous.a. Contact Cadence for details.

PROBLEM 2

When you attempt to operate remotely, the error message “remote_host_name: remote_host_name: cannot open” is displayed.

Solution

The restricted shell version of the `rsh` command was executed instead of the remote shell version. Change your `PATH` environment variable to include the path to the remote shell version of the `rsh` command. This executable file is typically located in either `/usr/ucb`.
or /usr/bin. This directory should appear in the search path ahead of any directories containing, or pointing to, the restricted shell version of the rsh command.

**PROBLEM 3**

When you attempt to operate remotely, the error message “permission denied” is displayed.

Solution

Complete the following steps:

- Log in to the remote system.
- Create or modify a file named .rhosts in your home directory on the remote system. Include in the file a line that contains the name of your local system. To view man page information about the .rhosts file, enter one or both of the following commands:

```
man login
man rsh
```

**PROBLEM 4**

You are unable to start Verilog-XL from the Saber simulator.

**Solution A**

The Verilog-XL executable file does not have execute permission. Change the permission on the executable file, using the command

```
% chmod +x verilog_pathname
```

where *verilog_pathname* is the path to Verilog-XL, including the executable file.
Solution B

The Verilog-XL executable file is not found in the PATH variable. Change the path definition to include the directory where the Verilog-XL executable file resides, as follows:

```
set PATH = (verilog_directory $PATH)
```

where verilog_directory is the path to the directory containing the Verilog-XL executable file.

PROBLEM 5

Verilog-XL starts but exits immediately with the message

***The partner simulator exited unexpectedly***

Solution A

Verilog-XL cannot find the license file. Examine the Verilog-XL output file verilog.log. Look for a line in the log file similar to this one:

```
```

If such an error is found, make sure that LM_LICENSE_FILE points to the appropriate license file. Modify the environment variable if necessary, as follows:

```
setenv LM_LICENSE_FILE "...:verilog_license_file"
```

where verilog_license_file is the path to the Verilog-XL license file.
Solution B

The `LM_LICENSE_FILE` environment variable is pointing to a Verilog-XL license file that is invalid or has expired. Examine the Verilog-XL output file `verilog.log`. Look for a line in the log file similar to this one:

```
Error! ERROR (LM -35): license for feature has expired.
```

If such an error is found, obtain a valid license file from Cadence Design Systems, install the license file, and set the `LM_LICENSE_FILE` environment variable accordingly.

PROBLEM 6

When you invoke the Saber/Verilog software with the Verilog-XL simulator running on a remote host, the Verilog-XL simulator starts but exits immediately with the following error message:

```
The partner simulator exited unexpectedly
```

Solution A

There is no permission to execute the shell on the remote host. Verify that you have permission to execute an `rsh` command on the remote host by entering

```
% rsh host 'ls' (Sun machines)
% remsh host 'ls' (HP machines)
```

where host is the name of the remote host. If you are unable to execute a remote shell, contact your system administrator to arrange for you to execute remote shells on the remote host.
Solution B

The remote working directory is invalid. Verify that the working directory on the remote host is valid by entering

```bash
% rsh host 'cd remote_directory'
```

where `host` is the name of the remote host, and `remote_directory` is the directory where the Verilog-XL simulator will be run on the remote host.

Correct the remote working directory as necessary to ensure a valid path name on the remote host, either by modifying the Saber Guide invocation command line (`-pwd` option) or by modifying the `verilog.scf` file (where the remote working directory can be specified).

Solution C

The Verilog-XL executable file cannot be found in the path on the remote system. Verify that the Verilog-XL executable file can be found on the remote system by entering

```bash
% rsh host 'cd remote_directory; verilog -s verilog_file'
```

where `host` is the name of the remote host, `remote_directory` is the directory where the Verilog-XL executable file will be run on the remote host, and `verilog_file` is the name of Verilog-XL input file.

Change permissions on the Verilog-XL executable file, or modify the path so that the Verilog-XL executable file can be found on the remote system.
Installing the Frameway Integration for Innoveda

You can install the Frameway Integration for Innoveda option at the same time you load Saber or after you have loaded Saber.

1. Install the Innoveda software.

   The Innoveda software must be loaded on your system before you install the Frameway Integration for Innoveda. For instructions, see your Innoveda eProduct Designer installation manual.

2. Install Saber and the Frameway Integration for Viewlogic.

   For instructions, see Chapter 23, “Saber and Saber HDL (version W-2004.12).

3. Test the Innoveda eProduct Designer software installation.

   Before you can correctly invoke and configure the Frameway Integration for Innoveda, you must verify the proper installation and operation of the Innoveda eProduct Designer software as follows:

   - Invoke DxDesigner by clicking Start > Programs > eProduct Designer > AnalogDesign and Simulation > Batch Mode > DxDesigner.

     If the DxDesigner does not start correctly, see the appropriate Innoveda eProduct Designer installation manual or call Innoveda customer support for more information.

   - Exit DxDesigner.

4. Test the Saber simulator installation.

   Invoke the tool at a DOS prompt by entering
C:> saber

If the Saber tools are correctly installed, this command displays the Saber welcome screen and then opens Saber Guide with Scope.

5. Add Saber symbol information to the viewdraw.ini file.

The viewdraw.ini file, located in the install_home\Saber\framework\innoveda\standard directory, specifies the paths to the Analogy symbol libraries. You might need to modify these paths to reflect the absolute paths to where the Analogy symbol libraries are installed on your network.

If necessary, in the viewdraw.ini file, replace the $(SABER_HOME) path name in each of the Analogy symbol library paths with the actual path to where the Saber symbol files reside.

For example, if the location of install_home is c:\user\user, you would change the symbol library path from

```
DIR [mr] $(SABER_HOME)/framework/viewlogic/symbols/beta (shr_beta)
```

to

```
DIR [rm] c:\user\user\Saber\framework\innoveda\symbols\beta (shr_beta)
```

6. Modify the WDIR, install_home, PATH and $LM_LICENSE_FILE environment variables as follows:

- Start the System program. Choose

  Start > Settings > Control Panel > System > Environment tab
- Add these paths to the WDIR variable:

  \install_home\Saber\framework\innoveda\standard
  \install_home\ai_bin
  \install_home\Saber\bin

- Add these paths to the PATH variable:

  \install_home\ai_bin
  \install_home\Saber\bin

- Modify LM_LICENSE_FILE to include the location of the Synopsys license file. You can use path or port@hostname syntax.

  27000@server1; 27000@server2

7. Verify that the Saber menu has been added to ViewDraw.

   - Restart the eProductDesigner toolbar.
   - Open ViewDraw by clicking the ViewDraw icon.

The Saber menu should be in the menu bar to the left of the Help menu.

Installing the Frameway Integration for Innoveda
The W-2005.03 version of Synopsys Online Documentation (SOLD) contains the most recent documentation for each product (which might be from an earlier foundation release). You can access the documentation by clicking the product name on the SOLD front panel. This chapter describes how to install SOLD.

This chapter contains the following sections:

- About SOLD
- Acquiring and Installing the Adobe Reader Software
- Verifying Your Adobe Acrobat Software
- Installing SOLD
- Verifying the SOLD Installation
• Configuring SOLD for Each User

To ensure a successful installation, complete the following procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).

• Define the SYNOPSYS environment variable (see “Defining the SYNOPSYS Environment Variable” on page 1-20).
About SOLD

SOLD contains document files in the cross-platform Adobe Portable Document Format (PDF), as well as Portable Document Index files (PDX) that enable full-text searching across all SOLD documents.

To read and search these files, you need version 4.0 or later of Adobe Acrobat Reader with Search plug-in or Adobe Acrobat. You can download and install the newest version, Adobe Reader 7.0 (for Windows) or Adobe Reader 5.0.10 (for UNIX) free of charge from the Adobe Web site. For more information, see “Acquiring and Installing the Adobe Reader Software” on page 25-4.

SOLD is packaged in the following ways:

• The Synopsys Online Documentation (SOLD) Compressed Files CD
  This CD contains installation files as well as compressed tar files for each of the SOLD products (ssd1, ssd2, and jsd) so that you can install SOLD on your hard drive.

  For a description of the SOLD products, see Using SOLD.

• The Synopsys Online Documentation (SOLD) Volumes 1, 2, and 3 CDs
  Each of these CDs contains the PDF files for one of the SOLD products (CD 1 contains ssd1, CD 2 contains ssd2, and CD 3 contains jsd). These CDs are used for reading SOLD directly from the CD—they do not include installation files.

  The installation instructions in this chapter apply only to the SOLD Compressed Files CD.
**Acquiring and Installing the Adobe Reader Software**

You can acquire the Acrobat Reader software by downloading the freeware Acrobat Reader from the Web. To have full Search capability with version 6.0, you must select “Full version” (the default) to download.

**Note:**  
Beginning with version 6.0, Acrobat Reader is called Adobe Reader.

---

**Downloading and Installing Adobe Reader From the Web**

To download Adobe Reader from the Acrobat Web site,

1. Go to http://www.adobe.com/ and click the Get Adobe Reader button. Follow the instructions on the Web page.

2. Uncompress the tar.Z file or use the gunzip utility for the tar.gz file. For example,

   ```
   % gzip -d sol-508.tar.gz
   ```

3. Untar the resulting file. For example,

   ```
   % tar xvf sol-508.tar
   ```

4. Enter ./install to start the installation script.

For more information, consult the ReadMe.html file or instgud.txt file that comes packaged with Acrobat Reader.
Verifying Your Adobe Acrobat Software

To view SOLD, you must have Acrobat Reader version 4.x or later.

To search SOLD, you must have the Search plug-in. For information about searching SOLD on the Linux platform, see *Using SOLD*.

The following sections describe how to determine your current software configuration.

Checking the Version Number

If you are using 3.x or an earlier version of Acrobat, you must upgrade to view SOLD. Follow the instructions in “Acquiring and Installing the Adobe Reader Software” on page 25-4.

To check the version number,

1. Open Acrobat Reader.

2. Choose Help > About Acrobat Reader (or Help > About Adobe Acrobat).

3. In the window that appears, verify that the words “Acrobat Reader 4.0” or “Adobe Acrobat 4.0” appear. (Later versions of Acrobat Reader are also supported.)

4. Close the About screen by clicking anywhere in the window.

Checking for the Search Plug-In

If you are using Acrobat Reader without the Search plug-in, you must upgrade to have full-text searching capability in SOLD. The Search plug-in cannot be downloaded from the Adobe site as a separate file;
to upgrade, you must download the entire Adobe Reader with Search plug-in package. Follow the instructions in “Acquiring and Installing the Adobe Reader Software” on page 25-4.

To check for the Search plug-in,

1. Open Acrobat Reader (if it is not already open).
2. Choose Help > About Plug-Ins or About Adobe Acrobat Plug-Ins to verify that Acrobat Search is on the list of installed plug-ins.

---

**Installing SOLD**

You can install SOLD by electronic software transfer (EST) or from the SOLD CD. In either case, you use the Synopsys Installer, which allows you choose either GUI installation or installation with a text script.

The SOLD CD package contains one compressed CD for installation and three uncompressed CDs that are read-only.

---

**Contents of SOLD**

The SOLD documentation set contains PDF document files, the index (PDX) files that enable full-text searching, and the UNIX installation scripts.

SOLD contains several collections of documents. Each collection describes a particular subject area and resides in its own directory. Each collection directory contains all the PDF files for the books in its subject area, as well as the index files for searching in that collection.
The README.1ST file in the SOLD directory and on the SOLD CD lists the contents of SOLD.

---

**Installation Options**

There are two ways to install SOLD:

- As a stand-alone installation
- As an overlay installation, installed over an existing synthesis tools directory

**Note:**
You cannot install a stand-alone product over a stand-alone SOLD installation. To install SOLD and a stand-alone product together, install the product first, then install SOLD as an overlay installation.

The SOLD installation procedure copies files from the SOLD directory (for EST) or SOLD CD into the appropriate places in the Synopsys root directory structure.

SOLD offers the following installation options:

- Full installation on hard drive
- Partial installation on hard drive
- No installation on hard drive (read from CDs)

A full installation is performed when you use the new Synopsys Installer installation. Most sites use a full installation for shared access by many users. If disk space is at a premium, you can create a partial installation by removing unused directories after the installation is complete (see “Partial Installation” on page 25-9).
**Electronic Software Transfer Installation**

The Synopsys Installer enables you to install SOLD by using a text script or a GUI. To download and install SOLD from the Web or by FTP, follow the procedures described in “Downloading the Software” on page 2-2.

To access SOLD products ssd1, ssd2, and jsd, download the sold_W-2005.03.tar.Z file.

If you are using a text script to install SOLD, see Example 2-1 on page 2-24, which shows a Synopsys media installation script for the synthesis tools. SOLD is installed in a similar manner.

For a description of the SOLD products, see *Using SOLD*.

**CD Installation**

The Synopsys Installer enables you to install SOLD by using a text script or a GUI.

To install SOLD from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22.

If you use the Synopsys Installer GUI, note the following:

- When you see a GUI screen asking you to deselect products that don’t need the platform-independent package, click Next. Do not deselect the chosen selection.

- SOLD is platform independent; therefore when you see a GUI screen for selecting platforms, All is preselected. Do not deselect All.
Example 2-2 on page 2-27 shows a Synopsys media installation script for the synthesis tools. SOLD is installed in a similar manner.

---

**Partial Installation**

Because each collection directory is self-contained, partial installations of SOLD are possible.

To effect a partial installation of SOLD, perform a standard installation, then delete from $SYNOPSYS/doc/online those collection directories you do not need at your site.

**Important:**

Do not delete the top.pdf file; it contains the SOLD front panel, which lists the products that are documented. Do not delete the solid directory; it contains *Using SOLD*.

Keep the remaining collection directories intact: Do not remove files from them or move the files in a collection relative to each other. Such modifications can cause hypertext links and the search mechanism to fail.

---

**Verifying the SOLD Installation**

Verify the installation by opening SOLD. To open SOLD, issue the command

```bash
$SYNOPSYS/sold
```

If SOLD is correctly installed, this command invokes Acrobat and displays the SOLD welcome screen in the Acrobat window.
Configuring SOLD for Each User

To configure SOLD for each user, you must specify the location of Acrobat Reader.

The first time you invoke SOLD, you must specify the location of the Acrobat Reader executable file that you are using. To invoke SOLD, enter

```bash
$SYNOPSYS/sold
```

If the Acrobat Reader location is unknown, you will be prompted for this information. The Acrobat Reader location that you specify is stored in the $HOME/.sold/acrobat file and then is automatically used whenever you invoke SOLD. If the Acrobat Reader location changes after your initial installation, manually modify the $HOME/.sold/acrobat file to reflect the new location.

For information about using SOLD, including how to search for information, see *Using SOLD*. To access Using SOLD, open SOLD and click the hypertext link labeled “Using SOLD.”
This chapter describes how to install the Star-MTB product.

Note:
The installation instructions in this chapter are the most up-to-date available at the time of production. However, changes might have occurred. For the latest installation information, see the product release notes or documentation.

This chapter contains the following sections:

- Media Availability and Supported Platforms
- Disk Space Requirements
- Installing the Software
- Setting Up Star-MTB for Each User
- Verifying the Star-MTB Installation
Important:
Star-MTB is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of Star-MTB. You must create a new directory for Star-MTB.

Media Availability and Supported Platforms

Star-MTB is available on CD or by EST download. Obtain the appropriate binary executable files based on the operating system you need. Table 26-1 shows the supported platforms for the W-2004.12 release.

Table 26-1  Supported Platforms and Keywords

<table>
<thead>
<tr>
<th>Platform</th>
<th>Operating system</th>
<th>Synopsys platform keyword</th>
<th>Path Keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP PA-RISC 2.0</td>
<td>HP-UX 11.0, 11.11 (11i)(^1,2)</td>
<td>hp32 (32-bit mode)</td>
<td>pa11</td>
</tr>
<tr>
<td>IA-32 (X86)</td>
<td>Red Hat Enterprise Linux 3.0(^1)</td>
<td>linux (32-bit mode)</td>
<td>linux</td>
</tr>
<tr>
<td>IA-32 (X86)</td>
<td>Red Hat Linux 7.2(^2)</td>
<td>linux72 (32-bit mode)</td>
<td>linux</td>
</tr>
<tr>
<td>Sun SPARC</td>
<td>Solaris 8, 9(^1)</td>
<td>sparcOS5 (32-bit mode)</td>
<td>sol4</td>
</tr>
<tr>
<td>DEC Alpha</td>
<td>OSF 4.0</td>
<td>alpha</td>
<td>alpha</td>
</tr>
</tbody>
</table>

1. Binary-compatible operating system. Note, however, that binary compatibility is not guaranteed.
2. HP-UX 11.0 and 11.11 and Linux Red Hat Enterprise 64-bit platforms are not available on CD. The products running on these platforms will be available for download by electronic software transfer (EST) at a later date. For availability, check with your Synopsys sales representative.
To install a product, select the appropriate platform keyword. To set an environment variable, select the appropriate path keyword.

Disk Space Requirements

Make sure you have enough disk space for the installation. For a full installation on all platforms, 550 MB is recommended. For a single platform installation, approximately 200 MB is recommended.

Installing the Software

Beginning with the W-2004.12 release, the installation procedure for installing Star-MTB has changed. Star-MTB now uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script.

To download and install Star-MTB from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the Star-MTB software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. Star-MTB is installed in a similar manner.

Setting Up Star-MTB for Each User

To set up a new tool user,

• Enter the path information.
• Set up a license variable that points to the license server.

• Source the cshrc.meta file, or use a dot (.) with the kshrc.meta file (where . is a Bourne or Korn shell command).

Add the following information to the cshrc, .kshrc, or a Star-MTB source file:

1. Add the Star-MTB executable files to your search path.

   ```
   setenv MTB_TPATH (install_dir/MTB/platform)
   
   Replace platform with the appropriate platform (see Table 26-1 on page 26-2).
   
   - If you are using the C shell, enter
     ```
     set path=($MTB_TPATH:$path)
     ```
   
   - If you are using the Bourne or Korn shell, enter
     ```
     path=($MTB_TPATH:$path)
     ```
   
```

2. Set the LM_LICENSE_FILE variable.

   ```
   - If you are using the C shell, add the following line:

     ```
     setenv LM_LICENSE_FILE port@hostname
     ```
   
   - If you are using the Bourne or Korn shell, enter these lines:

     ```
     LM_LICENSE_FILE=port@hostname
     export LM_LICENSE_FILE
     ```
Verifying the Star-MTB Installation

To verify the Star-MTB installation,

1. Make sure you are in a directory where you have read/write privileges.

   % cd $HOME

   The $installdir environment variable refers to the Star-MTB installation directory. This variable is created when you source the cshrc.meta file.

2. To run a demonstration simulation, enter

   % sml

   If a Star-MTB banner appears with no license error message, the installation was successful.
This chapter describes how to install the Star-RCXT product.

Note:
The installation instructions in this chapter are the most up-to-date available at the time of production. However, changes might have occurred. For the latest installation information, see the product release notes or documentation.

This chapter includes the following sections:

• Media Availability and Supported Platforms
• Disk Space Requirements
• Installing the Software
• Setting Up Star-RCXT for Each User
• Verifying the Star-RCXT Installation
• Customer Support
Media Availability and Supported Platforms

Star-RCXT is available on CD or by EST. Obtain the appropriate binary executable files based on the operating system you need. Table 27-1 shows the supported operating systems and keywords for this release.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Operating system</th>
<th>Platform keyword</th>
<th>Path keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD Opteron</td>
<td>Red Hat Enterprise Linux 3.0&lt;sup&gt;1&lt;/sup&gt;</td>
<td>amd64 (64-bit mode)</td>
<td>AMD.64</td>
</tr>
<tr>
<td>HP PA-RISC 2.0</td>
<td>HP-UX 11.0, 11.11 (11.i)&lt;sup&gt;1, 2&lt;/sup&gt;</td>
<td>hp32 (32-bit)</td>
<td>HP.64</td>
</tr>
<tr>
<td>HP PA-RISC 2.0</td>
<td>HP-UX 11.0, 11.11 (11.i)&lt;sup&gt;1, 2&lt;/sup&gt;</td>
<td>hp64 (64-bit)</td>
<td>HP.64</td>
</tr>
<tr>
<td>IA-32 (x86)</td>
<td>Red Hat Enterprise Linux 3.0</td>
<td>linux</td>
<td>IA.32</td>
</tr>
<tr>
<td>IA-32 (x86)</td>
<td>Red Hat Linux 7.2&lt;sup&gt;1&lt;/sup&gt;</td>
<td>linux72</td>
<td>IA.32-RH72</td>
</tr>
<tr>
<td>Itanium 2</td>
<td>Red Hat Enterprise Linux 2.1&lt;sup&gt;1&lt;/sup&gt;</td>
<td>linuxipf (64-bit mode)</td>
<td>IA.64</td>
</tr>
<tr>
<td>Sun SPARC</td>
<td>Solaris 8, 9&lt;sup&gt;2&lt;/sup&gt;</td>
<td>sparcOS5 (32-bit)</td>
<td>SUN.32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sparc64 (64-bit)</td>
<td>SUN.64</td>
</tr>
</tbody>
</table>

1. The HP-UX, Red Hat Linux 7.2, and Red Hat Enterprise Linux 64-bit platforms will be available for download by electronic software transfer (EST) at a later date. For availability, check with your Synopsys sales representative.
2. Binary-compatible operating system. Note, however, that binary compatibility is not guaranteed.

To install a product, select the appropriate platform keyword. To set an environment variable, select the appropriate path keyword (see “Setting Up Star-RCXT for Each User” on page 27-5).
Disk Space Requirements

The disk space requirement varies depending on the operating system and the tool selected for installation. Table 27-2 shows the maximum space required for installing each product on a particular operating system.

Table 27-2 Disk Space Requirements (in Megabytes)

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Megabytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base size (including online Help files)</td>
<td>115</td>
</tr>
<tr>
<td>Sun Solaris 32-bit</td>
<td>108</td>
</tr>
<tr>
<td>Sun Solaris 64-bit</td>
<td>144</td>
</tr>
<tr>
<td>HP-UX 32-bit</td>
<td>111</td>
</tr>
<tr>
<td>HP-UX 64-bit</td>
<td>124</td>
</tr>
<tr>
<td>Red Hat Linux 32-bit</td>
<td>90</td>
</tr>
<tr>
<td>AMD Opteron Red Hat enterprise Linux</td>
<td>94</td>
</tr>
<tr>
<td>Itanium Red Hat Enterprise Linux</td>
<td>145</td>
</tr>
</tbody>
</table>

Installing the Software

Beginning with the W-2004.12 release, the installation procedure for Star-RCXT has changed. Star-RCXT now uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script.

To download and install Star-RCXT from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.
To install the Star-RCXT software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. Star-RCXT is installed in a similar manner.

Star-RCXT is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of Star-RCXT. You must create a new directory for Star-RCXT.

Setting Up Star-RCXT for Each User

To set up a new tool user, add the following information to the .cshrc, .kshrc, or a Star-RCXT source file:

1. Add the Star-RCXT executable files to your search path.
   - If you are using the C shell, enter
     
     ```
     set path=(installation_directory/platform_star-rcxt/bin $path)
     ```
   - If you are using the Bourne shell, enter
     
     ```
     PATH=installation_directory/platform_star-rcxt/bin:$PATH
     export PATH
     ```

2. Set the `LM_LICENSE_FILE` environment variable.
   - If you are using the C shell, add the following line:
     
     ```
     setenv LM_LICENSE_FILE port@hostname
     ```
   - If you are using the Bourne shell, enter these lines:
     
     ```
     LM_LICENSE_FILE=port@hostname
     export LM_LICENSE_FILE
     ```
The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use port@host rather than using the path to the license file.

Each license file can contain licenses for many packages from multiple vendors. You can specify multiple license files by separating each entry with a colon (:).

Verifying the Star-RCXT Installation

To verify the Star-RCXT installation,

1. Make sure you are in a directory with read/write privileges.
   
   $ cd $HOME

2. Run the Star-RCXT GUI on each installed platform by entering

   $ StarXtract -gui

   The GUI will appear on your screen.

3. Exit the GUI by choosing File > Exit in any GUI window.

Customer Support

For information about using Star-RCXT, see the Star-RCXT User Guide.

For information about accessing Star-RCXT documentation, see “Related Publications” on page xxi.
For information about contacting Customer Support, see “Customer Support” on page xxiii.
This chapter describes how to install the Star-SimXT product.

This chapter contains the following sections:

• Media Availability and Supported Platforms
• Downloading and Installing the Software
• Setting the Environment Variables
• Verifying the Star-SimXT Installation
• Customer Support
Media Availability and Supported Platforms

Star-SimXT is available on CD or by EST. Obtain the appropriate binary executable files based on the operating system you need. Table 28-1 shows the supported platforms for the V-2003.12 release.

Table 28-1  Supported Operating Systems and Platform Keywords

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Platform keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solaris 7, 8 (Solaris 5.5, 5.6 are also supported)</td>
<td>sparcOS5, sparc64</td>
</tr>
<tr>
<td>HP-UX 11.0, 11i (HP-UX 10.2 is also supported)</td>
<td>hp32, hp64</td>
</tr>
<tr>
<td>Red Hat linux 7.2 (Red Hat linux 7.1 is also supported)</td>
<td>linux</td>
</tr>
</tbody>
</table>

Downloading and Installing the Software

To download and install Star-SimXT,

1. Create a Star-SimXT installation directory if one does not already exist. For example,

   % mkdir -p /usr/synopsys/starsimxt

2. Download the Star-SimXT release to the installation directory.

   You can get the latest Star-SimXT download instructions from the SolvNet Release Library.

3. Uncompress and untar the files:

   % gzip -dc starsimxt_version_platform.tar.gz | tar xvf -
This command creates a subdirectory in the Star-SimXT installation directory. For example,

```
/usr/synopsys/starsimxt/starsimxt_version_platform
```

In the remainder of this chapter, this subdirectory is referred to as the Star-SimXT installation directory.

4. To set the file permissions on the new directory tree and its contents, enter

```
% chmod -R 755 /usr/synopsys/starsimxt
```

5. Remove the starsimxt_version_platform.tar.gz file.

```
% rm starsimxt_version_platform.tar.gz
```

6. For each user, set the required environment variables, as described in the next section.

---

**Setting the Environment Variables**

This section discusses the following environment variables:

- `starsimxt_HOME`
- `LM_LICENSE_FILE`

It is recommended that you place these variables in your `$HOME/.cshrc` or `$HOME/.profile` file as your default settings.
Setting the $starsimxt_HOME Environment Variable

Follow these steps.

1. Set the $starsimxt_HOME environment variable to point to your Star-SimXT installation directory.
   - If you are using the C shell, enter
     setenv starsimxt_HOME starsimxt_installation_directory_path
   - If you are using the Bourne shell, enter
     % starsimxt_HOME=starsimxt_installation_directory_path
     export starsimxt_HOME

2. Add $starsimxt_HOME/bin to your search path.
   - If you are using the C shell, enter
     set path=($starsimxt_HOME/bin $path)
   - If you are using the Bourne shell, enter
     PATH=$starsimxt_HOME/bin:$PATH
     export PATH

Setting the LM_LICENSE_FILE Environment Variable

To enable Star-SimXT to check out a license, you must set the LM_LICENSE_FILE environment variable. For example,

- If you are using the C shell, enter the following line:
  setenv LM_LICENSE_FILE port@hostname

- If you are using the Bourne shell, enter these lines:
  LM_LICENSE_FILE=port@hostname
  export LM_LICENSE_FILE
The port and host name variables correspond to the TCP port and license server *hostname* specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use *port@hostname* rather than using the path to the license file.

Each license file can contain licenses for many packages from multiple vendors. You can specify multiple license files by separating each entry with a colon (:).
Customer Support

A new e-mail alias has been created for Star-SimXT users. To subscribe to this mailing list, send an e-mail to starsim-user-request@synopsys.com, and include subscribe in the body of the e-mail. To unsubscribe, type unsubscribe.

For information about using Star-SimXT, see the Star-Sim XT User Guide. To find out how to access Star-SimXT documentation, see “Related Publications” on page xxi.

For information about contacting Customer Support, see “Customer Support” on page xxiii.
This chapter describes how to install the Synopsys synthesis tools.

This chapter contains the following sections:

- Synthesis Tools
- Installing the Software
- Configuring the Synthesis Tools
- Installing Optional Tools
- Verifying the Synthesis Tools Installation

To ensure a successful installation, complete the following procedures before beginning the installation process:

- Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).
• Define the **SYNOPSYS** environment variable (see “Defining the **SYNOPSYS** Environment Variable” on page 1-20).

• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).

---

**Synthesis Tools**

The Synopsys synthesis tools include the following:

• **Core synthesis tools**
  - Automated Chip Synthesis
  - BSD Compiler
  - Design Analyzer
  - Design Compiler
  - Design Vision
  - DesignWare
  - DFT Compiler
  - EDIF 2 0 0 Interface
  - Floorplan Manager
  - HDL Compiler (Presto Verilog)
  - Library Compiler
  - Module Compiler
  - Physical Compiler
- Power Compiler
- VHDL Compiler

- Synopsys Integrator for Falcon Framework
  - Mentor C version
  - Mentor D version

If you have purchased any of these tools, you must install the synthesis tools suite.

Note:
Beginning with the W-2004.12-SP2 release, Design Compiler FPGA no longer installs with the synthesis tools. See Chapter 8, “Design Compiler FPGA (version W-2005.03).”

Most synthesis tools install on all platforms (sparcOS5, sparc64, hp32, hp64, linux, and so on). The exception is Design Analyzer, which installs only on sparcOS5, hp32, linux, and rs6000.

---

**Installing the Software**

To download and install the synthesis tools from the Web or by FTP, follow the procedures described in “Downloading the Software” on page 2-2.

To transfer the files from the Synthesis CD to your system, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22.
On the sparcOS5 platform, you can choose to install either version C (sf3) or D (sf4) of the Synopsys Integrator for Falcon Framework product, but not both. On the hp32 platform, you can install only version D (sf4).

Example 2-1 on page 2-24 shows a sample Synopsys media installation script for the synthesis tools.

---

**Configuring the Synthesis Tools**

This section describes how to

- Set up the synthesis tools for each user
- Set up the systemwide defaults
- Configure the Browser for Physical Compiler and Design Vision

---

**Setting Up the Synthesis Tools for Each User**

To set up a new synthesis tools user,

1. Add the directory for the synthesis executable files to the `PATH` environment variable.

   If you are using the C shell, add the following line to the `.cshrc` file:

   ```
   set path=($SYNOPSYS/platform/syn/bin $path)
   ```

   If you are using the Bourne, Korn, or Bash shell, add the following line to the `.profile`, `.kshrc`, or `.bashrc` file:

   ```
   PATH=$SYNOPSYS/platform/syn/bin:$PATH
   export PATH
   ```
Replace *platform* with the appropriate platform (see “Products and Supported Platforms” on page 1-6).

When you install the synthesis files, a copy of the synthesis setup file is placed in $SYNOPSYS/admin/setup/.synopsys_dc.setup. The .synopsys_dc.setup file contains the system defaults for the synthesis tools. You can modify this file to customize the settings for your environment.

2. Place a .synopsys_dc.setup file in the user’s home directory.

   If you are using the C shell, enter

   ```
   % cp $SYNOPSYS/admin/setup/.synopsys_dc.setup ~/.synopsys_dc.setup
   ```

   If you are using the Bourne, Korn, or Bash shell, enter

   ```
   % cp $SYNOPSYS/admin/setup/.synopsys_dc.setup $HOME/.synopsys_dc.setup
   ```

   You can modify this file to customize the settings for each user.

3. To use a graphical user interface (GUI), such as Design Analyzer, you must also add the X Window System executable files to the `PATH` environment variable.

   If you are using the C shell, add the following line to the .cshrc file:

   ```
   set path=(/usr/dt/bin /usr/bin/X11 $path)
   ```

   For Solaris 8 or 9, add

   ```
   set path=(/usr/dt/bin /usr/openwin/bin $path)
   ```

   If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile, .kshrc, or .bashrc file:

   ```
   PATH=/usr/dt/bin:/usr/bin/X11:$PATH
   export PATH
   ```
For Solaris 8 or 9, add

```
PATH=/usr/dt/bin:/usr/openwin/bin/X11:$PATH
export PATH
```

---

**Setting Up the Systemwide Defaults**

If you are using the Design Analyzer product, you can customize the display for all users at a site by modifying the Design Analyzer application defaults (app-defaults) file. This file is placed in the following location during installation:

```
$SYNOPSYS/admin/setup/Design_analyzer
```

To see a list of available colors for the Solaris 8 platforms, enter

```
% more /usr/openwin/lib/X11/rgb.txt
```

For all other platforms, enter

```
% more /usr/lib/X11/rgb.txt
```

To see a list of available fonts, enter

```
% xlsfonts | more
```

To install the changes, copy the modified app-defaults file into the systemwide app-defaults location, which varies from site to site. To find the systemwide location at your site, contact your system administrator.

**Note:**

You must have root access privileges to install this systemwide defaults file.
If your app-defaults location is in X11 (a common location), install the Design_analyzer file by entering a command similar to the one in the following example:

```
% cp $SYNOPSYS/admin/setup/Design_analyzer /usr/openwin/lib/X11/app-defaults
% cp $SYNOPSYS/admin/setup/Design_analyzer /usr/lib/X11/app-defaults
```

You can customize the GUI display for an individual Design Analyzer user by adding color and font definitions to the .Xdefaults file in each user’s login directory. Values defined in the .Xdefaults file override the values in the systemwide app-defaults file.

If you are using the Design Vision or Physical Compiler GUI tools, see the appropriate online Help system for information about customizing the tool environment.

---

**Configuring the Browser for Physical Compiler and Design Vision Online Help**

The Physical Compiler and Design Vision online Help systems are browser-based HTML Help systems designed for viewing in Netscape version 7.0 for UNIX or version 4.78 for UNIX. These Help systems are not supported in Netscape version 6.

**Important:**

When you use online Help from within the GUI, the netscape executable file must be on the UNIX path.

Both Help systems make extensive use of Java, JavaScript, and style sheets. In your browser preferences, select the Advanced category and make sure that

- In Netscape 7.0, the Enable Java and XSLT options are both selected
• In Netscape 4.78, the Enable Java, Enable JavaScript, and Enable Style Sheets options are all selected, and the Enable Java Plugin option is deselected

As an alternative to opening either Help system from within its respective GUI tool, you can view the Help system stand-alone by opening the file named index.html in Netscape.

Installing Optional Tools

The synthesis media installation script automatically installs most of the synthesis tools. However, the following tools require manual setup or installations:

• Synopsys Integrator for Falcon Framework
• Power Compiler VPOWER
• SoCBIST

Installing Synopsys Integrator for Falcon Framework

To complete the setup for the Synopsys Integrator for Falcon Framework product, set the SYNOPSYS_IFF_ROOT environment variable to point to the Synopsys integrator directory.

When asked for the Falcon Framework version, enter

• C if you selected the sf3 product from the installation script
• D if you selected the sf4 product from the installation script
Note:
You can install Falcon Framework version C or D, but not both. Version C is supported only on the Solaris 8 (sparcOS5) operating system; version D is supported on both HP-UX 11.0 or 11i (hp32) and Solaris 8 (sparcOS5) operating systems.

If you are using the C shell, add the following line to the .cshrc file:

```
setenv SYNOPSYS_IFF_ROOT $SYNOPSYS/platform/syn/interfaces/mentorC
```

If you are using the Bourne, Korn, or Bash shell, add the following lines to the .profile file:

```
SYNOPSYS_IFF_ROOT=$SYNOPSYS/platform/syn/interfaces/mentorC
export SYNOPSYS_IFF_ROOT
```

Replace `platform` with one of the following: hp32 or sparcOS5.

---

**Installing Power Compiler VPOWER**

VPOWER is the Power Compiler interface to VCS, the Cadence Verilog-XL and NC-Verilog simulators, and the MTI Verilog simulator. VPOWER contains user tasks that allow you to monitor toggle activity during simulation and to output the information in a form readable by Power Compiler. To use VPOWER, link the user tasks to the executable file of your simulator.

The following sections describe the steps for static-linking VPOWER with Verilog-XL and VCS simulators only. For information about linking VPOWER with other simulators, see the *Power Compiler User Guide*.  

---

Installing Optional Tools
Verilog-XL Simulator

The following procedure describes how to link VPOWER to a version of the Verilog-XL simulator that contains the standard features you normally use at your site and includes the toggle count utilities needed for Power Compiler.

Note:
You must perform this installation on a machine that has access to your Verilog-XL simulator vendor distribution.

Consult your Verilog system administrator to obtain the following information before beginning the VPOWER installation:

- The directory path to your Verilog .o, .a, and .h files
- The directory location of your central Verilog distribution, for obtaining a current site copy of the veriuser.c file

This installation requires modification of your veriuser.c file. By obtaining a current site copy of the veriuser.c file, you can be sure to include any current site modifications when you modify this file.

To install VPOWER,

1. Change to the Synopsys vpower directory.
2. Modify a copy of your site veriuser.c file.
3. Link the VPOWER user tasks to the simulation executable file.
4. Copy the linked executable file.

The following sections describe these steps.
Changing to the Synopsys power Directory. All directories listed are relative to the root of the vpower directory: $SYNOPSYS/auxx/syn/power/vpower.

To change to the Synopsys vpower directory,

1. Make sure the environment variable $SYNOPSYS is set.

   \% echo $SYNOPSYS

   If it is not set, set it to the correct value.

   \% setenv SYNOPSYS root_directory

2. Change to the Synopsys vpower directory.

   \% cd $SYNOPSYS/auxx/syn/power/vpower

Modifying the veriuser.c File. To modify the veriuser.c file to define the new toggle count utilities,

1. Change to the vxl/vxl.sample directory, and review the sample veriuser.c file, which shows the edits you will have to make.

   \% cd vxl/vxl.sample

2. Copy your current site version of veriuser.c into the sample directory. To copy veriuser.c, you must know the directory location of your central Verilog distribution.

   \% cp site_location_dir_path/veriuser.c .

   By using a current site copy of veriuser.c, you ensure that any existing customizations are included in the VPOWER installation.

3. As shown in the sample veriuser.c file, make the following changes in your current site copy of veriuser.c:
- Add the following line:

```
#include "tcExtern.h"
```

- Add the following user tasks:

```
{usertask, 0, 0, 0, tc_set, tc_set_sync, "$toggle_set", 1},
{usertask, 0, 0, 0, tc_start, 0, "$toggle_start", 1},
{usertask, 0, 0, 0, tc_stop, 0, "$toggle_stop", 1},
{usertask, 0, 0, 0, tc_reset, 0, "$toggle_reset", 1},
{usertask, 0, 0, 0, tc_compatibility, 0, "$toggle_count", 1},
{usertask, 0, toggle_report_check, 0, toggle_report, 0, "$toggle_report", 0},
{usertask, 0, 0, 0, read_lib_saif, tc_lib_sync, "$read_lib_saif", 1},
{usertask, 0, 0, 0, read_rtl_saif, tc_set_sync, "$read_rtl_saif", 1},
```

- Comment out the following line:

```
char *veriuser_version_str = "";
```

4. Save your modified veriuser.c file.

5. Exit your text editor and remain in the sample directory to link the executable file.

**Linking User Tasks to the Simulation Executable File.**

VPOWER provides two ways to link the user tasks to your simulator executable file: by using the vconfig utility or by using a UNIX makefile. Each method links your simulator to the VPOWER user tasks. Choose the method that you find familiar or comfortable.

**Using vconfig to Link the Executable File.** The vconfig utility creates a script called cr_vlog. The cr_vlog script links your Verilog-XL simulator’s executable file to the VPOWER user tasks. You must define the name of the executable file created by cr_vlog, for example, verilog_toggle.
To use the vconfig method to link your executable file,

1. Use your vconfig utility or an equivalent utility to generate the cr_vlog script or an equivalent script.

2. In the script, set an environment variable pointing to the directory of the generated library archive. For example (if you are using Solaris 7 or later),

   ```
   setenv PPLILIB "../../lib-sparcOS5/libvpower.a"
   ```

3. In cr_vlog, look for the line that includes the math libraries:

   ```
   -lm \n
   ```

4. Add a line above this line to include the libvpower.a library. For example,

   ```
   $PPLILIB \n   -lm \n   ```

5. Run cr_vlog.

   ```
   % cr_vlog
   ```

   This script links your executable file to the VPOWER user tasks and creates the customized executable file called verilog_toggle. For details about linking the programmable language interface (PLI) by using the vconfig utility, see the Power Compiler User Guide.

Proceed to “Copying the Linked Executable File” on page 29-14.

Using a Makefile to Link the Executable File. Using the UNIX make command, you can use a makefile to link your Verilog-XL executable file to the VPOWER user tasks. The makefile creates a modified executable file called verilog_toggle.
Two makefiles exist: Makefile.sol and Makefile.hp.

To use the makefile method to link your executable file,

1. Using a text editor such as vi, edit the appropriate makefile to set variable values for VERILOG_LIB and VERILOG_INC.

   Modify the lines in the makefile to read according to your data. For example, enter

   ```
   VERILOG_LIB = path1
   VERILOG_INC = path2
   ```

   where path1 is the path to your Verilog distribution .o and .a files, and path2 is the path to your Verilog distribution .h files.

   The VERILOG_LIB variable must point to the directory path of the vlog.o and omnitasks.o files. The VERILOG_INC variable must point to the directory path of the acc_user.h and veriuser.h files.

2. Save the modified makefile and exit your text editor.

3. Use the make utility to link the executable file.

   ```
   % make -f Makefile.platform
   ```

   The platform extension is sol or hp.

   The make command uses the modified makefile to link your executable file, creating a customized executable file called verilog_toggle.

**Copying the Linked Executable File.** After you create your customized executable file, change the permissions so that the file is not writable, and copy it to a directory suitable for group access.
Enter the following commands at the UNIX prompt:

```
% chmod ogu-w verilog_toggle
```

This removes write access to other, group, and user.

```
% cp verilog_toggle site_verilog_bin_location
```

This copies the file to the site_verilog_bin_location directory for group access.

**VCS Simulator**

The following procedure describes how to link VPOWER to a version of VCS that contains the standard features you normally use at your site and includes the toggle count utilities needed for Power Compiler.

Note:

The PLI library has been tested with VCS version 3.0 and later versions.

To install VPOWER,

1. Change to the Synopsys vpower directory.
2. Modify a copy of the PLI table file.
3. Compile the simulation executable file.

The following sections describe these steps.

**Changing to the Synopsys vpower Directory.** All directories listed are relative to the root of the vpower directory: $SYNOPSYS/auxx/syn/power/vpower.
1. Make sure the environment variable $SYNOPSYS is set.

   `% echo $SYNOPSYS`

   If it is not set, set it to the correct value.

   `% setenv SYNOPSYS synthesis_root_directory`

2. Change to the Synopsys vpower directory.

   `% cd $SYNOPSYS/auxx/syn/power/vpower`

Modifying the PLI Table File. To modify the PLI table file (vpower.tab) to define the new toggle count utilities,

1. Change to the vcs/vcs.sample directory, and review the sample vpower.tab file, which shows the edits you will have to make.

   `% cd vcs/vcs.sample`

2. Make the necessary changes to the vpower.tab file.

Compiling the Simulation Executable File. VCS is a compiled simulator, so you must compile your designs along with VCS libraries to make a simulation executable file. To add PLI functionality to the simulation executable file, you need to link an extra PLI library when you compile your designs.

For Solaris the appropriate PLI library is

`../lib-sparcOS5/libvpower.a`

You normally get a VCS simulation executable file by entering the following command at the UNIX prompt:

`% vcs -Mupdate your_verilog_design_files compiler_options`
To link with the PLI library, enter

```
vcs -Mupdate \
-P $SYNOPSYS/auxx/syn/power/vpower/vcs/vcs.sample/vpower.tab \nyour_verilog_design_files compiler_options \
$SYNOPSYS/auxx/syn/power/vpower/lib-sparcOS5/libvpower.a
```

This generates an executable file called simv that includes PLI functionality.

Note:
You can copy vpower.tab and libvpower.a into any file locations that are convenient for you.

---

**Using SoCBIST**

To insert SoCBIST into your design, you need DFT Compiler, which installs with the synthesis tools. You also need TetraMAX if you want to use the SoCBIST pattern generation functionality. You can install TetraMAX as an overlay on the synthesis tools or as a stand-alone installation. For required SoCBIST environment variables, see “Setting Up the User Environment” on page 32-6.

---

**Verifying the Synthesis Tools Installation**

Note:

The Synopsys Common Licensing (SCL) software must be installed and `SNPSLMD_LICENSE_FILE` or `LM_LICENSE_FILE` must be defined before you can verify the synthesis tools installation. For information on installing SCL, see “Acquiring a License” on page 1-16.

To verify installation,
1. Make sure you are in a directory where you have read/write privileges:

   \% cd $HOME

2. Invoke the synthesis tools on a licensed machine. For example, invoke Design Compiler, Library Compiler, Design Analyzer, or Design Vision by entering one of the following commands:

   \% $SYNOPSYS/platform/syn/bin/dc_shell
   \% $SYNOPSYS/platform/syn/bin/lc_shell
   \% $SYNOPSYS/platform/syn/bin/design_analyzer
   \% $SYNOPSYS/platform/syn/bin/design_vision

   Replace \textit{platform} with the appropriate platform.

   For the most recent information about tool-specific platform support, see the documentation for your product.

   \textbf{Note:}

   You can verify other synthesis tools by using the preceding command. Simply replace the executable file name with the name of another synthesis tool.

   If you get the correct prompt, or if a GUI appears, the installation was successful.
This chapter describes how to install the System Studio product.

This chapter contains the following sections:

• Installing the Software
• Setting Up System Studio for Each User
• Verifying the System Studio Installation
• Troubleshooting Startup Problems

To ensure a successful installation, complete the following procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).
• Define the SYNOPSYS environment variable (see “Defining the SYNOPSYS Environment Variable” on page 1-20).
• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).

Note:
For detailed information on operating systems and acquiring patches, see “Supported Platforms and Operating Systems” on page 1-3.

---

## Installing the Software

Beginning with the V-2004.06 release, System Studio uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install System Studio from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the System Studio software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. System Studio is installed in a similar manner.
Setting Up System Studio for Each User

Set the defaults for each user according to the user’s shell and operating system. Table 30-1 lists the path name and description of systemwide defaults for System Studio.

Table 30-1  System Studio Systemwide Defaults

<table>
<thead>
<tr>
<th>Path name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYNOPSYS_CCSS</td>
<td>Identifies the System Studio installation directory. For example, $SYNOPSYS/sparcOS5/ccss.</td>
</tr>
<tr>
<td>CCSS_SIM_DIR</td>
<td>Path to the directory for code generation and simulation results (defaults to $HOME/ccss/sim)</td>
</tr>
<tr>
<td>CCSS KEYS</td>
<td>Specifies the complete file name of the license file. If CCSS KEYS is not set, the tool searches for other license keys in the following order: - SNPSLMD_LICENSE_FILE - LM_LICENSE_FILE</td>
</tr>
</tbody>
</table>

For C Shell Users

To use the C shell to set up a new System Studio tool user,

1. Add the System Studio executable directory to the PATH environment variable.

Add the following line to the .cshrc file:

```
setenv SYNOPSYS_CCSS ccss_home/platform/ccss
setenv CCSS_SIM_DIR ccss_sim_dir
set path = ($SYNOPSYS_CCSS/bin $path)
```

Replace platform with the appropriate platform (see “Products and Supported Platforms” on page 1-6).
Note:
You can define CCSS_SIM_DIR, but if it is not set, the GUI provides a reasonable default.

2. Point to your license key file by adding one of the following lines to your ~/.cshrc file:

```bash
setenv CCSS_KEYS /path/to/synopsys.lic
```

3. If the paths to the C++ compiler, debugger, and `make` command are not already included in your ~/.cshrc file, add the following line to your ~/.cshrc file:

```bash
set path = (compiler_home/bin make_home/bin $path)
```

4. To source the CCSS setup file, add the following line to your ~/.cshrc file:

```bash
source $SYNOPSYS_CCSS/../gnupackages/source_me.csh
```

5. Make these changes effective by logging out and logging in again or by entering

```bash
% source ~/.cshrc
```

---

For Bourne Shell Users

To use the Bourne, Korn, or Bash shell to set up a new user,

1. In your $HOME directory, add the following lines to the appropriate user setup file (.profile, .kshrc, or .bashrc):

```bash
SYNOPSYS_CCSS=ccss_home/platform/ccss
export SYNOPSYS_CCSS

CCSS_SIM_DIR=ccss_sim_dir
export CCSS_SIM_DIR
```

---

Chapter 30: System Studio (version W-2004.09)
30-4
PATH=$SYNOPSYS_CCSS/bin:$PATH
export PATH

Replace *platform* with the appropriate platform (see “Products and Supported Platforms” on page 1-6).

Note:
You can define CCSS_SIM_DIR, but if it is not set, the GUI provides a reasonable default.

2. If the System Studio license file will not be installed in the default location, add the following lines to your setup file:

```
CCSS_KEYS=lic_file
export CCSS_KEYS
```

3. If the paths to the C++ compiler, debugger, and *make* command are not already included in your setup file, add the following lines to it:

```
PATH=compiler_home/bin:make_home/bin:$PATH
export PATH
```

4. To source the CCSS setup file, add the following line to your setup file:

```
. $SYNOPSYS_CCSS/../gnupackages/source_me.sh
```

5. Make these changes effective by logging out and logging in again, or by entering

```
$. $HOME/setup_file
```

where *setup_file* is .profile, .kshrc, or .bashrc.
VHDL Simulation

If you intend to use the external simulation interface for VHDL cosimulation under the algorithmic domain of System Studio, you must ensure that the VHDL packages are analyzed before you use them. Your system administrator should analyze the files when System Studio is installed.

The relevant commands are

```
% cd $SYNOPSYS_CCSS/packages/vsscli/src/
% vhdlan -nc ccss_vsscli_package.vhdl
% cd $SYNOPSYS_CCSS/packages/bittrue/vhdlsynopsys/src/
% vhdlan -nc CCSS_PACKAGE_SYNOPSYS.vhdl \ 
  LIB_0_0_1_PACKAGE_SYNOPSYS.vhdl
%
```

Verifying the System Studio Installation

To verify the System Studio installation,

1. Make sure you are in a directory where you have read/write privileges:

   `% cd $HOME`

2. Invoke the tool by entering the following command:

   `% css &`
Troubleshooting Startup Problems

This section addresses common startup problems.

Key File Problems

To test the System Studio installation, start the System Studio Design Center. If the software does not start, check the contents of the key file as follows:

1. If you are using a network license file, check the first line of the key file and make sure the host name and the host ID match those of the machine on which the license is running.

   \texttt{SERVER hostname hostid 27000}

2. If you are using a network license file, check the second line of the key file and make sure the path to \texttt{snpslmd} exists and is correct.

   \texttt{VENDOR snpslmd scl_root/platform/bin/snpslmd}

   In this line, \textit{platform} is the operating system keyword (see Table 1-1 on page 1-4). Make sure there are no blank lines and no leading or trailing spaces in the license file.

3. For all types of license files, make sure that all System Studio users have read access to the key file.

   Set the file permission for the key file with the following command:

   \texttt{% chmod 644 \$CCSS KEYS/ccss/admin/license/CCSS.keys}

   Or, if you have defined the symbol \texttt{CCSS KEYS}, use this command:

   \texttt{% chmod 644 \$CCSS KEYS/ccss/admin/license/CCSS.keys}
% chmod 644 $CCSS_KEYS

Then use the following command to check that the read access is correct:

% ls -l $SYNOPSYS_CCSS/../../ccss/admin/license/CCSS.keys

You should see a report something like this:

-rw-r--r-- 1 thisuser group 4623 Apr 26 11:09 ccss.keys

---

**Insufficient Interprocess Communication (IPC) Semaphores**

When starting System Studio or DAVIS on Solaris 5.x platforms, if you see the following report,

```
sem_create->semget->IPC_CREATE: No space left on device
GMA failed
FATAL: Exec .../sparcOS5/ccss/bin/ccss_exec_ failed:status = 139
```

you need to increase the number of system semaphores. Add the following command to the `/etc/system` file (see the man page `system(4)` for details):

```
set semsys:seminfo_semmnu=0x100
```

After you change the `/etc/system` file, restart your system by using `boot -r`.

**Caution!**

Changing the `/etc/system` file incorrectly will prevent the system from starting.
This chapter describes how to install the TCAD products and utilities.

Note:
The installation instructions in this chapter are the most up-to-date available at the time of production. However, changes might have occurred. For the latest installation information, see the product release notes or documentation in SolvNet.

For TCAD product versions for this release, see Table 31-2 on page 31-3.

This chapter includes the following sections:

- Supported Platforms and Media Availability
- Disk Space and Memory Requirements
- Installing the Software
• Setting Up TCAD Products for Each User
• Running TCAD Products
• Using Graphics Devices
• Troubleshooting
• TCAD Utilities

To ensure a successful installation, have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).

### Supported Platforms and Media Availability

Table 31-1 lists the supported platforms, operating systems, and corresponding Synopsys platform keywords for this release. For detailed information, see “Supported Platforms and Operating Systems” on page 1-3.

**Table 31-1 Supported Platforms, Operating Systems, and Keywords**

<table>
<thead>
<tr>
<th>Platform</th>
<th>Operating system</th>
<th>Synopsys platform keyword</th>
<th>Window environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP PA-RISC 2.0</td>
<td>HP-UX 11.0, 11.11 (11i)(^1)</td>
<td>hp32 (32-bit mode) hp64 (64-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td>Sun SPARC</td>
<td>Solaris 8, 9(^1)</td>
<td>sparcOS5 (32-bit mode) sparc64 (64-bit mode)</td>
<td>CDE</td>
</tr>
<tr>
<td>IBM RS/6000</td>
<td>AIX 5.1</td>
<td>rs6000</td>
<td>CDE</td>
</tr>
<tr>
<td>IA-32 (x86)</td>
<td>Red Hat Linux 7.2</td>
<td>linux (32-bit mode)</td>
<td>GNOME</td>
</tr>
<tr>
<td>Itanium 2</td>
<td>Red Hat Enterprise Linux 2.11</td>
<td>linuxipf (64-bit mode)</td>
<td>GNOME</td>
</tr>
</tbody>
</table>
TCAD products are available on CD or by EST. Obtain the appropriate binary executable files for your operating system.

Table 31-2 lists the version W-2004.12, W-2004.09, V-2003.12, and V-2004.06 TCAD products and their supported platforms. For the latest product-specific platform information, see the release notes for your tool.

Table 31-2  TCAD Products and Supported Platforms

<table>
<thead>
<tr>
<th>Product</th>
<th>Version</th>
<th>Platform keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aurora</td>
<td>W-2004.12</td>
<td>sparcOS5, hp32, linux, rs6000</td>
</tr>
<tr>
<td>Raphael</td>
<td>V-2004.06</td>
<td>sparcOS5, sparc64, hp32, rs6000, linux</td>
</tr>
<tr>
<td>Raphael NES(^1)</td>
<td>U-2003.03</td>
<td>sparcOS5, hp32, rs6000</td>
</tr>
<tr>
<td>Taurus-Medici</td>
<td>W-2004.09</td>
<td>sparcOS5, sparc64, hp32, hp64, rs6000, linux, linuxipf, amd64</td>
</tr>
<tr>
<td>Taurus-TSuprem4</td>
<td>W-2004.09</td>
<td>sparcOS5, sparc64, hp32, hp64, rs6000, linux, linuxipf, amd64</td>
</tr>
<tr>
<td>Taurus Environment Modeling</td>
<td>W-2004.12</td>
<td>sparcOS5, hp32, rs6000, linux</td>
</tr>
</tbody>
</table>

1. This product might require a government-issued export license prior to sale to certain countries. Contact your sales representative for additional information.
The disk space requirements vary depending on the platform and the features selected for installation. Table 31-3 shows the maximum space required for installing TCAD products.

Table 31-3  TCAD Disk Requirements

<table>
<thead>
<tr>
<th>Product</th>
<th>Disk (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aurora</td>
<td>190</td>
</tr>
<tr>
<td>Raphael</td>
<td>125</td>
</tr>
<tr>
<td>Raphael-NES</td>
<td>75</td>
</tr>
<tr>
<td>Taurus-Medici</td>
<td>250</td>
</tr>
<tr>
<td>Taurus-Tsuprem4</td>
<td>125</td>
</tr>
<tr>
<td>Taurus Environment</td>
<td>355</td>
</tr>
<tr>
<td>Modeling</td>
<td></td>
</tr>
</tbody>
</table>

After the installation is completed, the directory tree shown in Table 31-4 exists as subdirectories of the TCAD directory.
Installing the Software

Beginning with the V-2004.06 release, the installation procedure for the TCAD products has changed. TCAD now uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install TCAD from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the TCAD software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. TCAD is installed in a similar manner.

Table 31-4  TCAD Subdirectories

<table>
<thead>
<tr>
<th>Subdirectory</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>bin/</td>
<td>Contains links to the TCAD executable files.</td>
</tr>
<tr>
<td>program_version/</td>
<td>Contains the TCAD product files and directories, including the install_program product installation script.</td>
</tr>
<tr>
<td>utility/</td>
<td>Contains various utilities for use with TCAD products. For a discussion of the contents of the utility directory, see the “TCAD utility Directory” on page 31-16.</td>
</tr>
<tr>
<td>license/</td>
<td>Contains the TCAD Network License Software and the license.dat license data file.</td>
</tr>
<tr>
<td>license_tma/</td>
<td>Contains the TCAD Network License Software for all supported platforms in compressed tar format.</td>
</tr>
</tbody>
</table>
The TCAD tools are stand-alone products and cannot be installed over an existing Synopsys product, including a prior version of TCAD. You must create a new directory for TCAD products.

Setting Up TCAD Products for Each User

To set up a new tool user, you must

- Check the search path
- Modify the search path
- Set the TMALIC or LM_LICENSE_FILE environment variable

Checking the Search Path

If a TCAD product has already been installed on your system, the TCAD bin directory might already exist in your search path. To determine whether it does, enter

```
% which program
```

where program is a TCAD executable file such as medici, raphael, or taurus.

If you get a response similar to

```
/usr/tcad/bin/program
```

your search path is set correctly.
Modifying Your Search Path

If the TCAD program is not found on the search path, it will need to be added. In the following examples, the TCAD directory on your system is named /usr/tcad.

- If you are using the C shell, add the following line to your $HOME/.profile:

  ```
  set path=(/usr/tcad/bin $path)
  ```

- If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile, .kshrc, or .bashrc file:

  ```
  PATH=/usr/tcad/bin:$PATH
  export PATH
  ```

Source the cshrc.meta file, or use a dot (.) with the kshrc.meta file (where . is a Bourne or Korn shell command).

Setting the TMALIC or LM_LICENSE_FILE Environment Variable

When you start a TCAD tool, the tool looks for a license in this order:

- The default location, *TCAD directory/license/license.dat*
- TMALIC
- LM_LICENSE_FILE

The TMALIC and LM_LICENSE_FILE environment variables point to the license server. For example,

```
setenv LM_LICENSE_FILE /path/to/license.dat
```
Note:
The TCAD license file uses the tmald daemon, which must be included on the VENDOR line of the license file. The path to the tmald daemon is `scl_root/platform/daemons/tmald`, where `scl_root` refers to the Synopsys Common Licensing (SCL) root directory.

Running TCAD Products

Table 31-5 lists the general format for most TCAD products. (For product availability for this release, see “Supported Platforms and Media Availability” on page 31-2.) If you install multiple versions of a product, the executable name is whatever you chose during installation. For most products, if you run them without specifying an input file, you are in interactive mode.

Table 31-5  Products and Keywords

<table>
<thead>
<tr>
<th>Product</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aurora</td>
<td>aurora input_filename</td>
<td>Runs Aurora with an input file.</td>
</tr>
<tr>
<td>Aurora</td>
<td>auroragui</td>
<td>Runs the Aurora GUI.</td>
</tr>
<tr>
<td>Davinci</td>
<td>davinci input_filename</td>
<td>Runs Davinci (30,000 nodes) with an input file.</td>
</tr>
<tr>
<td>Davinci</td>
<td>dv30k input_filename</td>
<td>Runs Davinci (30,000 nodes) with an input file.</td>
</tr>
<tr>
<td>Davinci</td>
<td>dv60k input_filename</td>
<td>Runs Davinci (60,000 nodes) with an input file.</td>
</tr>
<tr>
<td>Davinci</td>
<td>dv100k input_filename</td>
<td>Runs Davinci (100,000 nodes) with an input file.</td>
</tr>
<tr>
<td>Medici</td>
<td>medici input_filename</td>
<td>Runs Medici (10,000 nodes) with an input file.</td>
</tr>
<tr>
<td>Product</td>
<td>Format</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Medici</td>
<td>md3200 input_filename</td>
<td>Runs Medici (3,200 nodes) with an input file.</td>
</tr>
<tr>
<td>Medici</td>
<td>md10000 input_filename</td>
<td>Runs Medici (10,000 nodes) with an input file.</td>
</tr>
<tr>
<td>Medici</td>
<td>md20000 input_filename</td>
<td>Runs Medici (20,000 nodes) with an input file.</td>
</tr>
<tr>
<td>Medici</td>
<td>md60000 input_filename</td>
<td>Runs Medici (60,000 nodes) with an input file.</td>
</tr>
<tr>
<td>Raphael</td>
<td>raphael_program input_filename</td>
<td>Runs Raphael with an input file.</td>
</tr>
<tr>
<td>Raphael</td>
<td>dplot input_filename</td>
<td>Runs Dplot with an input file.</td>
</tr>
<tr>
<td>Taurus-Device</td>
<td>tdevice input_filename</td>
<td>Runs Taurus Device with an input file.</td>
</tr>
<tr>
<td>Taurus-Layout</td>
<td>tlayout input_filename</td>
<td>Runs Taurus-Layout with an input file.</td>
</tr>
<tr>
<td>Taurus-Process</td>
<td>tprocess input_filename</td>
<td>Runs Taurus Process with an input file.</td>
</tr>
<tr>
<td>Taurus-Visual</td>
<td>tv</td>
<td>Runs Taurus-Visual.</td>
</tr>
<tr>
<td>Taurus-WorkBench</td>
<td>twb</td>
<td>Runs Taurus-WorkBench.</td>
</tr>
<tr>
<td>TSUPREM-4</td>
<td>tsuprem4 input_filename</td>
<td>Runs TSUPREM-4 with an input file.</td>
</tr>
</tbody>
</table>
Using Graphics Devices

This section discusses how graphics devices are described to TCAD products and how they are specified with parameters of program statements.

Graphics Device Hierarchy

With TSUPREM-4, the graphics device used is determined as follows:

- If a graphics device is specified in the input file with the DEVICE parameter on the OPTION statement, TSUPREM-4 uses that device.
- Otherwise, if the DEFPDEV environment variable is defined, TSUPREM-4 uses its value as the graphics device.
- Otherwise, if the TERM environment variable is defined, TSUPREM-4 uses its value as the graphics device.
- Otherwise, TSUPREM-4 uses the default device specified in the s4pcap file, which is initially set to ps for Postscript. The s4pcap file contains a description of each device known to the program. You can modify the file to make the default device refer to any available real plotting device. The default device specified in the s4pcap file is used if neither DEFPDEV nor TERM is defined.

With the other simulators, the graphics device used is determined as follows:

- If a graphics device is specified in the input file with the DEVICE parameter on the PLOT statement, that device is used.
• Otherwise, if the DEFPDEV environment variable is defined, its value is used as the graphics device.

• Otherwise, the default graphics device is used. The default graphics device is defined by the first line in the prpdev file that contains an asterisk (*) as the first nonblank character. The prpdev file is located in your TCAD directory in

\textit{program\_version/platform}.

\textbf{Note:}

The \textit{pr} notation in \textit{prpdev} refers to the product code (md, dv, and so on) that you are using. See Table 31-5 on page 31-8.

\textbf{Specifying a Graphics Device}

With TSUPREM-4, you can specify the graphics device in the input file with the \texttt{DEVICE} parameter on the \texttt{OPTION} statement. For example, the following statement sets the graphics device to X:

\begin{verbatim}
OPTION DEVICE=X
\end{verbatim}

If you do not specify a graphics device in the input file, the DEFPDEV environment variable is used if it is set. You can set DEFPDEV to specify the graphics device by entering the following command:

\begin{verbatim}
% setenv DEFPDEV graphics_device
\end{verbatim}

If you are using the Bourne or Korn shell, you can use DEFPDEV to specify a graphics device by entering the following command:

\begin{verbatim}
$ DEFPDEV=graphics_device
    export DEFPDEV
\end{verbatim}

If you are using the C shell, you can set DEFPDEV so that the X graphics device is used by entering the following command:
% setenv DEFPDEV x

Note:

The graphics device must be entered in lowercase letters.

By setting the value of the DEFPDEV environment variable, you can set the graphics device to any device you want to use without disrupting work in progress by other TCAD software users.

With TSUPREM-4, if neither OPTION nor DEFPDEV is specified, TSUPREM-4 checks the TERM environment variable. TSUPREM-4 looks for the graphics device specified by TERM in the s4pcap file. If the graphics device is not found, and neither OPTION nor DEFPDEV is specified, TSUPREM-4 prints the following messages:

** Plot device vt100 not found in s4pcap file.
** Plotting to default device in s4pcap file.

In the first message, vt100 is the name of the device to which TERM is set.

With TSUPREM-4, if OPTION is not used and neither DEFPDEV nor TERM is set, TSUPREM-4 uses the default graphics device set in the s4pcap file. By default, the graphics device is set to ps in the s4pcap file.

With most other simulators, you can specify the graphics device in the input file with the DEVICE parameter on the PLOT statement. For example, the following statement sets the graphics device to X:

PLOT.2D TITLE="EXAMPLE" DEVICE=X
With the other TCAD simulators, if the PLOT statement does not specify a graphics device and DEFPDEV is not set, the simulator uses the default graphics device. The default graphics device is defined by the first line in the prpdev file that contains an asterisk (*) as the first nonblank character. (The prpdev file is located in your TCAD directory in program_version/library.)

For example, if you want to change the default graphics device from Sun to X, edit the prpdev file and move the asterisk (*) from the Sun entry to the X entry.

Before modification:

*SUN  29 20.32 15.24 33.0 33.0 -1 F F FTFF 9999
I/SUN 29 20.32 15.24 33.0 33.0 -1 F F FTFT 9999
X     30 20.32 15.24 500.0 500.0 -1 F F FTFF 9999

After modification:

SUN   29 20.32 15.24 33.0 33.0 -1 F F FTFF 9999
I/SUN 29 20.32 15.24 33.0 33.0 -1 F F FTFT 9999
*X    30 20.32 15.24 500.0 500.0 -1 F F FTFF 9999

For further information on the prpdev file and possible graphics devices, see the manual for the TCAD product you are installing.

---

**Sun, X, and tmaplot**

Both Sun and X drivers use the tmaplot graphics utility to generate graphics by piping graphics output through the tmaplotx executable program. The tmaplot utility automatically remembers up to 200 plots and allows you to scroll through them.

Use the following means to control the display:
• Right mouse button: Scroll backward
• Left mouse button: Scroll forward
• Control-c: Kill tmaplot display

To use X graphics, you must set the DISPLAY environment variable to your display machine. Usually, DISPLAY is set to the name of your computer followed by :0.0. For example, if the name of your machine is *mymachine*, enter the following command to set DISPLAY:

```shell
% setenv DISPLAY mymachine:0.0
```

Note:
To Sun users—You must also set the LD_LIBRARY_PATH environment variable to your OpenWindows library directory. For example,

```shell
% setenv LD_LIBRARY_PATH /usr/openwin/ \lib:$LD_LIBRARY_PATH
```

---

**Troubleshooting**

**Error Message:**

Xlib:  connection to "machine:0.0" refused by server
Xlib:  Client is not authorized to connect to Server
Bad return from XOpenDisplay

**Explanation:**
The program does not have permission to open a window on the display.

- Check to be sure the DISPLAY environment variable is set correctly.
- If the DISPLAY environment variable is set correctly on the console of the display, enter the following command:

  \% xhost +

Error Message:

tmafork: command not found

Explanation:

The tmafork TCAD utility cannot be found.

- Check to be sure the TCAD bin directory is in the search path.
- Check to be sure the TCAD utilities are installed correctly and that tmafork is linked to the TCAD bin directory.

Error Message:

*** Open Pipe = signal 13 code 0

Explanation:

The TCADPLOT process is terminating abnormally, leaving the TCAD program piping data to a broken pipe.

- Check to be sure TCADPLOT works correctly outside the TCAD program by entering the following command:

  \% tmaplot x test
• If TCADPLOT works correctly outside the TCAD program, the error is most likely caused by insufficient system resources to start the TCADPLOT process. Check your system resources when running the TCAD program to be sure there are enough resources to run the TCADPLOT process.

Error Message:

window: Base frame not passed parent window in environment
Cannot create base frame. Process aborted.

Explanation:

You are attempting to run a SunView application when you are not running in the SunView window environment. This error can occur during STUDIO if your path is not set correctly.

• If you are running OpenWindows, be sure the OpenWindows bin directory precedes the /bin and /usr/bin directories.

---

**TCAD Utilities**

The TCAD utilities are a set of programs designed to help you use TCAD products more effectively. TCAD utilities are installed automatically as part of a TCAD product installation.

---

**TCAD utility Directory**

The utility directory for all new releases of TCAD products (after June 1991) is product independent. The utility directory contains a file named V#. (# is a number). V#. is the version number of the utility in that directory.
Table 31-6 lists the utilities that TCAD provides.

Table 31-6  TCAD Utilities

<table>
<thead>
<tr>
<th>Utility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tmaplot</td>
<td>Generates Sun (SunView) and X graphics. For products released after June 1991, you must use tmaplot if you use Sun or X graphics.</td>
</tr>
<tr>
<td>tmafork</td>
<td>Allows systems that do not have a vfork system call to run a TCAD product without temporarily doubling the virtual memory required.</td>
</tr>
<tr>
<td>replot</td>
<td>Allows you to re-create TCAD graphical output without rerunning a simulation.</td>
</tr>
<tr>
<td>rfbtoa</td>
<td>Takes a TCAD binary output file, such as a structure file, and converts it to ASCII format.</td>
</tr>
<tr>
<td>tfatob</td>
<td>Takes a TCAD formatted (ASCII) file and converts it to binary format.</td>
</tr>
</tbody>
</table>

The tfatob and tfatob utilities are useful if you have TCAD products on multiple machine types. A binary file can be transferred between machines by converting it to ASCII on one machine and then transferring it to the second machine. Then it can be converted back to binary on the second machine.

Following is the directory structure of the utility directory, as it exists in a standard installed TCAD directory tree. The directories are shown with a trailing slash.

```
TCAD directory/bin/TCAD product/utility/
V#.#
install_utility
   replot/
       replot
       replotx
       rppdev
       rperro
```
Note:
The TCAD utilities do not require licenses. You can use them on any machine under the direct control of your organization. However, you are not allowed to copy or distribute the TCAD utilities elsewhere.

Executing the TCAD Utilities

To execute the TCAD utilities, you must include the tcad/bin directory in your search paths, as described in “Setting Up TCAD Products for Each User” on page 31-6.

If you install updates to the TCAD utilities in the future, the installation script creates links from the new version of the TCAD utilities to the tcad/bin directory. Therefore once the search path has been modified to include tcad/bin, it is already set up for updates.
This chapter describes how to install the TetraMAX product.

This chapter contains the following sections:

- Installing TetraMAX
- Setting Up the User Environment
- Verifying the TetraMAX Installation

If you are installing TetraMAX stand-alone, to ensure a successful installation complete the following procedures before beginning the installation process:

- Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).
- Define the SYNOPTSYS environment (see “Defining the SYNOPTSYS Environment Variable” on page 1-20).
• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).

---

**Installing TetraMAX**

This section describes Synopsys license key requirements and the two types of installation for TetraMAX ATPG and TetraMAX IddQTest, version W-2004.12:

• Stand-alone
  
  Install TetraMAX stand-alone in its own directory.

• Overlay
  
  Install TetraMAX overlay in the same directory as the W-2004.12 synthesis tools.

**Note:**

If you are going to install TetraMAX IddQTEST, you must install it first (see “Optional Installation of IddQTest” on page 32-6), then install TetraMAX ATPG as an overlay to the synthesis tools.
License Key Requirements

TetraMAX version W-2004.12 uses the Synopsys Common Licensing (SCL) system. For information on installing SCL, see “Acquiring a License” on page 1-16.

Note:
Optional features such as Diagnosis, IddQTest, PatternMap, and transition delay fault ATPG each require a separate license. For specific information on the licenses required for TetraMAX options, install the product and see online Help topic “Understanding TetraMAX License Usage.”

64-Bit Mode on HP-UX and Solaris Platforms

In 64-bit mode, TetraMAX supports both the shell and GUI on HP-UX and Solaris platforms.

To invoke TetraMAX ATPG in 64-bit mode, use the -64 switch.

% tmax -64 [other options]

An alternative method is to set the TMAX_64BIT environment to true (or to any string other than null).

% setenv TMAX_64BIT true
% tmax [other options]

Stand-Alone Installation

TetraMAX uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.
TetraMAX stand-alone is a complete installation of all TetraMAX applications. It must be installed in its own directory and not over an existing synthesis release.

To perform stand-alone installation,

1. Download and install TetraMAX from the Web or by EST, as described in “Downloading the Software” on page 2-2.

   Or

   Install the files from the TetraMAX CD to your system, as explained in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. TetraMAX is installed in a similar manner.

   Note:
   When you are prompted to select the product you want to install, enter **txs** to perform a stand-alone installation.

2. Make sure that your licensing software is installed. For information on SCL software, see “Acquiring a License” on page 1-16.

---

**Overlay Installation**

TetraMAX uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

Install TetraMAX version W-2004.12 over version W-2004.12 of the synthesis tools only. (Do not install it over any other versions of the synthesis tools.)
You perform overlay installation in the directory in which you installed the Synopsys synthesis tools ($SYNOPSYS). You must log on as the same user who installed the Synopsys synthesis tools so that you have write permission in the $SYNOPSYS directory.

Note:
If you have not installed the Synopsys synthesis tools, install them before proceeding with overlay installation (see Chapter 29, “). If you do not have the synthesis tools installed, the installation of TetraMAX overlay will not be allowed.

To perform overlay installation,

1. To download and install TetraMAX from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

Or

Install the files from the TetraMAX CD to your system, as explained in “Installing Product Files From a CD” on page 2-22. Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. TetraMAX is installed in a similar manner.

Note:
When you are prompted to select the product you want to install, enter tx to perform an overlay installation.

2. Make sure your Synopsys license server and license key file are set up to work with the synthesis tools. If you encounter problems, see the SCL documentation, Common Licensing Quick Start Guide and Common Licensing Installation and Administration Guide.
Optional Installation of IddQTest

You must install the IddQTest option before you install TetraMAX ATPG. IddQTest requires a separate license.

To install IddQTest,

1. Download and install IddQTest from the Web or by FTP. (See “Downloading the Software” on page 2-2.)

   or

   Install the files from the TetraMAX CD to your system. (See “Installing Product Files From a CD” on page 2-22.) Example 2-1 on page 2-24 shows a Synopsys media installation script for the synthesis tools. IddQTest is installed in a similar manner.

   Note:
   When you are prompted to select the product you want to install, enter idq to perform the installation.

2. Make sure that your licensing software is installed. For information on SCL software, see “Acquiring a License” on page 1-16.

3. Install TetraMAX ATPG as an overlay to the synthesis tools. See “Overlay Installation” on page 32-4.

Setting Up the User Environment

The procedure for setting up a new TetraMAX user has changed. When you define the TetraMAX root directory, you can now use the $SYNOPSIS environment.
Note:
For backward compatibility, you can still set $SYNOPSYS_TMAX. If $SYNOPSYS_TMAX is set, it will override $SYNOPSYS.

To set up a new TetraMAX tool user, add the TetraMAX directory containing the executable file to the PATH environment.

If you are using the C shell, add the following line to the .cshrc file:

```
set path=($SYNOPSYS/bin $path)
```

If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile or .kshrc file:

```
PATH=$SYNOPSYS/bin:$PATH
export PATH
```

To set up the user environment by using an alias, perform one of the following procedures. Note that these examples are for the C shell. Setups in other shells will differ.

- To set up the user environment by using an alias, enter
  
  ```
  % alias tmax '\$SYNOPSYS/bin/tmax \!*'
  ```

- To set up the user environment by using a path, enter
  
  ```
  % set path=($SYNOPSYS/bin $path)
  ```

- To set up the user environment for using SoCBIST, enter
  
  ```
  % set path=($SYNOPSYS/bin $SYNOPSYS/platform/bin $path)
  ```

Replace platform with the required platform.
Note:

If you used $SYNOPSYS_TMAX to define the TetraMAX root directory, set the user environment for SOCBIST as follows:

```
% set path=($SYNOPSYS_TMAX/bin $SYNOPSYS/platform/bin $path)
```

---

**Verifying the TetraMAX Installation**

To verify installation of the TetraMAX tools,

1. Make sure you are in a directory where you have read/write privileges.

   ```
   % cd $HOME
   ```

2. Invoke the TetraMAX GUI by entering the following command on a licensed machine:

   ```
   % tmax
   ```

   If the GUI appears, the installation was successful.
This chapter describes how to install the TimeMill product.

This chapter contains the following sections:

• Installing the Software
• Setting Up TimeMill for Each User
• Verifying the TimeMill Installation

To ensure a successful installation, complete the following procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys Root Directory” on page 1-19).
• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
Installing the Software

Beginning with the V-2004.06 release, TimeMill uses the Synopsys Installer tool, which allows you to use a graphical user interface (GUI) or a text script. For information about the Synopsys Installer, see “About the Synopsys Installer Software” on page 2-2.

To download and install TimeMill from the Web or by EST, follow the procedures described in “Downloading the Software” on page 2-2.

To install the TimeMill software from the CD, follow the installation procedure described in “Installing Product Files From a CD” on page 2-22. Example 2-2 on page 2-27 shows a Synopsys media installation script for PrimeTime. TimeMill is installed in a similar manner. The TimeMill subtools (ADFMI, TurboWave, and VTRAN) are automatically installed with the TimeMill installation.

TimeMill can be installed as a stand-alone installation or with any of the tools (NanoSim and PowerMill) it comes packaged with.

Setting Up TimeMill for Each User

To set up a new TimeMill tool user,

• If you are using the C shell, source the CSHRC_platform file located in the install directory.

    % cd install_dir  
    % source CSHRC_platform

The installation script for TimeMill creates a CSHRC_platform file for each platform installed. The term platform is replaced with the platform you installed.
The CSHRC_platform file sets the path for Nanosim and the NanoSim man pages.

```
set path=(install_directory/platform/ns/bin $path)
setenv MANPATH install_directory/doc/ns/man:$MANPATH
```

where `install_directory` is the directory where the tool has been installed.

If you don’t source the CSHRC_platform file, copy the preceding line and set the path from that file.

- If you are using the Bourne, Korn, or Bash shell, add the following lines to the .profile, .kshrc, or .bashrc file:

```
PATH=install_directory/platform/ns/bin:$PATH
export PATH

MANPATH=install_directory/doc/ns/man:$MANPATH
export MANPATH
```

Replace `platform` with the appropriate platform (see “Products and Supported Platforms” on page 1-6).

---

### Verifying the TimeMill Installation

To verify the TimeMill installation,

1. Make sure you are in a directory where you have read/write privileges:
   ```
   % cd $HOME
   ```

2. Invoke the tool by entering
   ```
   % timemill
   ```
If you see information about the product version, production date, and copyright, the installation was successful.
This chapter describes how to install the VCS product.

This chapter contains the following sections:

• Installing the Software
• Setting the Environment Variables
• Verifying the VCS Installation
• Customer Support

The instructions in this chapter also apply to VCSi.

To ensure a successful installation, complete the following procedure before beginning the installation process:

• Have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
Note:
The VirSim GUI installs with VCS. If you want to install the GUI as a stand-alone tool, see Appendix B, “VirSim (version 4.4).”

Installing the Software

VCS is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of VCS. You must create a new directory for VCS.

To download and install VCS by electronic software transfer,

1. Create a VCS installation directory and change to that directory.
   For example, enter
   
   ```bash
   mkdir /u/edatools
   cd /u/edatools
   ```

2. Download the software to the installation directory.

3. Uncompress and untar the files.

   ```bash
   gzip -dc /u/edatools/vcs_platform_version.tar.gz \  
   | tar xvf -
   ```

   This command creates a VCS subdirectory named after the release of VCS that you are installing.

To install VCS from a CD,

1. Create a VCS installation directory and change to that directory.
   For example,

   ```bash
   mkdir /u/edatools/vcs
   cd /u/edatools/vcs
   ```
2. Mount the CD by using the appropriate command for your operating system. For example, enter

\`
mount -o ro /dev/dsk/c2t1d4s0 /cdrom
\`

Note:
Mounting instructions are different for each platform. See your system documentation for the correct CD mounting commands.

Also, for Sun SPARC with vold (the volume management daemon for managing CD and floppy devices), the /cdrom directory already exists and the CD is automatically mounted. Therefore, use cd /cdrom/cdrom0 instead of cd /cdrom (and use `eject` to unmount the CD).

3. Uncompress and untar the files.

\`
gzip -dc /cdrom/vcs_platform_version.tar.gz  \\
| tar xvf -
\`

This command creates a VCS subdirectory named after the release of VCS that you are installing.

4. Unmount the CD by using the appropriate command for your operating system. For example, enter

\`
umount /cdrom
\`

Note:
If you are running the volume management daemon, use the `eject` command to unmount the CD.
Setting the Environment Variables

This section discusses the following environment variables:

- **VCS_HOME**
- **SNPSLMD_LICENSE_FILE**
- **LM_LICENSE_FILE**

It is recommended that you place these variables in your $HOME/.cshrc or $HOME/.profile file as your default settings.

---

Setting the $VCS_HOME Environment Variable

Follow these steps.

1. Set the $VCS_HOME environment variable to point to your VCS installation subdirectory.
   - If you are using the C shell, add the following line:
     ```
     % setenv VCS_HOME /u/edatools/vcs7.2
     ```
   - If you are using the Bourne shell, add these lines:
     ```
     % VCS_HOME=/u/edatools/vcs7.2
     export VCS_HOME
     ```

2. Add $VCS_HOME/bin to your search path:
   - If you are using the C shell, enter
     ```
     set path=($VCS_HOME/bin $path)
     ```
   - If you are using the Bourne shell, enter
     ```
     PATH=$VCS_HOME/bin:$PATH
     export PATH
     ```
3. (Optional) To include the optional utilities shipped with VCS in the path,

- If you are using the C shell, enter

```bash
set path = ($VCS_HOME/bin \
 $VCS_HOME/`$VCS_HOME/bin/vcs -platform`/bin \
 $VCS_HOME/`$VCS_HOME/bin/vcs -platform`/util \
 $path)
```

- If you are using the Bourne shell, enter

```bash
PATH=$VCS_HOME/bin \
 $VCS_HOME/`$VCS_HOME/bin/vcs -platform`/bin \
 $VCS_HOME/`$VCS_HOME/bin/vcs -platform`/util \
 $PATH
export PATH
```

Setting the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE Environment Variable

To enable VCS to check out a license, you must set the SNPSLMD_LICENSE_FILE or the LM_LICENSE_FILE environment variable.

- If you are using the C shell, enter the following line:

  ```bash
  % setenv SNPSLMD_LICENSE_FILE port@hostname
  ```

- If you are using the Bourne shell, enter these lines:

  ```bash
  % SNPSLMD_LICENSE_FILE=port@hostname
  export SNPSLMD_LICENSE_FILE
  ```
The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use \textit{port@host} name rather than using the path to the license file.

Each license file can contain licenses for many packages from multiple vendors. You can specify multiple license files by separating each entry with a colon (\texttt{:}).

\section*{Verifying the VCS Installation}

To verify the VCS installation,

1. Make sure you are in a directory where you have read/write privileges.
   \begin{verbatim}
   % cd $HOME
   \end{verbatim}

2. Invoke the tool by entering
   \begin{verbatim}
   % vcs -ID
   \end{verbatim}
   If you see information about the product version, production date, and copyright, the installation was successful.

3. Run the VirSim GUI on each installed platform by entering
   \begin{verbatim}
   % vcs -RPP
   \end{verbatim}

4. Exit the GUI by choosing File > Exit in any GUI window.
Customer Support

The VCS support page on the Synopsys Web site is regularly updated with the latest information. Check this page for application notes, online help updates, and other valuable information:


You can also send an e-mail message to VCS Support at vcs_support@synopsys.com.
This chapter contains instructions about installing the VCS MX (VHDL Simulation (Scirocco) and Verilog Simulation (VCS)) tool.

This chapter contains the following sections:

- Installing the Software
- Setting the Environment Variables
- Verifying the VCS MX Installation

The instructions in this chapter also apply to VCS MXi.

To ensure a successful installation, have your license server running and have the appropriate license keys installed (see “Acquiring a License” on page 1-16).
Note:
The VirSim GUI installs with VCS MX. If you want to install the GUI as a stand-alone tool, see Appendix B, “VirSim (version 4.4).”

Installing the Software

VCS MX is a stand-alone product and cannot be installed over an existing Synopsys product, including a prior version of VCS MX. You must create a new directory for VCS MX.

Note:
The installation procedure for VCS MX has changed with this release.

To download and install VCS MX by electronic software transfer,

1. Create a VCS MX installation directory and change to that directory. For example, enter

   % mkdir /u/edatools
   % cd /u/edatools

2. Download the software to the installation directory.

3. Uncompress and untar the files.

   % gzip -dc /u/edatools/vcs_mx/ \vcs_mx_platform_version.tar.gz | tar xvf -

   This command creates a VCS MX subdirectory named after the release of VCS MX that you are installing.
To install VCS MX from a CD,

1. Create a VCS MX installation directory and change to that directory. For example,

   % mkdir /u/edatools/vcs_mx
   % cd /u/edatools/vcs_mx

2. Mount the CD by using the appropriate command for your operating system. For example, enter

   % mount -o ro /dev/dsk/c2t1d4s0 /cdrom

   Note:
   Mounting instructions are different for each platform. See your system documentation for the correct CD mounting commands.
   Also, for sparcOS5 with vold (the volume management daemon for managing CD and floppy devices), the /cdrom directory already exists and the CD is automatically mounted. Therefore, use cd /cdrom/cdrom0 instead of cd /cdrom.

3. Uncompress and untar the files.

   % gzip -dc /cdrom/vcs_mx/vcs_mx_platform_version.tar.gz | tar xvf -

   This command creates a VCS MX subdirectory named after the release of VCS MX that you are installing.

4. Unmount the CD by using the appropriate command for your operating system. For example, enter

   % umount /cdrom

   Note:
   If you are running the volume management daemon, use the eject command to unmount the CD.
Setting the Environment Variables

This section discusses the following environment variables:

- **VCS_HOME**
- **SNPSLMD_LICENSE_FILE**
- **LM_LICENSE_FILE**

It is recommended that you place these variables in your $HOME/.cshrc or $HOME/.profile file as your default settings.

Setting the VCS_HOME Environment Variable

Follow these steps.

1. Set the `VCS_HOME` environment variable in the shell that you are using in which the `root_directory` argument is the name of the VCS MX root directory.
   - If you are using the C shell, enter
     
     `setenv VCS_HOME /vcs_mx/build/vcs_mx/vcs_mx7.2`
   
   - If you are using the Bourne shell, enter
     
     `% VCS_HOME=/vcs_mx/build/vcs_mx/vcs_mx7.2 export VCS_HOME`

2. Add the directory containing the VCS MX executable files to the `PATH` environment variable.
   - If you are using the C shell, add the following line to the .cshrc file:
     
     `set path=($VCS_HOME/bin $path)`
- If you are using the Bourne, Korn, or Bash shell, add the following line to the .profile or .kshrc file:

```
PATH=(path:$VCS_HOME/bin)
export PATH
```

## Setting the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE Environment Variable

To enable VCS MX to check out a license, you must set the SNPSLMD_LICENSE_FILE or the LM_LICENSE_FILE environment variable.

- If you are using the C shell, enter the following line:

  ```
  % setenv SNPSLMD_LICENSE_FILE port@hostname
  ```

- If you are using the Bourne shell, enter these lines:

  ```
  % SNPSLMD_LICENSE_FILE=port@hostname
  export SNPSLMD_LICENSE_FILE
  ```

The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use `port@host` name rather than using the path to the license file.

Each license file can contain licenses for many packages from multiple vendors. You can specify multiple license files by separating each entry with a colon (`:`).
Verifying the VCS MX Installation

To verify the VCS MX installation, enter

```plaintext
% vcs -ID
```

If you see information about the product version, production date, and copyright, the installation was successful.
This chapter describes how to install the Vera product.

This chapter contains the following sections:

- Downloading and Installing the Software
- Setting the Environment Variables
- Customer Support
Downloading and Installing the Software

To download and install the software,

1. Create a Vera installation directory. For example,

   % mkdir -p /usr/synopsys/vera

2. Download the Vera release to the installation directory.

   The latest Vera download instructions can be obtained from the SolvNet Release Library or from vera-support@synopsys.com.
   
   If a Vera directory does not already exist, you must create one.

3. Uncompress and untar the files.

   % pwd /usr/synopsys/vera
   % gzip -dc vera-version-platform.tar.gz | tar xvf -

   This will create a subdirectory in the Vera installation directory. For example,

   /usr/synopsys/vera/vera-version-platform

   In the remainder of this chapter, this subdirectory is referred to as the Vera installation directory.

4. To set the file permissions on the new directory tree and its contents, enter

   % chmod -R 755 /usr/synopsys/vera

5. Remove the vera-version-platform.tar.gz file.

   % rm vera-version-platform.tar.gz
6. For each user, set the required environment variables. See “Setting the Environment Variables,” next.

---

Setting the Environment Variables

This section discusses the following environment variables:

- VERA_HOME
- SNPSLMD_LICENSE_FILE
- LM_LICENSE_FILE

It is recommended that you place these variables in your $HOME/.cshrc or $HOME/.profile file as your default settings.

---

Setting the VERA_HOME Environment Variable

1. Set the $VERA_HOME environment variable to point to your Vera installation directory.

   - If you are using the C shell, add the following line:

     ```
     setenv VERA_HOME install_directory
     ```

   - If you are using the Bourne shell, enter these lines:

     ```
     VERA_HOME=install_directory
     export VERA_HOME
     ```

2. Add $VERA_HOME/bin to your search path.

   - If you are using the C shell, enter

     ```
     set path=($VERA_HOME/bin $path)
     ```

   - If you are using the Bourne shell, enter
Setting the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE Environment Variable

1. To enable Vera to check out a license, set the SNPSLMD_LICENSE_FILE or the LM_LICENSE_FILE environment variable.
   - If you are using the C shell, add the following line:
     ```bash
     setenv SNPSLMD_LICENSE_FILE port@hostname
     ```
   - If you are using the Bourne shell, enter these lines:
     ```bash
     SNPSLMD_LICENSE_FILE=port@hostname
     export SNPSLMD_LICENSE_FILE
     ```

     The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use `port@host` name rather than using the path to the license file.

2. Each license file can contain licenses for many packages from multiple vendors. You can specify multiple license files by separating each entry with a colon (`:`).

Customer Support

You can get support for Vera from the following locations:

- For technical issues, enhancement requests, and feedback, contact Customer Support at vera-support@synopsys.com.
• For documentation Issues, send e-mail to vera-doc@synopsys.com.

For general information on Synopsys licensing, see http://solvnet.synopsys.com/keys.

For information on Vera licensing, see

• The Vera Installation Guide, which is packaged in Portable Document Format (PDF) with the product files

• SolvNet article 900006, “VERA Licensing Structure,” at http://solvnet.synopsys.com/retrieve/900006
Troubleshooting

This appendix contains the following sections:

- Memory
- X Window System
Memory

Some common memory problems and possible solutions are described in this section.

Why Do I Get an “out of memory” Message?

Here is a possible scenario: A large job is running on a machine that has abundant swap space. You try to run a Design Compiler job on this machine and assume that you don’t need to be concerned about running out of swap space. But the application terminates with a fatal out-of-memory message before the machine runs out of swap space.

UNIX limits the amount of memory a job or process can consume while it is running. If a job reaches these limits before the system runs out of swap space, the job terminates with the fatal out-of-memory error message. These limits are built into the UNIX OS to prevent a single job or process from consuming all system resources (swap space, CPU time, number of processes, and so on), thereby depleting resources for other jobs. Some limits applicable to Synopsys applications are

- Data size—The maximum data size (including stack) for the process
- CPU time—The maximum CPU seconds per process
- Core dump size—The maximum size of a core dump

The data-size limit is the most important. It can be set at two levels:

- The system level
Limits are enforced for everyone who runs on that system.

- On a per-user basis

On all machines except those running HP-UX, you can change your personal limits by using the `limit` command (C shell) or `ulimit -s -d` command (Bourne, Korn, or Bash shell). On the HP-UX platform, only the system administrator can set the limits. Personal limits cannot exceed the systemwide limit. For example, the limits on a Sun client (Solaris 8) might look like this:

```
% limit
  cputime          unlimited
  filesize         unlimited
  datasize         524280 kbytes
  stacksize        8192 kbytes
  coredumpsize     unlimited
  descriptors      256
  memorysize       unlimited
```

Note:
In this example, any jobs or processes started on the Sun client can grow to 524 MB before limits are enforced.

On some solaris systems, setting the data size to `unlimited` defaults to a data size of only 2 GB. To set a larger data size, set the data size explicitly. For example, set it to 3.8 GB by using the following command:

```
% limit datasize 3891 MB
```

If the data size is sufficient, check the stack size. A stack size that is larger than the default (8,192 KB) can cause the data size to be smaller than required. Because the stack size is taken at the beginning of the process, it uses memory that would normally be available for data. Therefore you should set the stack size higher than the default only when absolutely necessary.
Most system administrators do not adjust the limits unless they are confronted with problems. If you do not adjust the limits, it is possible for a tool requiring a lot of swap space (such as Design Compiler) to experience an out-of-memory problem.

Note, however, that it is possible to extend memory (physical and swap space). For more information, see “Accessing Memory Beyond 2 GB With 32-Bit Synopsys Tools” on page 1-14.

What Should I Do When an “out of memory” Error Occurs?

Make sure that you are not running out of swap space on the system. Use the `swap -l` command for Sun SPARC systems to obtain swap space information. For example,

```
% swap -l
swapfile       dev   swaplo  blocks   free
/dev/dsk/c0t3d0s1  32,25      8  822520   628872
```

To determine available swap space on systems other than Sun SPARC, contact your system administrator.

If you have enough swap space but still encounter OS limits, use the `limit` command to find out what the `datasize` variable is set to (for all machines except HP). The `limit` command displays user-level limits.

```
% limit
  cputime          unlimited
  filesize         unlimited
  datasize         524280 kbytes
  stacksize        8192 kbytes
  coredumpsize     unlimited
  descriptors      256
  memorysize       unlimited
```
If your user-level data-size limit is too low, you can increase it by entering `limit datasize xxxx m` at the UNIX prompt, where `xxxx` is the number of megabytes and `m` stands for megabytes. For example,

```bash
% limit datasize 3891m
```

Note:

The `limit` command is a built-in C shell (csh) command. Make sure you are in csh before you execute `limit`.

For additional information about the `limit` command, see the appropriate man page. On HP systems you cannot change the user-level limits. User-level limits can be changed only at the system level.

The procedure for making limit changes varies from platform to platform. The system administrator at each site should be familiar with the procedure. If you still encounter problems, contact your ncuSynopsys technical representative.

---

**X Window System**

Some common X Window System problems and possible solutions are the following:

- If you cannot use the vi text editor in the xterm window, add an xterm entry in your `/etc/termcap` file.
• If, after an upgrade, you can no longer open Design Analyzer from your host, verify that the fonts assigned in .synopsys_dc.setup or the server default fonts are loaded. A fatal error results if the fonts are not available.

• Your ~/.xinitrc script might not be read on startup because it is a C shell script. In this case, you must rewrite it as a Bourne (/bin/sh) script.
VirSim (version 4.4)

This appendix gives instructions for installing the stand-alone VirSim GUI.

This appendix contains the following sections:

- Installing the Software
- Setting Up VirSim for Each User
- Setting the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE Environment Variable
- Verifying the VirSim Installation
- Customer Support
Important:
The stand-alone installation instructions in this chapter apply only to customers who do not have the VCS or VCS MX tools. VirSim installs automatically with those tools.

Installing the Software

To download and install VirSim from the Web or by EST, e-mail vcs_support@synopsys.com.

Table B-1 shows the supported platforms and keywords.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Platform keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solaris 7, 8</td>
<td>sparcOS5 (32-bit platform)</td>
</tr>
<tr>
<td></td>
<td>sparc64 (64-bit platform)</td>
</tr>
<tr>
<td>HP-UX 11.0, 11i</td>
<td>hp32</td>
</tr>
<tr>
<td></td>
<td>hp64</td>
</tr>
<tr>
<td>Red Hat Linux 7.2</td>
<td>linux for Intel (2.4 kernel)</td>
</tr>
</tbody>
</table>

To download and install VirSim,

1. Create a VirSim installation directory and change to that directory. For example,

   % mkdir virsim_install_dir
   % cd virsim_install_dir

2. Download the software to the installation directory.

3. Uncompress and untar the files:

   % gzip -dc virsim_platform_version.tar.gz | tar xvf -
Setting Up VirSim for Each User

To set up a new VirSim tool user, add the VirSim directory containing the executable file to the PATH environment variable.

1. Set the VIRSIMHOME environment variable to point to the installation directory. For example,

   If you are using the C shell, enter
   
   ```
   % setenv VIRSIMHOME virsim_install_dir
   ```

   If you are using the Bourne, Korn, or Bash shell, enter
   
   ```
   % VIRSIMHOME=virsim_install_dir
   export VIRSIMHOME
   ```

2. Update your PATH environment variable as follows:

   If you are using the C shell, enter
   
   ```
   set path=($VIRSIMHOME/bin $path)
   ```

   If you are using the Bourne, Korn, or Bash shell, enter
   
   ```
   PATH=$VIRSIMHOME/bin:$PATH
   export PATH
   ```
Setting the SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE Environment Variable

To enable VirSim to check out a license, you must set the SNPSLMD_LICENSE_FILE or the LM_LICENSE_FILE environment variable as follows:

- If you are using the C shell, add the following line:

  ```bash
  setenv SNPSLMD_LICENSE_FILE port@hostname
  ```

- If you are using the Bourne, Korn, or Bash shell, enter these lines:

  ```bash
  SNPSLMD_LICENSE_FILE=port@hostname
  export SNPSLMD_LICENSE_FILE
  ```

The port and host name variables correspond to the TCP port and license server host name specified in the SERVER line of the Synopsys license file. To ensure better performance, it is recommended that you use `the port@host` name rather than using the path to the license file.

Verifying the VirSim Installation

To verify the VirSim installation,

1. Change directories to an examples directory.
   ```bash
   % cd $VIRSIMHOME/examples/verilog/risc
   ```

2. To invoke VirSim, enter
   ```bash
   % virsim +vpdfile+risc.vpd +cfgfile+risc.cfg -f run.f
   ```
3. Exit the GUI by choosing File > Exit in any GUI window.

Customer Support

The support page on the Synopsys Web site is regularly updated with the latest information. Check this page for application notes, online help updates, and other valuable information:


You can also send an e-mail message to VirSim Support at vcs_support@synopsys.com.
Index

A
Acrobat Reader
   acquiring 25-4
   downloading from Web 25-4
   verifying Search plug-in 25-5
   verifying version of 25-5
Adobe Web site 25-4
AMPS
   installing 3-3
   platform keyword 1-6
   product ID 1-6
   setting up for new user 3-3
   verifying installation 3-4
app-defaults file 29-6
Astro
   disk space requirements 4-4
   installing 4-5
   setting up for new user 4-6
   verifying installation 4-7
Astro Interactive Ultra, installing 4-1
Astro-Rail
   disk space requirements 5-3, 13-4
   environment variables 5-4
   installing 31-5
   setting up for new user 5-4
   supported platforms 5-2
   verifying installation 5-5

C
Cadabra
   environment variables, setting 6-2
      CADABRAHOME 6-3
      LM_LICENSE_FILE 6-4
   installing 6-2
   support 6-5
   verifying installation 6-4
CD
   installing 2-22
   mounting 23-9
commands
      ./install.now 2-9, 2-23
      ./setup.sh 2-23
configuring the browser for Help
   Design Compiler FPGA 8-3
   Design Vision 29-7
   Floorplan Compiler 11-4
   Physical Compiler 29-7
core dump size A-2
CosmosScope
   accessing release notes 7-3
   mounting the CD 7-7
   preparing for installation 7-3
   running the installation program 7-8
   uninstalling the software 7-18
   UNIX platforms
      customer support 7-18
disk space and memory requirements 7-5
platform keyword 7-4
platform support 7-4
setting license environment variable 7-14
setting up new user 7-14
verifying 7-15
using command options 7-16
CPU time A-2

D
defaults
  synthesis tools 29-6
  System Studio 30-3
Design Analyzer
  customizing colors 29-6
  customizing fonts 29-6
Design Compiler FPGA
  configuring the browser for Help 8-3
  installing 8-2
  setting up for new user 8-3
  verifying installation 8-4
Design Compiler, verifying installation 29-17
Design Vision, configuring the browser for Help 29-7
DesignWare, installation 29-2
disk space requirements 1-9
documentation, online (SOLD) 25-3
downloading software 2-2
  by FTP 2-5
  from the Web 2-6
downloading Synopsys Installer 2-2

E
electronic software transfer
downloading files by 2-6
  Web address 2-6
Encore
  installing on UNIX 9-2
  on Windows 9-4
  invoking on Windows 9-7
  verifying installation on UNIX 9-4
environment variable, SYNOPSYS 1-20
errors, X Window System A-6
ESP
  environment variables, setting license 10-3
  installing 10-2
  setting up for new user 10-3
  verifying installation 10-4
EST files
  installing by using a GUI 2-10
  installing by using a text script 2-9

F
file, app-defaults 29-6
files (see product files)
Floorplan Compiler
  configuring the browser for Help 11-4
  installing 11-3
  platform keyword 1-7
  product ID 1-7
  setting up for new user 11-3
  verifying installation 11-4
Formality
  installing 12-2, 31-6
  platform keyword 1-7
  product ID 1-7
  setting up for new user 12-3
  verifying installation 12-3
Frameway Integration for Cadence, installing 24-21
Frameway Integration for Innoveda 24-39
Frameway Integration for Mentor Graphics
  installing 24-3
  troubleshooting 24-15
G

graphical user interface
  Design Analyzer, setting up systemwide defaults 29-6
  Design Vision 29-7
  Physical Compiler 29-7
  Synopsys Installer 2-10
  VirSim 34-2, 35-2, B-1

H

Hercules
  installing 13-5
  setting up for new user 13-6
  verifying installation 13-7

HSPICE
  AvanWaves, running 14-11
  configuring 14-5
  documentation 14-13
  hspice.ini file 14-13
  installing 13-5
    on Windows 14-9
    sentinel system drivers 14-10
  media 14-3
  multiple dongles, troubleshooting 14-11
  running 14-11
  setting up for new user 14-6
  supported platforms 14-3
  verifying installation 14-7

I

IC Workbench
  environment variables, setting
    license 15-3
  installing 15-2
  setting up for new user 15-3
  verifying installation 15-4

installation
  GUI 2-10
  multiple platform 1-5
  prerequisites

  creating root directory 1-19
  setting environment variable 1-20
  scripts
    Synopsys media for PrimeTime 2-27
    Synopsys media for synthesis tools 2-24
    installer (see Synopsys Installer)

J

JupiterXT, installing 4-1

L

licensing (see Synopsys Common Licensing)
  linking executable files
    using makefile 29-13
    using vconfig 29-12

M

Magellan
  environment variables, setting 16-3
    license 16-5
      VCS_HOME 16-3
    installing 16-2
    verifying installation 16-6
  memory
    beyond 2 GB 1-14
    data size limit A-2
    errors A-4
    physical 1-13
    requirements 1-12
    swap space 1-13, 1-14, A-4
    troubleshooting A-2
    multiple-platform installation 1-5

N

NanoSim
  installing 17-2
  platform keyword 1-7
  product ID 1-7
setting up for new user 17-2
verifying installation 17-4

O
online Help, FPGA Vision 8-3
operating system
patches 1-3
supported 1-3

P
PathMill
installing 18-3
platform keyword 1-7
product ID 1-7
setting up for new user 18-3
verifying installation 18-4
Physical Compiler (see synthesis tools)
platforms
64-bit 1-5
installing additional 1-6
installing multiple 1-5
PLI table file, modifying 29-15
Power Compiler VPower, installing 29-9
PowerMill
installing 19-2
platform keyword 1-7
product ID 1-7
setting up for new user 19-2
verifying installation 19-3
prerequisites for installing products
creating root directory 1-19
setting environment variable 1-20
PrimePower
platform keyword 1-7
setting up for new user 20-3
verifying installation 20-3
PrimeTime
installing 21-2
media installation script 2-27
platform keyword 1-7
setting up for new user 21-2
verifying installation 21-4
product files
downloading
by FTP 2-5
from the Web 2-6
installing from CD 2-22
types of packaging 2-3
untarring and uncompressing 2-8

R
RailMill
installing 22-2
platform keyword 1-7
product ID 1-7
setting up for new user 22-2
verifying installation 22-3
root directory, creating 1-19

S
Saber
command options, using 23-18
Interface to MATLAB, using 23-3
optional software, installing 24-1
Frameway Integration for Cadence 24-21
Frameway Integration for Innoveda 24-39
Frameway Integration for Mentor Graphics 24-3
Saber Co-Simulation Interface with
ModelSim 24-19
Saber Co-Simulation Interface with Verilog 24-30
supported compilers 23-5
uninstalling the software 23-20
UNIX platforms
compilers 23-5
customer support 23-21
disk space and memory requirements 23-6, 31-4
platform keyword 23-4
platform support 23-4
setting license environment variable 23-17
setting up new user 23-16
verifying 23-17

Saber Co-Simulation Interface with Verilog
24-30

Saber HDL
disk space requirements 23-7
installing 23-1
supported platforms 23-4

SCL (see Synopsys Common Licensing)
script, Synopsys media installation
for PrimeTime 2-27
for synthesis tools 2-24

semaphores, IPC 30-8
setting defaults
synthesis tools 29-6
System Studio 30-3

site identification number, finding 1-19

SoCBist
pattern generation functionality 29-17
tool dependencies 29-17

software
downloading
FTP 2-5
Web 2-6
installing
EST files by using a GUI 2-10
EST files by using a text script 2-9
from CD 2-22

SOLD
contents of CD-ROM 25-6
installation
CD 25-8
configuring for new user 25-10
electronic software transfer 25-8
options 25-7
partial 25-9
verifying 25-9
software for reading and searching 25-4

Star-MTB
installing 26-3
media 26-2
setting up for new user 26-3
supported platforms 26-2
verifying installation 26-5

Star-RCXT
disk space requirements 27-4
documentation 27-6
setting up for each user 27-5
supported platforms 27-3
verifying installation 27-6

Star-SimXT
documentation 28-6
downloading and installing 28-2
environment variables, setting 28-3
$starsimxt_HOME 28-4
license 28-4
media 28-2
supported platforms 28-2
verifying installation 28-5

swap space 1-13, A-4

Synopsys Common Licensing 1-16
acquiring a license 1-16
acquiring documentation 1-18
installing 1-18
obtaining keys 1-17

SYNOPSYS environment variable 1-20

Synopsys Installer 2-2
downloading by FTP 2-5
downloading from the Web 2-7
uncompressing and untarring 2-8
using a GUI 2-10
using a text script 2-9

Synopsys Integrator for Falcon Framework 29-8

Synopsys Online Documentation (see SOLD)
Synopsys platform keywords 1-4, 31-2
Synopsys power directory 29-11
Synopsys Qualified Runtime System Configuration 1-3
Synopsys root directory, creating 1-19
.synopsys_dc.setup A-6
synthesis tools
  configuring 29-4
  installing 29-3
  list 29-2
  platform keyword 1-8
  product ID 1-8
  setting up for new user 29-4
  verifying installation 29-17
system requirements
  disk space 1-9
  memory 1-11
System Studio
  HDL code generation 30-6
  installing 30-2
  IPC semaphore problems 30-8
  key file problems 30-7
  product ID 1-8
  setting up for new user 30-3
  troubleshooting startup problems 30-7
  verifying installation 30-6
VHDL packages 30-6
systemwide defaults
  synthesis tools 29-6
  System Studio 30-3

T

tar files, types of 2-3
TCAD
  disk requirements 31-4
  graphics
    devices 31-10
    specifying devices 31-11
    Sun, X, tmaplot 31-13
  product format and description 31-8
  search path, modifying 31-7
  utilities 31-16
TetraMAX
  installing
    overlay 32-4
    stand-alone 32-2
    license key requirements 32-3
    platform keyword 1-8
    product ID 1-8
    verifying installation 32-8
TimeMill
  installing 33-2
  platform keyword 1-8
  product ID 1-8
  setting up for new user 33-2
  verifying installation 33-3
tools, synthesis 29-2
troubleshooting
  memory A-2
  System Studio 30-7
  X Windows System A-5

V
VCS
  environment variables, setting 34-4
    license 34-5
    VCS_HOME 34-4
  installing 34-2
  platform keyword 1-8
  product ID 1-8
  support 34-7
  verifying installation 34-6
VCS MX
  environment variables, setting 35-4
    license 35-5
    VCS_HOME 35-4
  verifying installation 35-6
VCS simulator 29-15
Vera
  documentation, obtaining 36-5
  downloading and installing 36-2
  environment variables, setting 36-3
    license 36-4
    VERA_HOME 36-3
  platform keyword 1-8
product ID 1-8
support
  license 36-5
  technical 36-4
verifying installation
AMPS 3-4
Astro 4-7
Astro-Rail 5-5
Cadabra 6-4
CosmosScope 7-15
Design Compiler FPGA 8-4
Encore 9-4
ESP 10-4
Floorplan Compiler 11-4
Formality 12-3
Hercules 13-7
HSPICE 14-7
IC Workbench 15-4
Magellan 16-6
NanoSim 17-4
PathMill 18-4
PowerMill 19-3
PrimePower 20-3
RailMill 22-3
Saber 23-17
stamp_compiler 21-4
Star-MTB 26-5
Star-RCXT 27-6
Star-SimXT 28-5
synthesis tools 29-17

System Studio 30-6
TetraMAX 32-8
TimeMill 33-3
VCS 34-6
VCS MX 35-6
VirSim B-4
Verilog-XL simulator 29-10
veriuser.c file, modifying 29-10
VHDL Simulation (Scirocco) (see VCS MX)
35-2
VHDL simulation, with System Studio 30-6
VirSim
  environment variables, setting
    license B-4
  setting up for new user B-3
  support B-5
  verifying installation B-4
VPOWER
  linking to Verilog-XL simulator 29-10
    makefile 29-13
    vconfig 29-12
VPOWER, Power Compiler, installing 29-9

X

X Window System
  available colors 29-6
  troubleshooting A-5
    xinitrc A-6
    xterm A-5